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MainStage turns your computer into a powerful and customizable musical instrument
and effects processor that you can use with your music gear (your instruments,
microphones, controllers, and other equipment) in live performance.

This preface covers the following:

• About MainStage (p. 7)

• About the MainStage Documentation (p. 8)

• Additional Resources (p. 8)

About MainStage
For performing musicians, MainStage gives you the power and flexibility of Logic Pro in
an application optimized for live performance. Whether you are a keyboard player, guitarist,
vocalist, drummer, or play another instrument, you can use MainStage in your live
performance setup.

Some of the things you can do with MainStage include:

• Create custom sounds using a wide variety of included software instruments and effects.
You can also use third-party plug-ins, ReWire applications, and external sound modules.

• Organize your sounds for easy access when you perform.

• Create a visual layout that matches your hardware devices, putting the controls you
need at your fingertips.

• Connect MIDI devices to your MainStage concert so you can control parameters of your
sounds in real time.

• Trigger backing tracks and other audio files while you play.

• Loop your performances to create multitextured, dynamic sound environments.

• Record your performances in real time.

This is only a brief list of what you can do with MainStage. For a more detailed introduction,
see Introducing MainStage.
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About the MainStage Documentation
MainStage includes several documents that will introduce you to the application, help
you get started working, and provide detailed information about MainStage features and
controls.

• MainStage User Manual: This onscreen manual (the MainStage User Manual) describes
the MainStage interface, commands, and menus, and gives step-by-step instructions
for creating MainStage concerts and for accomplishing specific tasks. It also includes
information on setting up your system. It is designed to provide the information you
need to get up to speed quickly so you can make use of the intuitive interface and
powerful features of MainStage.

If you want to start by learning how to set up audio and MIDI hardware to use with
MainStage, read Setting Up Your System. If you want to learn about the features and
controls in the MainStage interface, read The MainStage Interface. If you want to jump
right in and start using the application, skip ahead to Getting Started with MainStage,
then read the chapters on Edit mode, working with concerts, and Layout mode. If you
want to read about using MainStage in live performance, turn to Performing Live with
MainStage.

• Exploring MainStage: This booklet introduces the basics of MainStage in an easy,
approachable way. It aims to get new users up and running with MainStage quickly so
you can have confidence and continue learning at your own pace. Each chapter presents
major features and guides you in trying things out.

• Logic Pro Instruments: This onscreen manual provides comprehensive instructions for
using the powerful collection of instruments included with Logic Pro and MainStage.

• Logic Pro Effects: This onscreen manual provides comprehensive instructions for using
the powerful collection of effects included with Logic Pro and MainStage.

• Working with Apogee Hardware: This onscreen manual describes the use of Apogee
hardware with Logic Pro and MainStage.

Additional Resources
Along with the documentation that comes with MainStage, there are a variety of other
resources you can use to find out more.

Release Notes and New Features
Each application offers detailed documentation that covers new or changed features and
functions. This documentation can be accessed in the following location:

• Click the Release Notes and New Features links in the application Help menu.

MainStage Website
For general information and updates, as well as the latest news on MainStage, go to:

• http://www.apple.com/logicpro/mainstage
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Apple Service and Support Websites
For software updates and answers to the most frequently asked questions for all Apple
products, go to the general Apple Support webpage. You’ll also have access to product
specifications, reference documentation, and Apple and third-party product technical
articles.

• http://www.apple.com/support

For software updates, documentation, discussion forums, and answers to the most
frequently asked questions for MainStage, go to:

• http://www.apple.com/support/mainstage

For discussion forums for all Apple products from around the world, where you can search
for an answer, post your question, or answer other users’ questions, go to:

• http://discussions.apple.com
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This chapter gives you a conceptual overview of MainStage and describes how you can
use it together with your instruments and other musical equipment when you perform
live.

This chapter covers the following:

• What Is MainStage? (p. 11)

• Using MainStage with Keyboard Controllers (p. 13)

• Using MainStage with Electric Guitars (p. 13)

• Using MainStage with Vocals, Drums, and Other Instruments (p. 13)

• How to Use MainStage in Your Music Setup (p. 13)

• Using MainStage in Live Performance (p. 16)

What Is MainStage?
MainStage is a music application designed for you to use in live performance. MainStage
turns your computer into a powerful multi-instrument and effects processor that you can
use on stage when you perform. Whether you play a keyboard, guitar, another instrument,
or sing, you can use MainStage with your instruments, microphones, and MIDI hardware
when you perform live.

MainStage lets you use professional-quality Logic Pro instruments and effects in your live
performances. You access and modify the instruments and effects in MainStage using
the familiar Logic channel strip interface. If you play a USB or MIDI keyboard controller,
you can play and control a wide variety of software instruments, including pianos and
other keyboards, synthesizers, strings, horns, percussion, and more. If you play electric
guitar, you can perform using included effects setups such as amp simulation, overdrive,
reverb, and compression. You can create your own effects setups and switch between
them easily. Vocalists and acoustic musicians can also use effects setups with sound input
through a microphone.
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MainStage provides a flexible interface for organizing and accessing your sounds in
concerts. Concerts are MainStage documents that hold your sounds—a concert can store
all the sounds you’ll use in an entire performance or a series of performances. In a
MainStage concert, individual sounds are stored as patches, and each patch can contain
one or more channel strips, each with its own instruments and effects. You can add
channel strips, choose channel strip settings, add instruments and effects, and edit their
parameters to customize your sounds. You can even mix channel strips of different types
in a single patch.

You can organize patches in a concert by ordering them in the Patch List and also by
grouping them into sets. Sets are folders where you can store patches you want to keep
together.

Each concert also includes a visual interface, called a layout, with controls that you can
use to modify your patches in live performance. Layouts contain screen controls, which
are onscreen representations of keyboards, faders, knobs, buttons, pedals, drum pads,
and other hardware controls and displays. You make connections between your MIDI
devices and your MainStage concert by assigning hardware controls to the screen controls
in the concert. After you make these controller assignments, you map the screen controls
to channel strip and plug-in parameters, completing the connection so that you can easily
access and manipulate the parameters you want for each patch in the concert. You can
also map screen controls to actions, which provide the ability to select patches, control
the Tuner or metronome, provide visual feedback, and perform other functions.

Parameter
mapping

MainStage screen control Channel strip or 
plug-in parameter

Hardware control

Controller
assignment

MainStage lets you quickly and easily make controller assignments and parameter
mappings to speed your workflow. You can customize your layout to match the controls
on your MIDI hardware, to optimize the use of available screen space, or in other ways
that suit your needs.
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Using MainStage with Keyboard Controllers
If you perform using a USB or MIDI keyboard controller, you can play and control MainStage
patches with software instruments using your controller. You can assign faders, knobs,
buttons, and other controls on the keyboard controller to screen controls in your concert,
and then map those screen controls to parameters in your patches. You can choose
exactly the parameters you want to have at your fingertips for each patch and access
them from your controller as you perform.

You can use MainStage with other MIDI controllers, including sustain pedals, expression
pedals, foot switches, MIDI guitars, and wind controllers that send standard MIDI messages.
You can also control external hardware synthesizers, ReWire applications, and other virtual
instruments using external instrument channel strips.

Using MainStage with Electric Guitars
If you play an electric guitar, you can use MainStage as a powerful, customizable
multi-effects processor. After you connect your instrument to your computer using an
audio interface, you send your guitar’s audio signal to audio channel strips in your patches,
where you can add effects including the Amp Designer and Pedalboard plug-ins designed
specifically for use with electric guitar. You can also use EQ, compression, reverb, overdrive,
and other Logic Pro effects in your guitar patches. You can control volume, effect blend,
or expression with an expression pedal, and use a foot switch to select patches hands-free
when you perform.

Using MainStage with Vocals, Drums, and Other Instruments
Vocalists and acoustic musicians can use MainStage by sending the audio output from
a microphone connected to their computer to audio channel strips in their patches. You
can use MainStage with Core Audio-compatible audio devices, such as audio interfaces
and digital mixers, for input from instruments and microphones, and for audio output to
speakers, monitors, a mixing board, or a public address (PA) system. In MainStage, you
can access a wide range of effects in your patches.

Drummers can also use MainStage by sending the audio output from microphones to
audio channel strips in their patches or by using drum pads or a virtual drum kit to control
the EXS24 mkII sampler, Ultrabeat, and percussion-oriented plug-ins.

How to Use MainStage in Your Music Setup
You can add MainStage to your music equipment setup by following these steps:
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Stage 1: Creating a Concert from a Template
You begin working in MainStage by creating a new concert from a template. MainStage
includes concert templates for keyboard, guitar, and other instruments, making it easy
to choose a template suited to your needs. MainStage recognizes many popular MIDI
controllers and automatically assigns hardware controls on the controller to corresponding
screen controls in the workspace, simplifying hardware setup.

For information about choosing a template to create a concert, see Choosing a Concert
Template.

Stage 2: Adding and Editing Patches to Customize Your Sounds
After you create a concert, you add patches for the sounds you want to play, and edit
the patches by adding channel strips, instruments, and effects, and adjusting their
parameters to “dial in” your custom sounds. You edit and organize patches in Edit mode.
In Edit mode, your patches are “live” so you can hear the results of your edits instantly.
You can select and play patches, choose channel strip settings, and edit channel strip
and plug-in parameters. You can quickly define key ranges for channel strips to create
keyboard layers and splits, scale expression and other parameters using transforms, and
filter incoming MIDI messages.

For information about editing patches, see Working with Patches in Edit Mode.

Stage 3: Organizing Your Patches for Easy Access
When you open a concert in Edit mode, the patches in the concert appear in the Patch List,
where you can select them and start playing. You can edit patch parameters, add channel
strips to existing patches or create new ones, and reorder patches to build your custom
collection of sounds to use when you perform.

You can also organize patches in sets for added flexibility. Sets are like folders that can
store groups of patches you want to keep together, which can be useful in several ways.
For example, you can store all your favorite lead synth patches in a set or store multiple
patches you intend to use in a single song, and quickly select the patches you want while
performing. You can also add channel strips at the set level, and have them available
with every patch in the set.

For information about organizing patches, see Working with Patches in Edit Mode. For
information about creating and editing sets, see Working with Sets in Edit Mode.
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Stage 4: Customizing the Visual Layout of Your Concert to Match Your Hardware
Devices
In Layout mode, you arrange screen controls in the workspace to create the visual layout
corresponding to your hardware controls. MainStage features a variety of screen controls,
including keyboards, knobs, faders, pitch bend and modulation wheels, foot pedals, drum
pads, and more. Also included are screen controls to display parameter and system
informaton, text and images, and a selector that you can use to view and select patches
or markers while performing.

You can quickly add screen controls to the workspace, and move, resize, and copy them
to create your layout. Alignment guides and other tools make it easy to visually arrange
screen controls, and you can customize display color, text labels, and other parameters
in the Screen Control Inspector. You can also group controls and arrange the grouped
control as a single unit.

For information about working with screen controls in Layout mode, see Working with
Screen Controls.

Stage 5: Making Connections Between MainStage and Your Music Hardware
In Layout mode, you connect physical controls on your MIDI hardware to the screen
controls in your concert by assigning the physical controls to the corresponding screen
controls in the workspace. You can move and resize screen controls in the workspace
and customize the display of visual feedback for parameter values and other information.
You only need to make hardware controller assignments once for an entire concert,
greatly reducing the amount of work required to connect your hardware with your
computer.

For information about making hardware assignments, see Assigning Hardware Controls
to Screen Controls.

Stage 6: Mapping Screen Controls to the Parameters You Want to Control in
Performance
Edit mode is where you map screen controls to channel strip parameters. You can map
whichever parameters you want to modify for each patch to screen controls so they can
be easily manipulated from your hardware when you perform live. You can also map
screen controls to MainStage actions, such as selecting the next patch you want to play.

For information about mapping screen controls, see Mapping Screen Controls.

You need not follow these steps in a strict order; however, in most cases you will find
working easier if you create your layout before making hardware assignments and make
hardware assignments before you map screen controls. If you plan to use one of the
existing concert templates without modifying its layout significantly, you can concentrate
on stages 1 to 3 and stage 6.
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To make setup easier, MainStage divides these tasks into two groups, with separate modes
for each group of tasks. You customize and organize your patches in Edit mode and
customize your layout and make connections with your hardware in Layout mode. The
advantage of this division is that it separates tasks you normally perform only once, such
as setting up your layout (the Layout mode tasks), from those you are likely to repeat
more often, such as editing your sounds (the Edit mode tasks).

Using MainStage in Live Performance
After you have created a concert with your custom patches following the steps described
above, you’re ready to play. When you perform live, you can use your computer as the
final sound module and effects box in your rig. You can select a patch and start playing
it instantly. MainStage switches seamlessly between patches and can sustain notes from
the previous patch while you start playing the newly selected one. You can view feedback
about your patches, including names, parameter values, and audio output levels, in real
time. You can also adjust concert-wide effects using auxiliary channel strips and control
other concert-wide settings.

In Perform mode, the workspace fill your entire screen by default, optimizing available
screen space for your onscreen layout. You can also choose Perform in Window to have
the workspace fill the MainStage window, while retaining access to the Finder and to
other applications.

You can use MainStage with multiple MIDI controllers, microphones, musical instruments,
and other music equipment. For time-based effects such as reverb and delay, you can
set a pre-defined tempo, use MIDI input for tempo changes, or tap the tempo as you
perform.

For tips and other information about using MainStage when you perform live, see
Performing Live with MainStage.
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You can use MainStage with a wide variety of MIDI controllers and Core Audio-compliant
audio devices. The following section provides basic information about using MIDI and
audio devices with MainStage.

Real-time generation and processing of digital audio requires intensive processing by
your computer. If you plan to work on large or complex projects, using a computer with
a faster processor and extra random-access memory (RAM) installed can facilitate your
productivity. Additional RAM is useful particularly when using a large number of effects
plug-ins and when playing sample-based software instruments. It is recommended that
you do not run other processor- or RAM-intensive applications simultaneously with
MainStage, particularly when performing live.

You also have the option to open MainStage in 64-bit mode, which allows you to access
large amounts of memory—when working with software instruments that require loading
very large sound libraries, for example. To open MainStage in 64-bit mode, Control-click
the Mainstage icon in the Applications folder, choose Get Info, then deselect the "Open
in 32-bit mode" checkbox.

This chapter covers the following:

• Using MIDI Devices with MainStage (p. 17)

• Using Audio Devices with MainStage (p. 19)

• Using Effects Plug-ins with MainStage (p. 19)

• Using MainStage with Time Machine (p. 19)

Using MIDI Devices with MainStage
MainStage works with many USB and MIDI keyboard controllers and with other MIDI
devices such as foot pedals and switches. To work with MainStage, MIDI devices must
send standard MIDI control messages. MainStage receives standard MIDI messages and
can be used to control external MIDI devices using external MIDI instrument channel
strips.
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Using MIDI Devices That Send Special MIDI Message Types
Certain types of hardware controls such as knobs (rotary controls) and buttons are capable
of sending several types of MIDI messages. When you assign these controls to MainStage
screen controls using the Learn process, MainStage analyzes the incoming MIDI data to
determine which type of message the hardware control is sending. In order for MainStage
to learn these controls correctly, be sure to turn knobs through their full range of motion
and to press buttons exactly three times during the Learn process.

Some MIDI controllers can send nonstandard or proprietary MIDI messages. MainStage
cannot process or respond to nonstandard MIDI messages, to “registered” or
“non-registered” parameter messages, or to system exclusive (SysEx) messages. MainStage
can process some system real-time messages and MIDI Machine Control (MMC) messages
when you assign a hardware control that sends these messages to a screen control.

Some devices feature buttons that send program change messages. You can use these
buttons to send program change messages to MainStage, but you cannot assign them
to control other parameters using MainStage screen controls.

Choosing a Controller Preset
Some keyboard controllers allow you to choose different presets or “scenes” that
reconfigure the messages sent by the controls on the device. In most cases, you should
choose a generic preset that sends standard MIDI messages rather than system exclusive
messages or messages intended for a particular application. After you have assigned
hardware controls to screen controls in MainStage, do not change the preset on the MIDI
device, or your assignments might be lost.

In some cases, you can change the message type the controller sends by choosing a
different preset or by reprogramming the device. Some devices may include software
that you can use to reprogram knobs, buttons, and other controls. For information about
reprogramming a MIDI device, see the documentation that came with the device.

Using MIDI Devices That Support Automatic Configuration
MainStage can automatically configure the screen controls in a concert to support many
popular MIDI controllers. If you are using a device that supports automatic configuration,
MainStage alerts you to select the appropriate preset on your device when you open a
new concert. After you select the preset on your MIDI device, the screen controls in the
concert are assigned to the corresponding controls on your hardware device so you can
use them in MainStage with no further configuration.
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Using Audio Devices with MainStage
MainStage works with Core Audio-compliant audio devices, including FireWire, USB,
ExpressCard, and PCI audio interfaces. You can connect microphones, electronic musical
instruments, and other musical equipment to your computer, or to an audio interface or
other audio device, and use them with MainStage.

MainStage can require a large amount of available RAM, particularly when playing
sample-based software instruments. It is recommended that you test your system and
the concerts you plan to use before you perform using MainStage to make sure there is
enough available memory to select and play the patches you want to use without causing
audio drop-outs or distortion. For more information about choosing audio drivers, see
Setting MainStage Preferences.

Using Effects Plug-ins with MainStage
You can use all of the included Logic Pro effects plug-ins in MainStage channel strips. For
more information about the included effects plug-ins, refer to the Logic Pro Instruments
and Logic Pro Effects manuals. You can also use Apple and third-party Audio Units effects
in MainStage channel strips in the same way you use them in Logic Pro channel strips.

Some Logic Pro effects, including Space Designer, require intensive real-time processing
of the audio signal. Using Space Designer on individual patches can affect the performance
of your concert, and in some cases result in audio dropouts or glitches, particularly if you
set the audio buffer to a smaller size. For this reason, it is recommended that you use
Space Designer sparingly in your concerts, and use a few Space Designer instances on
auxiliary channel strips shared between multiple patches, rather than in individual patches.

Some Audio Units plug-ins can introduce latency. Using effects that introduce latency,
such as compressors and limiters, can produce undesirable or unpredictable results during
live performance. Other Audio Units plug-ins, particularly instrument and amp modelling
plug-ins, require high levels of realtime processing and can affect the performance of
your concert.

For information about adding and configuring plug-ins in MainStage, refer to Working
with Plug-ins in Edit Mode.

Using MainStage with Time Machine
In Perform mode (both Perform in Window and Perform in Full Screen), Time Machine
backups are disabled automatically. This avoids any impact on your performance.
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You do all your work in MainStage in a single window, the MainStage window.

The MainStage window is organized to make it easy to work with your patches and the
layout of your concert. When you open MainStage, the workspace fills the center of the
window, with Inspectors and other editing areas on the sides and below. When you are
ready to perform, you can maximize your computer performance and your display space
for easy viewing on stage.

The first time you open MainStage, the Choose Template dialog appears so that you can
choose a concert template to create a new concert. To learn how to open MainStage, see
Opening MainStage. For information about choosing a template, see Choosing a Concert
Template.

This chapter covers the following:

• The MainStage Window (p. 22)

• Layout Mode (p. 23)

• Edit Mode (p. 24)

• Perform Mode (p. 25)

• Customizing the MainStage Window (p. 26)
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The MainStage Window
Some features of the MainStage interface are common to all modes, while others are
exclusive to certain modes.

Inspector

Workspace with 
screen controlsActivity MonitorToolbar

The main features of the MainStage window include:

• Toolbar: Includes buttons for quick access to common commands and tools. You can
customize the toolbar so that the commands you use most frequently are readily
available.

• Activity Monitor: Shows your computer’s processor and memory usage, and shows the
input from your MIDI devices as you edit and perform.

• Workspace: The “canvas” where you customize your onscreen layout, assign hardware
controls to screen controls, and view your concerts while you perform.

• Screen controls: The onscreen objects that correspond to the controls on your hardware
devices. You can add and arrange screen controls in the workspace, assign hardware
controls to screen controls, and then map them to parameters you want to control for
each patch in your concert. There are three types of screen controls:  panel controls,
shelf controls, and grouped controls.

• Channel strips: Channel strips are where you build and customize your sounds.
MainStage channel strips are similar to channel strips in Logic Pro, with Insert, Sends,
and I/O menus as well as level meters, faders, pan knobs, and other controls.
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• Inspectors: Inspectors appear below (in Edit mode) or along the left side of the MainStage
window (in Layout mode) when you select different items onscreen. The Inspectors
allow you to edit parameters and attributes for patches, sets, screen controls, channel
strips, and the concert. Most Inspectors feature tabs that make it easy to quickly access
the parameters you want to edit.

To make working easier, MainStage features three different modes, each suited to a
different task. You audition, edit, and organize your sounds and map screen controls in
Edit mode. You customize the visual arrangement of controls onscreen and make controller
assignments in Layout mode. You use Perform mode when you perform live.

Layout Mode
Layout mode is where you customize your onscreen layout and make connections between
your MIDI hardware and the screen controls in your concert. You drag screen controls
into the workspace and arrange them onscreen to customize your layout, then create
connections (called controller assignments) between your MIDI hardware and the screen
controls.

In the Screen Control Inspector, you can edit layout parameters to customize hardware
assignments and modify the visual look of the screen controls in your concert.

Screen Control Inspector Screen Controls Palette

• Screen Control Inspector: View and edit parameters for screen controls in the workspace,
including hardware input, appearance, and certain types of MIDI output parameters.
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• Screen Controls Palette: Drag screen controls from the palette into the workspace to
add them to your onscreen layout. The palette has four tabs so that you can quickly
view all screen controls or only one type of screen control. Panel controls appear as
two-dimensional objects in the workspace, while shelf controls appear on an adjustable
three-dimensional shelf.

• Layout buttons: Along the left side of the workspace is a series of buttons that you can
use to quickly position selected screen controls in the workspace. You can align,
distribute, and group selected screen controls.

In Layout mode, unlike the other modes in MainStage, you can’t select or edit individual
patches. To learn what you can do in Layout mode, see Working in Layout Mode.

Edit Mode
Edit mode is where you create, customize, and organize your sounds. You can add patches,
add and edit channel strips, create keyboard layers and splits, and edit channel strip and
plug-in parameters. Edit mode is also where you map screen controls to channel strip
parameters and actions, and edit patch, set, and concert-level parameters.

Patch List Inspector (changes 
depending on the 
selection)

Channel Strips 
area

• Patch List: Shows the patches and sets in the concert. You can add patches and sets
to the Patch List, name them, and organize them. The Patch List includes an Action
menu with commands to create patches and sets, reset program change numbers, skip
items, and import and export patches and sets to use in other concerts.
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• Inspector (varies depending on the type of item selected): View and edit parameters for
the currently selected patch, channel strip, screen control, set, or for the concert. The
name of the Inspector changes to identify the type of item you are currently inspecting.

• Channel Strips area: View and edit the channel strips in your patches or at the concert
or set level. Channel strips appear in a vertical format similar to Logic Pro channel strips,
with many of the same controls. You can also add channel strips and save channel strip
settings.

• Assignments & Mappings tab: Shows the assignments and mappings for the selected
patch, set, or concert. You can create new assigments and mappings, edit existing ones,
and edit the hardware input settings for an assignment.

To learn what you can do in Edit mode, see Working in Edit Mode and Working with
Concerts.

The remaining mode, Perform mode, is optimized for performing live.

Perform Mode
By default, Perform mode opens in full screen. The workspace fills your entire computer
display so that your screen controls are as large as possible for maximum readability.
Perform in Full Screen optimizes your display for live performance when you want to use
MainStage exclusively while you play. It also disables OS-level autosave, Spotlight, and
Time Machine.
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You can choose to have Perform mode open in a window. The toolbar remains visible so
that you can switch modes using the Mode buttons, use the Panic or Master Mute buttons
and the Tuner, and view CPU and memory levels and MIDI input in the Activity Monitor.
The browsers and Inspectors are hidden to maximize the size of the workspace, making
screen controls larger and easier to read in onstage situations. You can still access the
Finder and switch to other applications but cannot open plug-in windows.

To learn about using Perform mode when you perform live, see Performing Live with
MainStage.

Customizing the MainStage Window
You can customize the MainStage window to suit your way of working. In Edit mode, you
can adjust the width of the Patch List, show or hide the Inspectors and the Channel Strips
area, and customize the buttons on the toolbar.

Resizing the Workspace
You can adjust both the horizontal and vertical size of the workspace to give more room
to the Patch List, the Inspector, and the Channel Strips area.

To resize the workspace horizontally
1 Move the pointer to the space between the workspace and the Inspector.

The pointer becomes a resize pointer.

2 Drag up or down to resize the workspace.
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To resize the workspace vertically
1 Move the pointer to the space between the workspace and the Channel Strips area.

The pointer becomes a resize pointer.

2 Drag left or right to resize the workspace.

Hiding and Showing the Inspector
You can hide the Inspector or show it if it is hidden.

To hide or show the Inspector
Do one of the following:

µ Choose View > Inspectors (or press Command-5).

µ In the toolbar, click the Inspectors button.

Hiding and Showing the Channel Strips Area
You can hide the Channel Strips area or show it if it is hidden. Hiding the Channel Strips
area gives you more room for the workspace.

To hide or show the Channel Strips area
Do one of the following:

µ Choose View > Channel Strips (or press Command-6).

µ In the toolbar, click the Channel Strips button.

Customizing the Toolbar
The toolbar at the top of the MainStage window contains buttons for frequently used
commands. You can customize the toolbar, adding buttons for the functions you use
most often and can return to the default set later.

The default set of toolbar buttons includes buttons for selecting the different window
modes, hiding the Inspector and the Channel Strips area, activating Master Mute, and
other common commands. You can customize the toolbar with additional buttons for
other commands and adjust the position and spacing of items. You can also hide the
toolbar to maximize available screen space. You customize the toolbar by dragging items
from the Customize Toolbar dialog to the toolbar.

To show the Customize dialog
Do one of the following:

µ Choose View > Customize Toolbar.

µ Control-click the toolbar, then choose Customize Toolbar from the shortcut menu.
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The Customize Toolbar dialog appears, and spaces between buttons in the toolbar are
outlined in gray.

To add a button to the toolbar
µ Drag a button from the Customize dialog to the toolbar.

If you drag a button between two existing buttons, the buttons move to make room for
the new button.

To move a button in the toolbar
Do one of the following:

µ If the Customize Toolbar dialog is visible, drag the button to move it.

µ If the Customize Toolbar dialog is not visible, Command-drag the button to move it.

You can also rearrange the toolbar using set-width spaces, flexible spaces, and separators.

To add a space or a separator to the toolbar
µ Drag a space, flexible space, or separator from the Customize Toolbar dialog to the toolbar.

To return the toolbar to the default set of buttons
µ Drag the default button set, located at the bottom of the Customize Toolbar dialog, to

the toolbar.

You can also change the toolbar so that it shows only icons or only text by Control-clicking
the toolbar, then choosing Icon Only or Text Only from the shortcut menu.

To show only icons in the toolbar
Do one of the following:

µ Control-click the toolbar, then choose Icon Only from the shortcut menu.

µ In the Customize Toolbar dialog, choose Icon Only from the Show pop-up menu.

To show only text in the toolbar
Do one of the following:

µ Control-click the toolbar, then choose Text Only from the shortcut menu.

µ In the Customize Toolbar dialog, choose Text Only from the Show pop-up menu.

To show both icons and text in the toolbar
Do one of the following:

µ Control-click the toolbar, then choose Icon & Text from the shortcut menu.

µ In the Customize Toolbar dialog, choose Icon & Text from the Show pop-up menu.

To close the Customize dialog
µ When you are finishing customizing the toolbar, click Done.

To hide the toolbar
µ Choose View > Hide Toolbar.
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When the toolbar is hidden, the menu item becomes Show Toolbar.
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You can quickly start working in MainStage by choosing a concert template and trying
out the patch settings in the concert. This chapter provides a brief guided “walkthrough”
you can follow the first time you open MainStage. If you wish to continue learning the
major features of the application in a hands-on manner, consult the Exploring MainStage
guide.

This chapter covers the following:

• Before You Begin (p. 31)

• Opening MainStage (p. 32)

• Choosing a Concert Template (p. 32)

• Selecting Patch Settings in the Patch Library (p. 33)

• Adding a Patch (p. 34)

• Naming a Patch (p. 35)

• Selecting and Playing Patches (p. 35)

• Adding a Channel Strip (p. 36)

• Changing a Channel Strip Setting (p. 38)

• Learning a Controller Assignment (p. 39)

• Mapping a Screen Control (p. 41)

• Trying Out Perform Mode (p. 41)

Before You Begin
Before you start working in MainStage, you should connect the hardware equipment that
you plan to use, such as your keyboard controller, audio interface, instruments, or
microphones, to your computer. To use keyboard controllers and other MIDI devices with
MainStage, the devices should be capable of sending standard MIDI messages. If you’re
not sure whether this is the case for a particular device, consult the owner’s manual or
the product website. For more information, see Setting Up Your System.
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Opening MainStage
You start by opening MainStage and creating a new concert from a template.

To open MainStage
µ Double-click the MainStage icon in your Applications folder or in the Dock.

Choosing a Concert Template
MainStage includes templates for different musical instruments, including Keyboards,
Guitar Rigs, Drums, Vocals, and more. You can choose a concert template in the Choose
Template dialog, which appears the first time you open MainStage and when you create
a new concert or close a concert.

To choose a concert template
1 Choose File > New (or press Command-N).
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2 In the Choose Template dialog, choose the devices you want to use for audio input and
output from the Audio Input and Audio Output pop-up menus.

3 Click the instrument category on the left you want to view templates for. You can also
click Quick Start and choose a simple keyboard or guitar template to start playing
immediately.

A brief description below each template describes its features and intended use.

4 Scroll through the available templates to find the one you want to use.

5 Click Choose, or double-click the template.

Choosing one of the Quick Start templates opens a new concert in Perform mode, so you
can start playing immediately. Choosing any other template opens a new concert in
Edit mode. The workspace appears in the center of the MainStage window, showing the
screen controls in the concert. To the left of the workspace is the Patch List, which shows
the patches and sets in the concert. The channel strips for the selected patch appear in
the Channel Strips area to the right of the workspace. The new concert may contain a
single patch, or several patches. Below the workspace, the Patch Library is open, so you
can easily audition different patch settings to find the one you want to use.

In the Choose Template dialog, you can view templates in either a grid, a list, or a
Cover Flow view. You can choose a different view using the view buttons, located in the
lower-left part of the dialog.

To choose a different view for the Choose Template dialog
Do one of the following:

µ To view templates in a grid, click the Grid button.

µ To view templates in Cover Flow, click the Cover Flow button.

µ To view templates in a list, click the List button.

For more information about opening, editing, and saving concerts, see Working with
Concerts.

Selecting Patch Settings in the Patch Library
When you open a concert or select a patch, the Patch Library opens in the Patch Inspector
below the workspace. The Patch Library contains a variety of patches optimized for the
instrument the concert is designed for. You can quickly audition patch settings in the
Patch Library and choose a setting for the selected patch.

To select a patch setting
1 Look through the settings in the Patch Library to find the one you want to use.

2 Click the patch setting.
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You can start playing the patch immediately using the selected patch setting. You can
also search for patch settings by name.

To search for patch settings by name
1 Choose Find in Library from the Action menu in the upper-right corner of the Patch

Inspector.

2 Enter the name of the patch setting you want to find.

3 Click Find.

The first patch setting with the text you entered appears selected in the Patch Library.

4 To find subsequent patch settings with the same name, choose Find Again in Library
from the Action menu.

Note: If you have saved multiple patches using the Save as Set command (or the Export
as Set command in MainStage 1.0) in the Action menu, the saved file appears as a patch
in the Patch Library unless you have selected a different location for saving the file. Clicking
the saved file in the Patch Library causes an alert to appear while the individual patches
are opened from the .patch file.

Adding a Patch
You can add patches to the concert and organize them in the Patch List. The number of
patches is limited only by the amount of available memory in your system. When you
add a patch to a concert, the patch is selected so you can easily audition and select a
patch setting from the Patch Library.

To add a new patch
1 Click the Add Patch button (+), located in the upper-right corner of the Patch List.

The new patch appears in the Patch List, and the Patch Library is open in the Patch
Inspector.
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2 Select the patch setting you want to use from the Patch Library.

If you are using a keyboard controller, select a Keyboard patch. If you are playing your
electric guitar, select a Guitar Rig patch. For other instruments or vocals, you can choose
a template from the appropriate category or modify a keyboard or guitar template to
suit your needs.

3 If the patch uses an audio channel strip, make sure the channel strip is set to use the
correct audio input, then gradually raise the volume fader on the channel strip until you
hear sound on the channel.

Naming a Patch
When you add a patch, by default it takes the name of the channel strip added with it.
You can give each patch a custom name to make it easier to identify and distinguish
between them.

To name a patch
1 Double-click the patch in the Patch List.

A field appears around the patch name, which is selected.

Double-click the 
patch name, then 
type a new name. 

2 Type a new name in the patch name field.

For more information about editing and organizing patches, see Working with Patches
in Edit Mode.

Selecting and Playing Patches
The patches in the concert appear in the Patch List along the left side of the MainStage
window. You can easily access the patches in your concert by selecting them in the
Patch List. You can quickly select patches by clicking them in the Patch List.
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Using a MIDI controller, you can play patches that have a software instrument channel
strip. If you are playing an electric guitar or another instrument connected to an audio
interface, or are using a microphone, you can play or sing using patches that have an
audio channel strip. Before playing through an audio channel strip, first make sure that
the channel strip is set to receive input on the channel (or stereo pair of channels) to
which your instrument or microphone is connected.

With the patch selected, try moving some controls on your MIDI controller and check to
see if the screen controls in the workspace respond. Some screen controls, including the
keyboard, modulation and pitch bend wheels, and sustain pedal screen controls, respond
to appropriate MIDI messages without needing to be assigned or mapped.

You can continue selecting and playing patches in the concert to find sounds you want
to perform with or to use as a starting point for creating your own custom patches. You
can also add new patches and edit their channel strip settings to create your own unique
sounds.

For more information about organizing and selecting patches in the Patch List, see Working
with Patches in Edit Mode.

Adding a Channel Strip
You can add channel strips to a patch to create layered sounds and keyboard splits. When
you add a channel strip to a patch, you choose the type of channel strip, the output, and
other settings. You can mix both types in a single patch.

To add a channel strip to a patch
1 Make sure the patch is selected in the Patch List.

2 Click the Add Channel Strip button (+) in the upper-right corner of the Channel Strips
area.

The New Channel Strip dialog appears. You choose settings in the Channel Strip dialog
in the same way as when you add a patch.

3 In the New Channel Strip dialog, select the type of channel strip you want to create.

4 Choose the audio output for the channel strip from the Output pop-up menu.

5 For audio channel strips, choose mono or stereo format from the Format pop-up menu
and choose the audio input from the Input pop-up menu. For external instrument channel
strips, also choose the MIDI input, MIDI output, and MIDI channel from their respective
pop-up menus.
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Important: Audio channel strips can produce feedback, particularly if you are using a
microphone for audio input. When you add an audio channel strip, the volume of the
channel strip is set to silence, and Feedback Protection is turned on to alert you when
feedback occurs on the channel strip. When you add an external instrument channel
strip, the volume of the channel strip is set to silence, but Feedback Protection is turned
off.

6 Optionally, you can add multiple channel strips to a patch by typing a number in the
Number field. You can add up to the maximum number for a channel strip type.

7 Click Create.

A new channel strip appears in the Channel Strips area, highlighted to indicate that it is
selected. The Channel Strip Inspector appears below the workspace, showing different
parameters for the new channel strip.

8 For audio and external instrument channel strips, gradually raise the volume fader until
you hear sound on the channel.
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You can adjust channel strip output using the Volume fader, adjust pan position using
the Pan knob, and mute or solo the channel strip using the Mute and Solo buttons. For
audio channel strips, you can switch between mono and stereo format using the Format
button. For software instrument channel strips, you can choose a different instrument
from the Input pop-up menu. You can choose new channel strip settings, add and edit
effects, add sends to busses, and change the output using the controls on the channel
strip.

You can also define the key range for a channel strip, create transform and velocity graphs,
and filter various MIDI messages to a channel strip in the Channel Strip Inspector. For
general information about working with channel strips, see the “Working with Instruments
and Effects” chapter of the  Logic Pro User Manual. For more information about using
channel strips in MainStage, see Working with Channel Strips in Edit Mode.

Changing a Channel Strip Setting
You can quickly change the instrument, effects, and other parameters for a channel strip
by selecting a new setting from the Channel Strip Library. The browser shows available
settings for the currently selected channel strip.

To select a new channel strip setting
1 Make sure that the channel strip you want to change is selected.

The selected channel strip is highlighted.

2 In the Channel Strip Inspector, click the Channel Strip Library tab.

Available channel strip settings appear in the Channel Strip Library. Logic Pro channel
strip settings appear as a series of folders with different instrument and usage categories.
If you have GarageBand or have one or more Jam Pack collections installed on your
computer, those settings appear below the built-in settings.
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3 Click a category from the column on the left, then click subcategories from the columns
on the right until you see the settings you want.

Click a category in this 
column to see the 
available choices.

Click the channel strip 
setting you want to use from 
the columns to the right.

You can also search for channel strip settings by name and perform other functions using
the Channel Strip Library. For more information about the Channel Strip Inspector, see
Choosing Channel Strip Settings.

Learning a Controller Assignment
When you select a patch or a channel strip setting, some channel strip parameters respond
to the controls on your MIDI device instantly. MainStage responds to notes played on a
keyboard controller, volume, pan, and expression messages, modulation and pitch bend
wheel messages, and sustain pedal messages without your having to configure any screen
controls to receive these messages. For other controls such as faders, knobs, and buttons,
you must assign these hardware controls to MainStage screen controls before you can
use them in your concert.

In MainStage, you assign hardware controls to screen controls in the Layout Inspector,
similar to learning controller assignments for a control surface in Logic Pro. Learning
controller assignments is a quick and easy method for assigning hardware controls to
screen controls.

Note: To be able to assign a hardware control to a screen control, the hardware control
must send standard MIDI messages. For more information, see Using MIDI Devices with
MainStage.

To learn a controller assignment
1 In the toolbar, click the Layout button.

MainStage switches to Layout mode.
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2 In the workspace, select the screen control you want to learn.

The selected control appears highlighted in blue.

3 Click the Assign button in the Screen Control Inspector (or press Command-L).

The Assign button glows red to indicate that the assignment process is active, and the
selected screen control is highlighted in red.

4 On your MIDI device, move the control you want to assign. Move faders and knobs through
their full range of motion, and press buttons exactly three times (not too quickly) to
enable MainStage to correctly learn the MIDI message types sent by these controls.

The values in the Hardware Assignment pop-up menus change to reflect the type of
hardware control learned by the screen control. While the assignment is being learned,
incoming MIDI messages appear in the Activity Monitor above the workspace.

After the assignment process, the screen control responds when you move the
corresponding hardware control. This shows that the screen control is receiving MIDI
input and is correctly assigned.

5 While the Assign button is red, you can learn additional controller assignments by selecting
another screen control and moving the hardware control you want to assign to it.
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6 When you are finished assigning controls, click the Assign button (or press Command-L)
again to turn off the assignment process.

For more information about making controller assignments, see Assigning Hardware
Controls to Screen Controls.

Mapping a Screen Control
After you have learned controller assignments for the screen controls you want to use,
you can map the screen controls to the parameters in the patches you want to control
when you are performing. You will likely want to map screen controls to parameters in
each patch in a concert, so that you can easily access and modify the parameters you
want for each patch when you perform live. You can also map parameters at the concert
level to control master volume, view master levels, or modify concert-wide effects.

There are two ways to map screen controls to parameters:  by visually selecting parameters
on channel strips or plug-in windows, or by choosing parameters in the Parameter
Mapping browser. To learn how to map a screen control to a channel strip or plug-in
parameter, see Mapping Screen Controls to Channel Strip and Plug-in Parameters. To
learn how to map a screen control to an action, see Mapping Screen Controls to Actions.

Trying Out Perform Mode
Now you can try playing your patches as you would in a performance. You can have the
workspace occupy the entire screen, presenting the screen controls as large as possible
for easy viewing in concert environments, or you can view the workspace in a window,
so you can use the toolbar buttons and access other applications.

To switch to Perform mode
Do one of the following:

µ Click the Perform button in the toolbar.

µ Choose View > Perform in Full Screen (or press Command-4).

Note: By default, the Perform button opens the workspace in full screen. For information
about changing this preference, see Display Preferences.

To view the workspace in a window
µ Choose View > Perform in Window (or press Command-3).

You can use either workspace view to play the patches you added or modified, and use
the controls on your MIDI controller to modify the parameters you have mapped to screen
controls.
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In Edit mode, you add and edit patches to create your custom sounds, choose patch
settings in the Patch Library, organize and select patches in the Patch List, edit patch
parameters in the Inspector, and map screen controls to parameters and actions. You can
create custom patches in Edit mode and organize them in the Patch List so that you can
easily access them when you perform.

This chapter covers the following:

• Working with Patches in Edit Mode (p. 43)

• Working with Channel Strips in Edit Mode (p. 50)

• Working with Plug-ins in Edit Mode (p. 73)

• Mapping Screen Controls (p. 76)

• Editing Screen Control Parameters in Edit Mode (p. 84)

• Working in the Assignments and Mappings tab (p. 89)

• Working with Sets in Edit Mode (p. 91)

• Working at the Set Level (p. 94)

• Sharing Patches and Sets Between Concerts (p. 94)

• Recording the Audio Output of a Concert (p. 95)

Working with Patches in Edit Mode
Patches are the individual sounds you play using your keyboard controller (for MIDI
keyboardists) and the effects setups you use with your guitar, microphone, or other
instrument (for guitarists, vocalists, and other instrumentalists). MainStage patches can
contain multiple channel strips, each with a different instrument or effects setup.

Some basic patch operations, including adding and naming patches, selecting and naming
patches, and adding channel strips to patches, are described in Getting Started with
MainStage.

If MainStage is currently in Layout or Perform mode, click the Edit button in the top-left
corner of the MainStage window to begin working in Edit mode.
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Selecting Items in the Patch List
All of the patches and sets in a concert appear in the Patch List, located to the left of the
workspace. To select an item in the Patch List in Edit mode, you can click the item or use
key commands.

To select a patch in the Patch List
1 In the Patch List, located to the left of the workspace, click the patch.

Click a patch in the 
Patch List to select it, 
and start playing.

2 With the patch selected, you can start playing instantly.

You can also select patches in the Patch List using your computer keyboard.

To select a patch using your computer keyboard
µ Press the Down Arrow key to select the next (lower) patch in the Patch List.

µ Press the Up Arrow key to select the previous (higher) patch in the Patch List.

There are additional key commands you can use to select items in the Patch List.

SelectsDefault key command

Previous item (patch or set) in the Patch ListUp Arrow

Next item (patch or set) in the Patch ListDown Arrow

Previous patch in the Patch ListCommand-Up Arrow

Next patch in the Patch ListCommand-Down Arrow

First patch of the previous setCommand-Left Arrow

First patch of the next setCommand-Right Arrow

Note: When you use the Command-Arrow key commands listed above to select different
patches, the selected screen control remains selected in the workspace. This makes it
easy to see how a screen control is configured in different patches.
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In addition to using key commands, you can select a patch (or set) in the Patch List by
typing the first few letters of its name.

To select a patch or set by typing its name
1 Click the border of the Patch List to select it.

2 With the Patch List selected, start typing the name of the patch. Once you type enough
letters to uniquely identify its name, the patch or set is selected.

You can also select a patch by typing its name in Perform mode. For information, see
Selecting Patches by Typing.

You can also select a patch using your computer keyboard by typing its patch number.
Patch numbers appear to the left of the patch names in the Patch List.

To select a patch by typing its patch number
1 Click the border of the Patch List to select it.

2 With the Patch List selected, type the patch number using your computer keyboard.

Skipping Items in the Patch List
You can skip patches or sets in the Patch List. When a patch or set is skipped, using the
Command key together with the arrow keys to select items passes over the patch or set
and the next (non-skipped) item is selected. However, you can still select the item by
clicking it, or using the arrow keys alone.

Skipped items are also skipped when you use the patch selector in Perform mode.

To skip a patch or set
1 Select the patch or set in the Patch List.

2 Choose Skip from the Action menu for the Patch List.

The item appears as a thin line in the Patch List.

To set a skipped patch or set to no longer be skipped
1 Select the item (patch or set) in the Patch List.

2 Choose Don’t Skip from the Action menu for the Patch List.

The item returns to full size in the Patch List.

Collapsing Sets in the Patch List
You can collapse sets in the Patch List. When you collapse a set, you can select the set
and use any channel strips or busses at the set level but cannot select or play patches in
the set while in Edit mode.

To collapse a set
µ In the Patch List, click the disclosure triangle for the set.
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You can uncollapse the set by clicking its disclosure triangle again. Collapsing a set has
no effect on whether you can select patches in the set in Perform mode.

For information about creating and using sets, see Working with Sets in Edit Mode.

Copying and Pasting Patches
You can copy, paste, and duplicate patches in the Patch List using the standard Mac OS X
menu and key commands or by Option-dragging. When you paste or duplicate a patch,
it includes any mappings made to parameters in the original patch.

Reordering Patches in the Patch List
When you add a patch to a concert, the new patch appears below the currently selected
patch in the Patch List. You can drag patches in the Patch List to reorder them.

To reorder patches in the Patch List
µ Drag patches up or down in the Patch List until they appear in the order you want.

Moving Patches in the Patch List Repeatedly
The MainStage command set includes a Move Again command that lets you easily move
selected patches multiple times. You can use Move Again when you drag, paste, create,
or delete patches in the Patch List. By default, the Move Again command is not assigned
to a key command. To use it, you should first assign it to a key command in the Command
Editor. For information about using the Command Editor, see Using the Command Editor.

Creating a Patch from Several Patches
You can create a patch by combining several existing patches. The new patch contains
all of the channel strips of the selected patches.

To create a patch from several existing patches
1 In the Patch List, select the patches you want to use to create the new patch.

2 Choose “Create Patch from Selected Patches” from the Action menu at the upper-right
corner of the Patch List.

The new “combined” patch appears in the Patch List, labeled “Untitled Patch.”

3 Double-click the name and type a name for the combined patch.

Note: Creating a patch with more than three channel strips can affect performance,
particularly if they use a large number of plug-ins or processor-intensive plug-ins.

Setting the Time Signature for a Patch
You can set the time signature for a patch. Time signatures can be used with the Playback
plug-in and also control the beats for the metronome. When you set the time signature
for a patch, it overrides any concert- or set-level time signature.

To set the time signature for a patch
1 In the Patch Inspector, select the Attributes tab.
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2 In the Attributes tab, select the Has Time Signature checkbox.

3 Double-click the number in the field to the right, and enter the number of beats for one
measure of the time signature.

4 Choose the beat value from the pop-up menu to the right.

Changing the Tempo When You Select a Patch
You can give a patch its own tempo setting so that when you select the patch, the tempo
changes to the patch tempo setting. MainStage uses the new tempo until you select
another patch or set with its own tempo setting, tap a new tempo, or until MainStage
receives tempo information from incoming MIDI messages. For more information about
using and changing tempo in MainStage, see Using Tempo in a MainStage Concert.

To change the tempo using a patch
1 In the Attributes tab of the Patch Inspector, set the patch tempo using the Change Tempo

To value slider.

2 Select the Change Tempo To checkbox to activate the patch tempo when the patch is
selected.

Select the checkbox 
and set the tempo 
using the slider.

Setting Patch Program Change Numbers
When you add a patch to a concert, the patch is given a MIDI program change number
(the lowest available number between 0 and 127) until all available program change
numbers are taken. You can select patches using program change numbers when
performing by assigning buttons on a MIDI device to send program change messages.
You can change the program change number in the Patch Inspector.

To change the program change number for a patch
1 In the Patch List, select the patch.

When you select a patch, the Patch Inspector appears below the workspace.

2 In the Attributes tab of the Patch Inspector, select the Program Change checkbox.

3 Using the value slider, set the program change number.
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The MIDI standard allows program change numbers with values from 0 to 127. If all
available program change numbers in a concert are already in use, any new patches
added to the concert will be given program change number zero (0), but the number is
inactive (the checkbox is not selected). Bank changes are not supported.

If you set a program change number so that it duplicates an existing program change
number, the word “Duplicate” appears in red next to the Program Change value slider.
If two or more patches have the same program change number, and the numbers are
active, the patch that appears first (highest) in the Patch List or patch selector is selected
when you send the program change message with the corresponding value.

You can reset program change numbers for all active (non-skipped) patches in a concert.
When you reset program change numbers, patches are assigned program change numbers
based on their order in the Patch List, starting from the top. The program change numbers
for skipped (inactive) patches are not reset.

To reset program change numbers for active patches in a concert
µ Choose Reset Program Change Numbers from the Action menu for the Patch List (or press

Command-Shift-Option-R).

You can assign buttons and other controls to send program change messages and use
them to select patches in the concert. For information about assigning buttons, see
Assigning Buttons.

Deferring Patch Changes
By default, when you switch patches, the new patch is ready to play immediately. You
can “defer” a patch change so that the patch change occurs after the last note of the
previous patch has been released or sustained.

To defer a patch change
µ In the Attributes tab of the Patch Inspector, select the Defer Patch Change checkbox.

Note: Deferring patch change works in Perform mode but does not work when you are
editing patches in Edit mode. You can defer incoming MIDI program changes, and buttons
mapped to actions, but not defer patch changes made by clicking the Selector object or
using the arrow keys.

Instantly Silencing the Previous Patch
Sometimes you may want the sound of the previous patch to continue after you select
a new patch, as when you want to sustain a chord pad while soloing over it. At other
times, you may want to silence the sound of the previous patch instantly when you select
a new patch.
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To instantly silence the previous patch when you select a patch
µ In the Attributes tab of the Patch Inspector, select the Instantly Silence Previous Patch

checkbox.

Changing the Patch Icon
Each patch has an icon that appears in the Patch List next to the patch name. By default,
the patch icon shows the type of channel strip created when the patch was added. You
can choose a new icon for a patch and use icons to visually distinguish patches in the
Patch List.

To change the icon for a patch
µ In the Attributes tab of the Patch Inspector, choose an icon from the Icon pop-up menu.

Changing the Tuning for a Patch
By default, patches use the same tuning method as the concert (or the set, if they are in
a set with its own tuning method). You can change the tuning for a patch so that it uses
a different tuning. When you change the tuning for a patch, it overrides any concert- or
set-level tuning method.

To change the tuning for a patch
1 In the Patch Inspector, select the Tuning tab.

2 Choose the tuning you want the patch to use from the Method pop-up menu.

Deleting Patches
You can delete a patch if you decide you no longer want it in the concert.

To delete a patch
1 Select the patch in the Patch List.

2 Choose Edit > Delete (or press the Delete key).
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Working with Channel Strips in Edit Mode
Channel strips are the building blocks of your patches. They contain the instruments and
effects for the sounds you use in performance. MainStage channel strips use the channel
strip interface familiar from Logic Pro, with the same structure and many of the same
functions as Logic Pro channel strips. The main features of MainStage channel strips are
shown below:

Settings menu

Pan knob

Icon

Mute and Solo buttons

Insert slots

Send slots and Send Level knob

Level meter and peak 
level display 

Expression control

Channel EQ

Input and Output slots

Volume fader

• Icon: Shows the type of channel strip for easy identification.

• Expression control: Allows you to quickly adjust the expression value of the channel
strip.

• Settings menu: Allows you to load and save the entire routing configuration of a single
channel strip, including all loaded plug-ins and settings.
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• Channel EQ: Allows you to add an EQ effect to sculpt the sound of the channel strip
signal before applying other effects.

• Insert slots: Allow you to insert up to 15 effect plug-ins into each audio, instrument,
aux, and output channel strip.

• Send slots: Allows you to route a channel strip’s signal to an aux channel strip. Sends
are commonly used to apply the same effect or effects to several signals.

• Send level knob: Controls the amount of signal sent to an aux channel strip. This knob
appears when a Send slot is activated.

• Input slot: Sets the channel strip’s input source. Depending on the channel strip type,
it can be a physical input, a bus, or a software instrument plug-in—in this case it is
known as an Instrument slot.

• Output slot: Sets the channel strip’s output path. It can be a physical output or a bus.

• Pan knob: On a mono channel strip, the Pan/Balance knob controls the position of the
signal in the stereo image. On a stereo channel strip, it controls the relative level of the
left and right signals at their outputs.

• Volume fader: Sets a channel strip’s playback volume.

• Mute button: Mutes and unmutes the channel strip.

• Solo button: Solos and unsolos the channel strip.

• Level meter: Displays a channel strip’s playback level.

• Peak level display: Updates during playback to show the highest peak level reached.

In MainStage, you can use audio, software instrument, and auxiliary (aux) channel strips
in your patches and sets, and also at the concert level. You can also use external instrument
patches to “play” external hardware devices and ReWire applications. You can use channel
strips in MainStage just as you can in Logic Pro. You can adjust the volume level using
the Volume fader, adjust the pan position using the Pan knob, and mute or solo the
channel strip using the Mute and Solo buttons.

A MainStage concert can have a maximum of 1023 software instrument channel strips,
512 audio channel strips, 256 external instrument channel strips, and 256 auxiliary (aux)
channel strips.

You can add effects using the Insert slots, send the signal to an auxiliary channel (aux)
using the Sends slots, and choose a different output from the Output slot. For audio
channel strips, you can change the format between mono and stereo using the Format
button. For software instrument channel strips, you can change the instrument using the
Instrument slot. You can also choose, copy, and save channel strip settings, choose a
different channel strip type, or reset the channel strip from the Settings menu.
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If you are famliar with channel strips from Logic Pro, note that there are a few differences
between MainStage channel strips and Logic Pro channel strips:

• MainStage channel strips include an Expression dial so that you can easily see the
current MIDI Expression being received by the channel strip.

• MainStage channel strips do not have a Record Enable or Bounce button.

• MainStage audio channel strips can use automatic Feedback Protection to alert you
when feedback occurs on the channel. For information about using Feedback Protection,
see Using Feedback Protection with Channel Strips.

• MainStage audio channel strips do not have an input monitoring (i) button. You can
use the Mute button to silence the channel strip.

• In MainStage, you can use the Format button to select mono or stereo format. MainStage
does not support surround input or surround processing.

• MainStage channel strips do not have Group or Automation Mode pop-up menus.

• MainStage channel strips include a Change All option in both Input and Output pop-up
menus that you can use to change either the input or output for all channel strips in
a patch, a set, or for the overall concert.

• In MainStage, the selected channel strip is highlighted in white.

• Only one channel strip in each patch–the first audio channel strip–sends audio to the
Tuner. The channel strip that sends audio to the Tuner is indicated by a tuning fork
icon at the top of the channel strip.

• In MainStage, the name of the channel strip changes when you select a new channel
strip setting, unless you have renamed it.

• In MainStage, the channel strip number (at the bottom of the channel strip) reflects its
order in the patch, not the concert.

• Surround plug-ins are not available in MainStage.

• You can choose the information displayed on the channel strip, including latency
information, by Control-clicking the channel strip and choosing the information you
want to display from the shortcut menu.

• The Playback plug-in is available only in MainStage, not in Logic Pro.

• The Loopback plug-in is available only in MainStage, not in Logic Pro.

For complete information about the instruments and effects available in Logic Pro, see
the Logic Pro Instruments and Logic Pro Effects manuals. To learn how to add a channel
strip, see Adding a Channel Strip. To learn how to change a channel strip setting, see
Changing a Channel Strip Setting.
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Selecting Channel Strips
When you add a channel strip to a patch (or add a channel strip at the set or concert
level), the channel strip is selected in the Channel Strips area, and available settings appear
in the Channel Strip Settings browser. You can select a channel strip directly by clicking
it in the Channel Strips area and also select an adjacent channel strip by using key
commands:

SelectionKey command

The channel strip to the leftLeft Arrow

The channel strip to the rightRight Arrow

Showing Signal Flow Channel Strips
In addition to the channel strips in a patch, you can view and edit signal flow channel
strips in the Channel Strips area. Signal flow channel strips include the Output and Master
channel strips for the concert, auxes that are receiving signal from a channel strip in the
patch, and any set- or concert-level channel strips that are available when the patch is
selected. You can also view signal flow channel strips at the set level.

When you show signal flow channel strips, channel strips at the concert level, including
Output and Aux channel strips, include a small concert icon near the top of the channel
strip to make it easy to distinguish them from patch-level channel strips. Channel strips
at the set level include a small folder icon so they can also be easily distinguished.

You can edit signal flow channel strips in the Channel Strips area. For example, you can
adjust the volume fader or pan slider of a signal flow channel strip, or add effects to an
aux channel strip.

To show signal flow channel strips
µ Choose Show Signal Flow Channel Strips from the Action menu in the upper-right corner

of the Channel Strips area.

Creating an Alias of a Channel Strip
You can create an alias of a channel strip and use the alias in different patches or sets.
Aliases allow you to share highly memory-intensive plug-ins, such as third-party
multichannel instruments and samplers, between different patches, rather than creating
multiple instances of these plug-ins. In some cases, creating an alias can be more efficient
(use fewer resources) than adding a concert- or set-level channel strip.

To create an alias of a channel strip
1 In the Channel Strips area, select the channel strip.

2 Choose Edit > Copy, or press Command-C (default).

3 In the Patch List, select the patch in which you want to use the alias.

4 Choose Edit > Paste as Alias, or press Command-Option-V (default).

53Chapter 5 Working in Edit Mode



The alias is pasted after the last channel strip in the patch (but before any signal flow
channel strips, if they are visible). An alias icon appears near the top of the alias to
distinguish it from the channel strips in the patch.

You can use an alias in multiple patches or sets. When you change settings on the original
channel strip (with the exception of volume, pan, and expression), those changes are
reflected in the aliases of the channel strip. You may want to audition each patch that
uses an alias after changing the settings of the original channel strip, to make sure it
sounds the way you want.

Note: You can’t import a patch or set containing an alias, because the aliased channel
strip may not be available.

You can create an alias of a multi-output instrument, such as the EXS24 mkII, to use in
another patch or set in the concert. When you copy a multi-output instrument to create
an alias, be sure to select all of the aux channel strips for the instrument so that the
complete multi-output instrument is pasted as an alias. For information about using
multi-output instruments in MainStage, see Using Multiple Instrument Outputs in
MainStage.

Editing Channel Strips in MainStage
You can add instruments to software instrument channel strips and add effects to any
channel strip in the Channel Strips area. Adding instruments and effects to a channel
strip is the same in MainStage as it is in Logic Pro.

You edit channel strip parameters in the Channel Strip Inspector, which appears below
the workspace when the channel strip is selected in the Channel Strips area. You can set
the key range and velocity offset, create a controller transform, and filter MIDI control
messages to the channel strip. You can also rename the channel strip and change the
channel strip color and icon. The Channel Strip Inspector has four tabs, which provide
the following functions:

• Channel Strip Library and Plug-In Library: With a channel strip selected, you can choose
channel strip settings from the Channel Strip Library. With an Insert slot selected, you
can choose settings for the plug-in from the Plug-in Library.

54 Chapter 5 Working in Edit Mode



• Attributes: You can rename the channel strip and choose a different channel strip color
and icon.

• MIDI Input: You can create controller transforms in the MIDI Input tab. For software
instrument and external instrument channel strips, you can also choose the MIDI input
device, filter MIDI input, transpose the instrument, and create velocity scaling graphs.

• Layer Editor: For software instrument and external instrument channel strips, you can
define the key range, set floating split points, and set the minimum and maximum
velocity for the channel strip.

Using the Channel Strip Library you can access any available channel strip. Some channel
strips, however, include plug-ins (particularly Space Designer) not suited for live
performance because of their intensive CPU usage. Using these channel strips can affect
the performance of your concert, resulting in audio dropouts and other issues.

Logic Pro surround effect plug-ins cannot be used with MainStage. If you choose a channel
strip setting containing one of these effects, the unused effects are shown disabled (gray,
with a diagonal line running through the effect name).

Choosing Channel Strip Settings
You can quickly change the instrument, effects, and other parameters for a channel strip
by choosing a new channel strip setting. You can choose a new channel strip setting in
one of two ways:  by using the Channel Strip Library or by using the Settings button at
the top of the channel strip.

To choose a channel strip setting from the Channel Strip Library
1 In the Channel Strips area, select the channel strip you want to change.

The selected channel strip is highlighted with a blue outline.

2 In the Channel Strip Inspector, click the Channel Strip Library tab.

Available settings for the channel strip appear in the Channel Strip Library. MainStage
built-in channel strip settings appear in a series of folders with different instrument
categories. If you have GarageBand installed, or have one or more Jam Packs installed on
your computer, those settings appear below the built-in settings.
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3 Click a category from the column on the left, then click subcategories from the columns
on the right until you see the settings you want.

You can select a recent channel strip setting by clicking Recent in the column on the left,
and then selecting a recent setting from the second column. You can also choose a new
channel strip setting from the Settings menu at the top of the channel strip.

To choose a channel strip setting from the Settings menu
µ Click the Settings button at the top of the channel strip, then choose a new setting from

the menu that appears.

When you choose new channel strip settings from the Settings menu, the selected channel
strip setting does not appear selected in the Channel Strip Library.

You can also search for channel strip settings by name.

To search for channel strip settings in the Channel Strip Library
1 In the Channel Strip Inspector, select the Channel Strip Library tab.

2 Choose Find in Library from the Action menu in the upper-right corner of the Channel
Strip Inspector.

3 In the dialog that appears, type the text you want to search for.

The channel strip with the text in its name appears selected in the library.

4 If more than one channel strip includes the search text, choose “Find Next in Library”
from the Action menu to cycle through the channel strips with names containing the
text.

5 To change the channel strip setting, click the name of the new setting in the Channel
Strip Inspector.
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The Channel Strip Library shows all available channel strip settings, including settings
that may not be useful in MainStage. If you choose a channel strip setting containing
plug-ins not usable in MainStage, the plug-ins appear with a bold diagonal line in the
Channel Strips area.

Renaming a Channel Strip
When you add a channel strip to a patch, the channel strip has a default name. You can
rename channel strips to distinguish your custom settings from the default ones.

To rename a channel strip
µ In the Attributes tab of the Channel Strip Inspector, select the name in the Name field

and type a new name.

Type a new name 
in the field.  

Changing the Channel Strip Color
Each channel strip has a color, which appears at the bottom of the channel strip and as
a layer above the keyboard screen control in the workspace and the Layer Editor. You
can change the color of a channel strip to make it easier to visually distinguish channel
strips.
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To change the color of a Software Instrument channel strip
µ In the Attributes tab of the Channel Strip Inspector, choose a color from the Color pop-up

menu.

Choose a color from the 
pop-up menu.

Changing the Channel Strip Icon
When you add a channel strip, the channel strip has a default icon, which appears above
the Settings menu. You can change the icon to help visually distinguish channel strips
with different instrument types or uses.

To change the icon for a channel strip
µ In the Attributes tab of the Channel Strip Inspector, choose an icon from the Icon well.

Choose an icon from 
the menu.
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Using Feedback Protection with Channel Strips
You can use Feedback Protection on audio and external instrument channel strips in
MainStage. Feedback Protection is turned on by default for audio channels strips and off
by default for external instrument channel strips. You can turn Feedback Protection on
or off for individual channel strips in the Channel Strip Inspector.

To turn Feedback Protection on or off
µ In the Attributes tab of the Channel Strip Inspector, select the Feedback Protection

checkbox to turn Feedback Protection on. Deselect the checkbox to turn it off.

When Feedback Protection is turned on for a channel strip, MainStage alerts you when
it detects feedback on the channel. When the feedback alert appears, the channel is
temporarily silenced. You can then choose to mute the channel while you find and
eliminate the source of the feedback, disable Feedback Protection for all audio and external
channel strips in all concerts, or continue to use the channel and receive alerts when
feedback occurs.

For more information about disabling Feedback Protection globally, see Audio Preferences.

Setting Keyboard Input for a Software Instrument Channel Strip
In the Channel Strip Inspector, you can choose the keyboard controller from which the
channel strip receives MIDI input. If you are using a multitimbral instrument, you can also
choose the input for each MIDI channel. For example, you can use the EVB3 instrument
as a multitimbral instrument, and send input to the upper and lower register and the
foot pedal using three separate MIDI channels.

To set the keyboard input for a software instrument channel strip
1 In the Channel Strip Inspector, click the MIDI Input tab.

2 Choose the MIDI input device from the Keyboard pop-up menu in the Input section.

The names in the Keyboard pop-up menu correspond to keyboard screen controls in the
workspace.

To set multitimbral input for different MIDI channels
1 In the Channel Strip Inspector, click the MIDI Input tab.

2 Choose Multitimbral from the Keyboard pop-up menu in the Input section.

3 In the Multitimbral Settings dialog, choose the input device for each MIDI channel you
want to receive MIDI input.

Transposing Software Instrument Channel Strips
You can transpose (change the pitch of ) a software instrument channel strip. When you
transpose a channel strip, every MIDI note received by the channel strip is transposed by
the number of semitones set in the Transpose value slider.
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To transpose the MIDI input of a software instrument channel strip
1 Select the channel strip in the Channel Strips area.

2 In the MIDI Input tab of the Channel Strip Inspector, set the value using the Transpose
value slider. You can click the value and drag up or down to set the value, click the up
arrow or down arrow, or double-click the value and type a new value.

Filtering MIDI Messages
You can filter some MIDI messages for a channel strip in the Channel Strip Inspector.
When you select one or more MIDI message types in the Filter section of the Channel
Strip Inspector, the corresponding MIDI message types are filtered out of any incoming
MIDI data and are not sent to the channel strip.

You can filter the following types of MIDI messages:

• Pitch Bend

• Sustain (control message 64)

• Modulation (control message 1)

• Expression (control message 11)

• Aftertouch

To filter incoming MIDI messages
1 In the Channel Strip Inspector, click the MIDI Input tab.

2 In the Filter section of the MIDI Input tab, select the checkbox for the MIDI messages you
want to filter.

If you have created a controller transform, you can filter the input message type, and the
controller transform will still send its output message type. It is also possible to filter the
output message type, but in this case the output of the controller transform will be filtered.

Setting a Channel Strip to Ignore Hermode Tuning
If a patch (or the concert or set containing the patch) is set to use Hermode tuning, but
the patch contains a channel strip (for example, one with a drum or percussion instrument)
that you do not want to use Hermode tuning, you can set the individual channel strip to
ignore Hermode tuning.

To set a channel strip to ignore Hermode tuning
µ In the MIDI Input tab of the Channel Strip Inspector, select the Ignore Hermode Tuning

checkbox.

For information about using Hermode tuning, see the Logic Pro User Manual.
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Working with Graphs
Using graphs, you can graphically remap the values for some MIDI control messages so
that input values from your controller produce different output values for the channel
strip or plug-in parameter. Graphs make it easier to see and modify a range of values for
a parameter, such as velocity or filter cutoff.

You can use graphs for the following types of parameters:

• Controller transforms

• Velocity scaling (both input velocity and note input)

• Parameters to which a screen control is mapped

You open a graph window by clicking the button for that type of graph in the appropriate
Inspector. The Transform and Velocity Scaling graphs for the selected channel strip are
available in the MIDI Input tab of the Channel Strip Inspector. The Parameter graph for
the selected screen control is available in the tab for the individual mapping as well as
in the Mappings tab in the (Edit mode) Screen Control Inspector.

The graph shows the range of input values on the horizontal (x) axis, moving from left
to right, and shows the range of output values on the vertical (y) axis, moving from bottom
to top.

In the graph window, you have several ways of working. You can edit the graph curve
directly, edit values numerically using the Precision Editor, or use the Curve buttons to
set the graph to one of the predefined curves.

Most of the ways you edit graphs are the same, regardless of the type of graph—although
there are a few features specific to one or another type. For Parameter graphs, you can
change the minimum and maximum range values for the graph using the Range Min
and Range Max value sliders. For information about controller transforms, see Creating
Controller Transforms. For information about velocity scaling, see Scaling Channel Strip
Velocity. For information about parameter mapping graphs, see Using Parameter Mapping
Graphs.

To edit a graph
1 Select the channel strip or screen control you want the graph to apply to.

2 Select the MIDI Input tab (for transform and velocity scaling graphs) or the Mapping tab
(for parameter mapping graphs).

3 Click the graph button for the type of graph you want to edit.

The graph window opens.

4 Do one of the following:

• Click one of the Curve buttons to set the graph to one of the preset curves.
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• Click the curve at the point where you want to add a node, then drag the node to the
desired value. Drag horizontally to change the input value, or vertically to change the
output value.

As you drag, the current values of the node appear next to the pointer.

• Double-click the curve at the point where you want to add a node, then edit the values
for the node in the Precision Editor.

• Option-click any part of the curve (except a node), then drag the dotted part of the
curve to make the curve nonlinear.

5 Continue adding and adjusting points on the curve until you achieve the result you want.

6 When you are finished, click the close button at the upper-left corner of the graph window
to close it.

To invert the values of the graph
Do one of the following:

µ In the graph window, click the Invert button.

µ In the tab for the mapping, select the Invert Parameter Range checkbox.

To reset the graph to its default values
µ Click the Revert to Default button at the top of the graph window.

After you have edited a graph, the button for the graph in the Inspector shows the edited
shape of the graph in a dark blue color to make it easier to identify which graphs you
have edited and how.

To close the graph window
µ Press Escape (Esc).

Creating Controller Transforms
Using a transform graph, you can remap the values for some MIDI control messages so
that input values from your controller produce different output values for the channel
strip. A common use of the transform is for expression scaling, where input MIDI expression
values are mapped to different output values on a graphic curve.

In addition, you can transform input values for one message type to output values for
another message type. For example, you can transform MIDI volume values from your
controller to send expression values to the channel strip, or transform input breath values
to send modulation values. The transform graph provides a very flexible way of remapping
both the values and the output destination for these MIDI control messages. In MainStage,
you can transform values for expression, modulation, MIDI volume, and breath control
messages.
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You choose the input and output message types and graphically create transform curves
in the MIDI Input tab of the Channel Strip Inspector. In a transform graph, the horizontal
axis represents input values from your controller, and the vertical axis represents output
values sent to the channel strip.

To set the input and output message types for a controller transform
1 In the Channel Strips area, select the channel strip for which you want to create a controller

transform.

2 In the Channel Strip Inspector, select the MIDI Input tab.

3 In the Controllers section, choose the input message type from the Input pop-up menu.

4 Choose the output message type from the Output pop-up menu.

Click the Transform button 
to edit the graph.

Choose the input and 
output message types 
from these menus.

To open the Transform graph
µ In the MIDI Input tab of the Channel Strip Inspector, click the Transform button.

The Transform graph opens.

If a patch contains more than one channel strip with a transform graph, the transform
curves for the other channel strips in the patch appear in the controller Transform graph
window behind the current curve. Each channel strip in the patch can have its own
controller transform.

For information about editing the graph, see Working with Graphs.

Scaling Channel Strip Velocity
You can scale the output velocity of a channel strip using the Velocity Scaling graphs.
You can scale output velocity based on note input or input velocity.

When you perform velocity scaling, each input velocity (regardless of the note being
played) is scaled to the output velocity.
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When you perform note scaling, output velocity is scaled depending on the note in the
key range. This is useful when you want to have a parameter change in different parts of
the key range; for example, when a filter or attack parameter opens for higher note values
to give a brighter, sharper sound.

To open a velocity scaling graph
1 In the Channel Strips area, select the channel strip on which you want to perform velocity

scaling.

2 In the Channel Strip Inspector, select the MIDI Input tab.

3 In the MIDI Input tab, do one of the following:

• To open the velocity input graph, select the Velocity Input button.

• To open the note input graph, select the Note Input button.

The selected velocity scaling graph opens.

For information about editing the graph, see Working with Graphs.

Creating Keyboard Layers and Splits
If you play a keyboard controller, you can easily create keyboard layers and splits in your
MainStage patches. You create layers and splits by adding two or more channel strips to
a patch and setting the Low Key and High Key for each channel strip to define its key
range. The key range defines the range of notes on a keyboard controller that trigger
sound from a software instrument or external instrument in the channel strip. You can
define key ranges so that they overlap (for layered sounds) or are contiguous (for splits).

The Layer Editor tab in the Channel Strip Inspector shows the key range for each channel
strip in a patch and in the concert or set containing the patch (if either includes a channel
strip with a key range). You can define the key range for a channel strip in one of several
ways:  you can drag the edges of the layer, use the Learn buttons to define the Low and
High keys, or use the Low Key and High Key value sliders.

To open the Layer Editor
µ In the Channel Strip Inspector, click the Layer Editor tab.

To define a key range using the layers
1 In the Layer Editor, move the pointer over the left edge of the layer you want to

change/define.

The pointer changes to a resize pointer.

2 Drag the left edge of the layer to the note you want to use as the low key (the lowest
note in the key range).

3 Move the pointer over the right edge of the layer.

4 Drag the right edge of the layer to the note you want to use as the high key (the highest
note in the key range).
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To define a key range using the Learn buttons
1 In the Channel Strips area, select the channel strip.

2 In the Channel Strip Inspector, click the Layer Editor tab.

3 Click the Learn button next to the Low Key value slider.

Click Learn and play the 
corresponding note on 
your music keyboard. 

4 On your keyboard controller, press the key you want to set as the lowest key in the key
range.

5 Click the Learn button again to turn off Learn mode for the Low Key.

6 Click the Learn button next to the High Key value slider.

7 On your keyboard controller, press the key you want to set as the highest key in the key
range.

8 Click the Learn button again to turn off Learn mode for the High Key.

When you play the patch, you hear the channel strip when you play notes inside the key
range. When you play notes outside the key range, no sound is generated from the
channel strip.

To define a key range using the value sliders
1 In the Channel Strips area, select the channel strip.

2 In the Channel Strip Inspector, click the Layer Editor tab.

3 Change the value in the Low Key value slider.
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You can click the value and drag vertically, click the up arrow or down arrow, or
double-click the value and type a new value.

Set the high key and 
low key using these 
value sliders. 

4 Change the value in the High Key value slider.

You can click the value and drag vertically, click the up arrow or down arrow, or
double-click the value and type a new value.

Setting Floating Split Points
When a key range has a floating split point, the notes that define the boundaries of the
key range ends change depending on the keys you play as you approach the boundary
of the key range. You set floating split points in the Layer Editor tab of the Channel Strip
Inspector.

Floating split points can be explained using an example. If you set the Low Key of a key
range to C1, set a floating split point value of 3, then play notes immediately above C1
(for example, the notes F1-Eb1-D1), and continue playing downward past C1 (for example,
the notes C1-Bb0-A0), the split point moves down to include those notes, up to the
floating split point value (3 semitones). If, however, you start by playing notes immediately
below the Low Key (for example, the notes G0-A0-B0) and continue playing upward past
C1 (for example, the notes C1-D1-E1), the split point moves up to include those notes,
up to the floating split point value. (In this example, C1 and D1 would be included, but
not E1, which is four semitones above the Low Key.)

To set floating split points for a layer/key range
1 In the Layer Editor tab, click the Low Key Floating value slider and drag vertically to change

the value, or double-click the current value and type a new value (the value is the number
of semitones used for the split).
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2 Click the High Key Floating value slider and drag vertically to change the value, or
double-click the current value and type a new value.

You can also create a keyboard split by adding a channel strip at the set level and adjusting
the key range of the channel strips in the patches in the set. The channel strip at the set
level takes precedence over any channel strips in patches in the set for the notes in its
key range. For information about adding a channel strip at the set level, see Working at
the Set Level.

Setting the Velocity Range
By default, the velocity of a channel strip extends from 1 to 127. You can limit the velocity
range so that the channel strip only responds when the notes you play on your controller
fall between the Min and Max values of the velocity range.

To set the velocity range for a channel strip
1 In the Channel Strips area, select the channel strip.

2 In the Channel Strip Inspector, click the Layer Editor tab.

3 In the Layer Editor, set the minimum velocity that triggers the channel strip using the
Velocity Min value slider. (Click the value and drag vertically to change the value, or
double-click the value and type a new value.)

4 Set the maximum velocity that triggers the channel strip using the Velocity Max value
slider.

Overriding Concert- and Set-Level Key Ranges
If a software instrument channel strip exists at the concert level, the concert-level channel
strip takes precedence over any patch-level software instrument channel strips within its
key range. This means that when you play any notes in the key range of the concert-level
channel strip on a keyboard controller, you hear only the concert-level channel strip, even
when a patch is selected.

Similarly, if a software instrument channel strip exists at the set level, the same condition
applies for all patches in the set. That is, the set-level channel strip takes precedence over
any patch-level channel strips within its key range.

You can override concert- or set-level channel strips for a channel strip on an individual
patch, so that the patch-level channel strip takes precedence over the concert-level or
set-level channel strips.

To override concert- or set-level key ranges
1 In the Patch List, select the patch with the channel strip that you want to override the

concert- or set-level channel strip.

2 In the Channel Strips area, select the channel strip with the key range that you want to
override the concert- or set-level key range.
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3 In the Channel Strip Inspector, select the Layer Editor.

4 Select the “Override parent ranges” checkbox.

The “Override parent ranges” checkbox is available only if there is a concert- or set-level
channel strip.

Using the EXS24 mkII Instrument Editor in MainStage
For channel strips using the EXS24 mkII sampler instrument, you can edit sampler
instrument zones and groups in the EXS Instrument Editor. The EXS24 mkII Instrument
Editor works exactly the same in MainStage as it does in Logic Pro, with one exception:  in
MainStage, you cannot open the Sample Editor to edit individual audio samples.

In an EXS24 mkII instrument, a zone is a location into which a single sample (an audio
file) is loaded from a hard disk. You can edit zone parameters in Zone view mode. Zones
can be assigned to groups, which provide parameters that allow you to simultaneously
edit all zones in the group. You can define as many groups as desired. The Instrument
Editor has two view modes:  Zones view and Groups view. You can edit zones in Zones
view and edit group parameters in Groups view.

To open the EXS24 mkII Instrument Editor
1 In a channel strip using the EXS24 mkII, double-click the EXS24 slot in the I/O section.

2 In the upper-right area of the EXS24 mkII plug-in window, click the Edit button.

Click the Edit button 
to open the 
Instrument Editor.

The Instrument Editor opens. When you play notes on the keyboard of the EXS24 mkII
Instrument Editor, the notes are played on the selected channel strip. You can switch
between Zones view and Groups view, click individual zones to view their parameters,
click notes on the keyboard to hear the samples assigned to them, create zones and
groups, and edit zone and group parameters just as you can in Logic Pro.
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For in-depth information about using the EXS24 mkII Instrument Editor, refer to the
Logic Pro Instruments manual.

Using Multiple Instrument Outputs in MainStage
MainStage supports the multiple output versions of the EXS24 mkII, Ultrabeat, and some
Audio Units instruments. You can insert multi output instruments and use them to route
different outputs to different physical outputs, apply different plug-ins or processing to
different outputs, or for other uses.

If an instrument supports multiple outputs, one or more multi output versions are available
in the Instrument Plug-in menu for the instrument.

The Plug-in menu shows specific information about output configurations, for
example:  EXS24:  Multi Output (5xStereo, 6xMono).

Note: Not all instruments support multiple outputs. If no multi output version is available
in the Plug-in menu, the instrument does not support multiple outputs.

To insert a multi output instrument
1 On the channel strip in which you want to use the multi output instrument, click the

Instrument slot.

2 Choose the instrument from the Plug-in menu, and choose the multi output version from
the submenu.
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The instrument name appears in the Instrument slot, and a small Add (+) button appears
below the Solo button on the channel strip. The Output for the instrument is set to Output
1-2.

3 Double-click the Instrument slot to open the instrument (plug-in) window.

You need to set up the output routing for individual sounds or samples in the instrument
(plug-in window). You set up output routing for the EXS24 mkII in the Instrument Editor,
and set up output routing for Ultrabeat in the Output menu of the Assignment section
of the Ultrabeat window.

4 On the channel strip, click the Add button to add additional outputs.

Each time you add an output, a new section of the channel strip is added, with the next
available pair of outputs.

Each output uses the same instrument, but each can have its own inserts, volume, pan,
and expressions settings and its own effect sends, as well as its own outputs.

For more information about using multiple instrument outputs, see the Logic Pro
User Manual and the Logic Pro Instruments manual. Information about specific instruments
(for example, Ultrabeat) can be found in the chapters covering those instruments.

Using External MIDI Instruments in MainStage
You can add an external MIDI instrument channel strip to a patch and use it to play an
external instrument, such as a hardware synthesizer. You can also use an external
instrument to “play” a ReWire application.

When you use an external MIDI instrument channel strip, you choose the MIDI channel
to send MIDI output from MainStage to the instrument, and choose the audio inputs to
receive audio from the instrument. The audio output from the instrument is routed to
the input of the channel strip, where you can process it using MainStage effects.

To add an external instrument channel strip
1 Click the Add Channel Strip (+) button in the upper-right corner of the Channel Strips

area.

2 In the New Channel Strip dialog, select External Instrument.

You can also choose the MIDI input and output, the format, and the audio input and
output for the channel strip. You can choose an audio channel or a ReWire application
for the input, but cannot choose a bus. The MIDI input pop-up menu shows the Keyboard
or MIDI Activity screen controls (which receive MIDI note input) currently in the workspace.

Note: When using an external instrument to send MIDI to a ReWire slave application
(such as Reason or Live), you should disable any MIDI input the slave application receives
directly from the hardware controller. For information about disabling MIDI input from
a hardware device, consult the documentation for the application.
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For ReWire applications, when you add an external channel strip, set the MIDI port to the
ReWire slave. The Channel list also updates based on the port. Some ReWire slaves set
up multiple ports. To use a ReWire application with MainStage, open the ReWire application
after opening MainStage.

When you play your keyboard controller with the patch containing the external MIDI
instrument selected, MainStage sends note and other MIDI messages to the chosen MIDI
Output and MIDI Channel, receives audio from the chosen Input, and sends the audio
output to the chosen Output. You can also send a program change message to the
external instrument when you select the patch to control which program the external
instrument uses.

To send a program change to an external instrument when you select a patch
1 In the Channel Strip Inspector, click the MIDI Out tab.

2 In the MIDI Out tab, select the Send Program Change checkbox.

The Program Change value is set to –1 by default, so that no program change is sent
when you select the Send Program Change checkbox, until you change the value.

3 Set the program change number you want to send using the Send Program Change value
slider.

4 If you want to send a Bank Change message, select the Send Program Change checkbox,
then set the most-significant byte (MSB) and least-significant byte (LSB) of the bank
change number using the Bank MSB and Bank LSB value sliders.

When you select the patch, the program change and bank change messages are sent to
the external instrument. Also note that program and bank changes are sent when you
edit the program change and bank change value sliders in the Channel Strip Inspector
(so you can be sure that the values you enter send the correct program and bank change
messages).

If you want the external instrument to respond to the program change, but do not want
it to receive note or other MIDI information from your controller, click the MIDI Input tab
and choose None from the Keyboard pop-up menu.

You can also use a knob or fader mapped to the Program Change action to send program
changes to an external instrument.

To send program changes to an external instrument using a screen control
1 In the workspace, click the screen control you want to use to send program change

messages.

2 In the Screen Control Inspector, click the Unmapped tab.

3 In the Mapping browser, select the external instrument, then select MIDI Controller folder
from the submenu.

4 In the third column from the left, select Program Change.
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The screen control is mapped to the Program Change parameter. By moving the hardware
control assigned to the screen control, you can send program changes to the external
instrument.

Note: If the MIDI Out parameter of the external instrument channel strip is set to the
external instrument when you map the screen control to the Program change parameter,
a program change (Program 0) is sent when you create the mapping. If you are editing
the program on the external instrument, your changes may be lost. To map the screen
control without sending an immediate program change to the external instrument, choose
None from the MIDI Out slot of the external instrument before you create the mapping,
then choose the external instrument in the MIDI Out slot. No program change is sent
until you move the knob or fader.

You can also send MIDI messages, including SysEx and continuous control messages, to
your connected MIDI hardware devices using an external instrument channel strip. The
Channel Strip inspector includes a Send MIDI File control where you can select a standard
MIDI file with the information you want to send.

To send a MIDI file using an external instrument
1 In the External Instrument Channel Strip inspector, click the MIDI Output tab.

2 Select the Send MIDI File checkbox, then click the Select button.

3 Browse to the location of the MIDI file you want to add, select the file, then click Send.

The MIDI file is sent immediately to the port selected on the external instrument channel
strip. The MIDI file is re-sent on patch change just like the other options in the Channel
Strip inspector (such as Program Change or MIDI Clock messages).

Only SMF (standard MIDI file) types 0 and 1 are supported. MIDI files are sent sequentially,
one at at time, per concert. If you switch rapidly through several patches that send long
MIDI files, the MIDI files are queued and sent in succession. MIDI messages are sent at
the tempo stored in the MIDI file.

Using the Activity Monitor
As you work on your concert in Edit mode, the Activity Monitor in the toolbar shows the
current CPU and memory information as well as received MIDI messages. The CPU section
of the Activity Monitor glows red to indicate a CPU overload condition.

The Memory section of the Activity Monitor glows yellow to indicate a low-memory
condition. Low-memory conditions can be caused by having too many memory-intensive
channel strips or plug-ins in a concert or by using other memory-intensive applications
(including ReWire applications) together with the concert. If a low-memory condition
occurs, try reopening the concert and consolidating some memory-intensive plug-ins or
channel strips.
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Deleting Channel Strips
You can delete a channel strip if you decide you no longer want it in a patch.

To delete a channel strip
1 Select the channel strip in the Channel Strips area.

2 Choose Edit > Delete (or press the Delete key).

Working with Plug-ins in Edit Mode
MainStage includes a full collection of professional-quality Logic Pro plug-ins for
instruments and effects, as well as utility plug-ins such as the Tuner.

You can use plug-ins in MainStage channel strips in patches, and also at the concert and
set level. You use instrument plug-ins in sofware instrument channel strips, and you can
use effect plug-ins in audio, software instrument, external instrument, and auxiliary channel
strips. In addition to the built-in factory plug-ins, you can use Audio Units plug-ins for
both instruments and effects in MainStage.

Adding, Removing, Moving, and Copying Plug-ins
You can add plug-ins to a channel strip, replace a plug-in with a different one, and remove
plug-ins from a channel strip. You can also move, reorder, and copy plug-ins within a
channel strip, or between channel strips.

To add an instrument plug-in
µ Click and hold the Instrument slot, then browse through the plug-in menu to find and

select the plug-in you want to use.

To add an effect plug-in
µ Click the Insert slot, then browse through the plug-in menu to find and select the plug-in

you want to use.

To replace a plug-in
µ Click and hold the Insert or Instrument slot, then browse through the plug-in menu to

find and select a plug-in to replace the existing one.

To remove a plug-in
µ Click and hold the Insert or Instrument slot, then choose 0No Plug-in from the menu.

To move a plug-in
µ Hold down the Command key while dragging the plug-in to an empty slot, either on the

same channel strip or on another channel strip.

To reorder plug-ins
µ Hold down the Command key while dragging the plug-in to an occupied slot, either on

the same channel strip or on another channel strip.
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To copy a plug-in
µ Hold down Command-Option while dragging the plug-in to another slot, either on the

same channel strip or on another channel strip.

Using the Channel EQ
The Channel EQ allows you to sculpt the sound of the channel strip before applying other
effects.

To use the Channel EQ plug-in
1 Double-click the EQ icon at the top of the channel strip.

The Channel EQ plug-in is added to the first available Insert slot and the plug-in window
opens.

2 Do one of the following:

• Choose a Channel EQ setting from the Settings menu at the top of the plug-in window.

• Graphically edit an EQ band by dragging vertically to change the level or dragging
horizontally to change the center frequency.

• Numerically edit an EQ band by clicking and dragging the number to raise or lower
the value; or by double-clicking, then typing a new value.

For detailed information about using the Channel EQ effect, refer to the Logic Pro Effects
manual.

Using Plug-in Settings
MainStage plug-ins include settings that combine a set of parameter values optimized
for a specific result. For an instrument plug-in, a setting may re-create the characteristic
sound of a particular instrument, while for an effect plug-in, it may be tailored for use
with a specific instrument or to create a particular sound. You can choose settings, copy
and paste settings, save settings and perform other functions in the Settings menu for
each plug-in.

To choose a plug-in setting
1 Double-click the plug-in slot to open the plug-in window.

2 Click the Settings menu (at the top of the plug-in window), browse to the setting you
want, then select it.

Tip: You can also select the plug-in slot, then choose a plug-in setting in the Channel
Strip Inspector.

To choose the previous plug-in setting
µ Click the left arrow next to the Settings menu (or choose Previous Setting from the Settings

menu).
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To choose the next plug-in setting
µ Click the right arrow next to the Settings menu (or choose Next Setting from the Settings

menu).

To copy and paste plug-in settings
1 Click the Copy button in the plug-in window header (or choose Copy Setting from the

Settings menu).

This copies all parameter settings into a plug-in settings Clipboard, which is independent
of the global Clipboard.

2 Click the Paste button in the plug-in window header (or choose Paste Setting from the
Settings menu).

To save changes to a plug-in setting
µ Choose Save Setting to save the current plug-in parameter values as the setting. This

overwrites the existing setting.

µ Choose Save Setting As to name and save a setting, including its folder location. You can
create a new folder in the Save As dialog, if you wish.

Note: Subfolders must be located in the folder for the corresponding plug-in. For example,
you could save a setting called Euro Lead in the Lead Synths subfolder of the ES2 folder.

To revert to a plug-in’s default settings
µ Choose Reset Setting from the Settings menu.

To create a default setting
µ Save a setting called #default in the Settings folder for the plug-in.

To delete a plug-in setting
µ Choose Delete Setting from the Settings menu.

Adjusting Plug-in Parameters
Each plug-in window contains controls to adjust the values of the parameters for that
plug-in. Some controls, such as buttons, knobs, and sliders, are shared by different plug-ins,
while others are unique to a particular plug-in. Most controls are labeled to show the
parameter they affect. Full details on the parameters of each individual plug-in can be
found in the Logic Pro Instruments and Logic Pro Effects manuals.

To adjust plug-in parameters
Do one of the following:

µ Click buttons to switch them on or off.

µ Drag knobs vertically to adjust their value.

µ Drag sliders horizontally or vertically, depending on their orientation.

µ Type a value into a numbered field.
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µ Select a control, then move your mouse wheel or swipe your trackpad to adjust the value.

To reset a parameter to its default value
µ Option-click the parameter.

To adjust a parameter in finer increments
µ Hold down the Shift key before manipulating a control.

Using Other Plug-in Window Controls
All Logic plug-ins share a common header. In addition to the Settings menu, the header
includes controls for switching between views, bypassing the plug-in, and comparing
plug-in settings before and after adjustments. You will also find extended plug-in
parameters at the bottom of some plug-in windows.

You can view plug-in parameters in Editor view, which shows a graphical interface for
the plug-in, or in Controls view, which shows parameters arranged in a row of value sliders
where appropriate.

To switch between Editor and Controls view
µ Choose the Controls or Editor item in the plug-in window header’s View menu.

To bypass a plug-in
µ Click Bypass in the plug-in window header.

To compare the plug-in before and after adjustments
1 Click Compare in the plug-in window header to hear the plug-in with its saved settings.

2 Click Compare again to hear the plug-in with your latest changes (since saving).

To show extended plug-in parameters
µ Click the disclosure triangle at the bottom of the plug-in window.

Mapping Screen Controls
After you have created your patches and learned controller assignments for the screen
controls you want to use, you can map MainStage screen controls to channel strip and
plug-in parameters to modify the sound of your patches while you perform, or map them
to MainStage actions to control other functions.
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You map screen controls to parameters in Edit mode. After you learn controller
assignments (in Layout mode), the screen controls in the workspace do not respond to
movements of physical controls on your MIDI hardware until you map them to channel
strip parameters (in Edit mode). There are two ways to map screen controls to
parameters:  by visually selecting parameters on channel strips or plug-in windows or by
choosing parameters in the Parameter Mapping browser. You can also create mappings
in the Assignments & Mappings table. For information, refer to Working in the Assignments
and Mappings tab.

Mapping Screen Controls to Channel Strip and Plug-in Parameters
After you have made your controller assignments, you can begin mapping screen controls
to the parameters in your patches you will want to control while you are performing. You
will likely want to map screen controls to parameters in each patch in a concert, so that
you can easily access and modify the parameters you want for each patch when you are
performing live. You can also map parameters at the concert level to control master
volume, view master levels, or modify concert-wide effects.

You can map screen controls to channel strip and plug-in parameters in one of two
ways:  by mapping screen controls visually to parameters on the channel strip or in a
plug-in window or by using the Parameter Mapping browser.

You map screen controls to parameters in Edit mode. The screen controls in the workspace
do not respond to movements of physical controls on your MIDI hardware until you map
them to channel strip parameters.

To map a screen control to a channel strip or plug-in parameter
1 In the workspace, click the screen control you want to map.

The screen control is highlighted in blue. The Screen Control Inspector appears below
the workspace, showing the parameters for the selected screen control. The Screen Control
Inspector includes General and Mapping tabs as well as a tab labeled Unmapped.

2 Press Command-L.

The Screen Control Inspector opens to the Unmapped tab, showing the Parameter
Mapping browser. The Map Parameter button lights red to indicate that mapping is active.

3 To map the screen control to a channel strip parameter, click the control for the parameter
on the channel strip in the Channel Strips area.
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4 To map the screen control to a plug-in parameter, double-click the plug-in in the Inserts
section of the channel strip to open the plug-in window, then click the parameter in the
plug-in window.

Click the parameter in 
a channel strip or 

plug-in window.

Click the screen control 
you want to map to a 
parameter.

The screen control is mapped to the selected parameter, and the Unmapped tab takes
the name of the parameter. You can continue mapping additional screen controls by
clicking them in the workspace and then clicking the corresponding parameters in a
channel strip or plug-in window.

5 When you are finished, press Command-L again (or click the Map Parameter button) to
turn off mapping.

To map a screen control using the Parameter Mapping browser
1 In the workspace, click the screen control you want to map.

The screen control is highlighted in blue. The Screen Control Inspector appears below
the workspace, showing the parameters for the selected screen control. The Screen Control
Inspector includes General and Mapping tabs as well as a tab labeled Unmapped.
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2 In the Screen Control Inspector, click the Unmapped tab.

The Parameter Mapping browser appears, showing the channel strips and plug-ins
available for mapping as well as the Actions folder.

3 In the column on the left of the Parameter Mapping browser, select the channel strip
with the parameter to which you want to map the screen control.

Parameters for the selected channel strip appear in the columns on the right. Additional
folders for the instruments and effects in the channel strip may appear in these columns.
Click a folder to see the parameters for that instrument or effect.

4 Select the parameter you want to map.

Click the parameter to 
which you want to map 
the screen control.

Click the channel strip 
or plug-in with the 
parameter you want 
to map.

The screen control is mapped to the selected parameter, and the Unmapped tab takes
the name of the parameter. You can continue mapping additional screen controls by
clicking them in the workspace and then choosing parameters in the Parameter Mapping
browser. Using the Parameter Mapping browser, you can map parameters that are not
visible in plug-in windows.

You can also map screen controls to MainStage actions and to AppleScript scripts. For
more information about mapping screen controls, see Mapping Screen Controls.

Note: If you change the channel strip setting for a channel strip to which you have mapped
screen controls, you will lose any parameter mappings.

You can also edit velocity sensitivity for a channel strip, create controller transforms, and
filter various MIDI messages. For information about editing channel strips, see Editing
Channel Strips in MainStage.
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Mapping Screen Controls to Actions
In addition to mapping screen controls to channel strip and plug-in parameters, you can
map them to MainStage actions. Actions let you select patches and sets; silence MIDI
notes; control the Tuner and the metronome; tap a new tempo; display information about
patches, MIDI messages, and other information; and perform other functions using screen
controls.

For a complete table of actions, including descriptions and usage notes, see Using
MainStage Actions.

The Actions folder, which appears in the Parameter Mapping browser along with available
parameters, contains actions for selecting patches and sets, showing the Tuner, activating
tap tempo, Master Mute, or Panic, and others. The Actions folder also contains an
AppleScript subfolder with useful scripts.

You can map button screen controls to actions for selecting different patches and use
physical buttons on your MIDI device to select patches when you perform. You can also
map buttons to actions for selecting different sets or selecting the concert. For information
about assigning buttons, see Assigning Buttons.

To map a screen control to an action
1 In the workspace, click the screen control you want to map.

The Screen Control Inspector appears below the workspace, showing the settings for the
selected screen control. If the screen control is currently mapped, a tab with the name
of the mapping is visible in addition to the General and Mapping tabs. If the control is
unmapped, the tab is labeled “Unmapped.”

2 Click the Unmapped (or name of mapping) tab.

The Parameter Mapping browser appears below the workspace. The Actions folder is
available in the Parameter Mapping browser.

3 In the column on the left of the Parameter Mapping browser, click the Actions folder.
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The available actions appear in the second column of the browser.

Click the Actions folder to 
see available actions.

Click the action you 
want to map from 
the submenu.

4 Select the action you want to map.

Note: If you map a knob screen control to an action to select a patch (such as the
−10 Patches, Previous Patch, Next Patch, or +10 Patches action), the screen control jumps
to the value of the hardware control, regardless of the setting of the Respond to Hardware
Move parameter in the Screen Control Inspector.

Mapping a Screen Control to Multiple Parameters
You can map a single screen control to multiple parameters and control how the screen
control modifies each mapped parameter. Mapping a screen control to multiple parameters
is also referred to as multimapping. You map a screen control to up to eight parameters
by adding mappings in the Screen Control Inspector.

To add a mapping
1 Map the screen control to a parameter or action, as described in Mapping Screen Controls

to Channel Strip and Plug-in Parameters and Mapping Screen Controls to Actions.

2 With the screen control selected, click the Add Mapping (+) button at the upper-right
corner of the Screen Control Inspector.

A new Unmapped tab appears in the Inspector, showing the Parameter Mapping browser.

3 In the Parameter Mapping browser, choose the parameter to which you want to map the
screen control.
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If you add a mapping while the Learn process is active (the Map Parameter button is red),
you can immediately learn the new mapping. The Command Editor also includes key
commands for selecting the previous and next tab to make mapping to multiple
parameters easier. For information about using key commands, see Using the Command
Editor.

If you frequently map screen controls to multiple parameters, you can speed your workflow
by assigning key commands to select the previous and next tab or to select a specific tab
in the Screen Control Inspector. For information about assigning key commands, see
Using the Command Editor.

To view all mappings for a screen control
µ In the Screen Control Inspector, select the Mappings tab.

The mappings appear in a list view that shows the minimum and maximum range values
and patch change behavior for each mapping and includes buttons to open the Parameter
graph and Invert graph values for each mapping.

If you create multiple mappings for a screen control, you can define the relationships
between the first mapping and subsequent mappings. This can be especially useful when,
for example, you are mapping the same control to filter cutoff and filter resonance, and
you want to ensure that resonance does not exceed a certain maximum value as you
increase the cutoff value. The default relationship affects all future mappings (for the
same and other screen controls), but does not affect existing mappings. The default is
set to Scale the first time you open MainStage.

To define the default relationship between the first mapping and subsequent mappings
1 Select a screen control you want to map to multiple parameters.

2 Choose “Default Relation to First Mapping” from the Action menu, located in the
upper-right corner of the Screen Control Inspector.

3 Do one of the following:

• To set subsequent mappings to be offset by a fixed value from the first mapping, choose
Offset.

• To set subsequent mappings to scale by a constant ratio, starting from the same
minimum value, choose Scale.

• To set subsequent mappings to scale by a constant ratio to the point defined for the
mapping, starting from both the same minimum value and maximum value, choose
Pivot.
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Editing the Saved Value for a Parameter
If you have set the default behavior for saving parameter values to “Reset to saved value”
in MainStage General preferences, or in the Attributes tab of the Screen Control Inspector,
the parameter values for a patch are returned to their last saved value when you change
patches. You can view and edit the saved value in the tab for the parameter mapping in
the Screen Control Inspector.

To view and edit the saved value for a parameter
1 In the Screen Control Inspector, click the tab for the mapping.

You can view the current saved value for the parameter in the Saved Value value slider.

2 To edit the value, do one of the following:

• Change the value in the Saved Value value slider.

• Drag the slider to the right of the value slider left or right.

Note: The value in the Screen Control Inspector is mapped automatically to the screen
control. However, making a change to the screen control is only reflected in the Screen
Control Inspector after you save the concert with that patch selected in the patch list.

Using Parameter Mapping Graphs
Each parameter mapping has a Parameter graph. You can edit the graph to remap input
values to different output values for the parameter.

To open the Parameter graph for a mapping
µ In the tab for the mapping or in the Mappings tab, double-click the Graph button for the

mapping you want to edit.

The Parameter graph window opens. The title of the graph window shows the parameter
name.

For information about editing graphs, see Working with Graphs.

Mapping Screen Controls to All Channel Strips in a Patch
When you map a screen control to a channel strip parameter such as volume or pan, you
can map it to control the same parameter in all of the channel strips in the patch. This is
particularly useful when you want to control the overall volume of a layered sound, even
if the different layers are played across multiple keyboards.

To map a screen control to all channel strips in a patch
1 Map the screen control following the instructions in the preceding sections.

2 In the column on the left of the Parameter Mapping browser, select the Send to All folder.

3 Select the destination from the second column.

4 Select the parameter to map the screen control to from the third column.
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You can map the screen control to actions for transposing software instrument channel
strips, channel strip parameters, and MIDI control message types from the Destinations
folder. When you map a screen control to all channel strips in a patch, the parameter to
which the screen control is mapped changes to the same value for all channel strips in
the patch when you move the screen control.

Note: When you map a drum map using Send to All, the Send to All folder contains MIDI
notes, not controllers.

Undoing Parameter Mapping
You can undo parameter mapping if you decide you don’t want to keep the mapping.
When you undo parameter mapping, all mappings created in the current Learn mode
(either by pressing Command-L or clicking the Map Parameter button) session are undone.

To undo parameter mappings
Do one of the following:

µ Choose Edit > Undo (or press Command-Z).

µ Press the Escape key.

Removing Screen Control Mappings
If you want a screen control to be free of any mappings, you can remove its existing
mapping. This can be useful with controls that pass through MIDI messages (for example,
for pitch bend and modulation wheels, or expression pedals) when you do not want them
to send MIDI messages for their pass-through control type. You do not need to remove
the mapping for a screen control when you remap it.

To reset the mapping for a screen control
1 In the workspace, click the screen control you want to map.

2 In the column on the left of the Parameter Mapping browser, click None.

Editing Screen Control Parameters in Edit Mode
In Layout mode, you edit basic screen control parameters that are constant throughout
the entire concert. In Edit mode, you can edit screen control parameters for a specific
patch or set. You can also override concert- and set-level mappings for an individual
patch or set.

Overriding Concert- and Set-Level Mappings
By default, mappings you make at the concert level (to parameters and actions) take
precedence over mappings to individual patches or sets in the concert. If you map a
screen control to a parameter at the concert level (for example, to Master Volume), that
screen control cannot be mapped to a parameter or action in a patch or set, unless you
override the concert-level mapping.
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Similarly, mappings you make at the set level take precedence over mappings for any
patches in the set. If you map a screen control to a parameter at the set level (for example,
to an effect on a set-level channel strip), that screen control cannot be mapped to a
parameter or action in a patch in the set, unless you override the set-level mapping.

If you try to map a screen control that is mapped at the concert or set level, text appears
in the Screen Control Inspector informing you that the screen control is mapped at another
level, and the parameters in the Screen Control Inspector are dimmed. You can override
the concert- and set-level mappings for an individual patch, and then map the screen
control at the patch level.

To override concert-level mappings
µ In the Screen Control Inspector, select the Override Concert Mapping checkbox.

Select the checkbox to 
override mappings at 
the concert level.

The parameters in the Screen Control Inspector become active.

To override set-level mappings and other parameters for a patch
µ In the Screen Control Inspector, select the Override Set Mapping checkbox.

The Parameter Mapping section becomes active so that you can map the parameter.

Mapping tabs for concert-level mappings are available only at the concert level, and
mapping tabs for set-level mappings are available only at the set level. When you override
a concert- or set-level mapping, the mapping tabs become available at the level of the
override.

Replacing the Parameter Label
You can replace the parameter label for a screen control (for an individual patch or set),
to make the label easier to identify.

To replace the parameter label for a screen control
1 Select the screen control in the workspace.
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2 In the Screen Control Inspector, select the Attributes tab.

3 Select the Replace Parameter Label checkbox.

4 Enter the new label text in the field.

Choosing a Custom Color for a Screen Control
You can change the color of the active area of a screen control (for an individual patch
or set).

To choose a custom color for a screen control
1 Select the screen control in the workspace.

2 In the Screen Control Inspector, select the Attributes tab.

3 Select the Custom Color checkbox.

4 Choose a new color from the Custom Color pop-up menu.

Changing the Appearance of a Background or Grouped Screen Control
You can change the appearance of a background screen control or grouped set of screen
controls by choosing a different panel, or adding a custom image.

To change the panel for a background or grouped screen control
1 In Edit mode, Option-click the screen control in the workspace.

Panel and Image controls appear in the Screen Control Inspector.

2 In the Screen Control Inspector, make sure that the Custom Background checkbox is
selected.

3 Select the Panel button.

4 Click the Panel well and choose a new panel from the pop-up menu.

To add a custom image for a background or grouped screen control
1 In Edit mode, Option-click the screen control in the workspace.

Panel and Image controls appear in the Screen Control Inspector.

2 In the Screen Control Inspector, make sure that the Custom Background checkbox is
selected.

3 Select the Image button, then click Select.

An Open dialog appears.

4 Browse to the image you want to use, select the image, then click Choose Image.

Choosing Custom Text Color for a Screen Control
You can change the color of the text for a screen control (for an individual patch or set).

To choose a custom text color for a screen control
1 Select the screen control in the workspace.
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2 In the Screen Control Inspector, select the Attributes tab.

3 Select the Custom Label Color checkbox.

4 Choose a new color from the Custom Label Color menu.

Setting a Screen Control to Show the Hardware Value
By default, screen controls show the value of the parameter the control is mapped to. In
some cases, for example, when the screen control is assigned to a foot pedal, or when
the screen control is mapped to multiple parameters, it may be better to show the value
of the hardware control assigned to the screen control.

To set a screen control to show the hardware value
1 Select the screen control in the workspace.

2 In the Screen Control Inspector, select the Attributes tab.

3 Select the Show Input Value checkbox.

Setting Parameter Change Behavior for Screen Controls
You can set the behavior for saving parameter values for screen controls in individual
patches. This is useful, for example, when the default for saving parameter values is set
to Reset, but you want certain screen controls (for example, concert- and set-level screen
controls) to keep their current value when switching patches.

To set the behavior for saving parameter values in a patch
1 Select the patch.

2 Select the screen control for which you want to set the parameter change behavior.

3 In the Attributes tab of the Screen Control Inspector, choose the parameter change
behavior for the screen control from the “When a patch is changed and screen value
differs from saved patch” pop-up menu:

• To have the screen control use the default behavior set in MainStage preferences,
choose Preference.

• To preserve changes to parameter values when you change patches, choose Keep.

• To return values to the last saved value, choose Reset. When this value is chosen, you
should save the concert after making any changes you wish to keep to the patch, before
selecting another patch.

• To have the screen control use the last received value from the physical control assigned
to it, choose Match.

When you choose an item from the pop-up menu, a brief description of its function
appears below the menu.

Important: If you set the behavior for saving parameter values in a patch to Reset,
parameter values are also reset when you switch to Layout mode.
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Setting Hardware Matching Behavior for Screen Controls
Some hardware synthesizers and music workstations let users control what happens
when you move a physical control that is set to a different value than the parameter it
modifies. The parameter value can instantly change to the position of the physical control
(sometimes called jump), it can change by the same amount (called relative), or it can not
change at all until the physical control matches its current value (called snap).

You can set the behavior for screen controls in MainStage to any of these behaviors when
you move the physical control assigned to the screen control.

To set the behavior for screen controls when you move a hardware control
1 Select the patch.

2 Select the screen control for which you want to set the hardware matching behavior.

3 In the Attributes tab of the Screen Control Inspector, choose the parameter change
behavior for the screen control from the “When hardware value differs from screen value”
pop-up menu:

• To have the screen control use the default behavior set in MainStage preferences,
choose Preference.

• To have the screen control instantly change to match the hardware value, choose Jump.

• To have the screen control change when the hardware control matches its current
value, choose Pickup.

• To have the screen control move relative to the hardware control, choose Relative.

Note: When you choose an item from the menu, a brief description of its function appears
below the menu.

Resetting and Comparing Changes to a Patch
You can reset changes to all parameters in a patch that are mapped to screen controls
to their last saved value, letting you hear the patch in its last saved (original) state, and
toggle between the original and modified states of the patch. There are two ways to reset
and compare changes to a patch: by using the Reset/Compare Patch button in the toolbar
or by using the Reset/Compare Patch action mapped to a screen control at the concert
level.

To reset changes to mapped patch parameters using the Reset/Compare Patch button
1 With the patch selected, click the Reset/Compare Patch button.

The patch is reset to its previously saved state.

2 To hear the patch in its modified state, click the Reset/Compare Patch button.

To reset and compare changes using the Reset/Compare action
1 In Layout mode, add a button screen control to your layout.
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2 Assign a button on your hardware controller to the new button screen control.

3 In Edit mode, click the concert icon in the Patch List.

4 Select the new button screen control in the workspace.

5 In the Parameter Mapping browser, select the Actions folder, and then select the Reset/
Compare Patch action in the second column.

For more information about mapping a screen control at the concert level, see Controlling
the Overall Volume of a Concert.

Working in the Assignments and Mappings tab
You can view and edit assignments and mappings for the selected patch, set, or concert
in the Assignments & Mappings table. The left column of the Assignments & Mappings
table lists the assignments in the patch by device and MIDI channel. The middle column
shows the screen control to which the hardware control is assigned (if one exists). The
right column shows the mapping for each control, following the same order that appears
in the Screen Control Inspector. The Assignments & Mappings table allows you to create
and edit assignments and mappings without leaving Edit mode.

You can quickly see whether a hardware control is assigned, and see the parameter or
action to which it is mapped. When you manipulate a hardware control, the row showing
its assignment and mapping is highlighted. If it is unassigned, a new row is created.

The Assignments & Mappings tab also includes an Action menu, with items for creating
assignments and for selecting a mapping row when it receives MIDI input.
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To show the Assignments and Mappings table
µ Click the Assignments & Mappings tab at the top of the workspace (or press

Command-Shift-M).

To return to the workspace
µ Click the Workspace tab at the top of the window (or press Command-Shift-W).

Creating and Deleting Assignments and Mappings
The Assignments & Mappings tab includes an Assign & Map button so you can quickly
create new assignments and mappings. You can also create assignments and mappings
independent of any screen control, allowing you to use a hardware control to adjust the
value of a parameter or action for which there is no screen control in the workspace.

To create a new assignment and mapping
1 In the Action menu, choose New Assignment.

A new, blank row appears in the table.

2 Click the Assign & Map button.

3 Manipulate the hardware control you want to assign.

The row is updated to show the new assignment.

4 To create a mapping, do one of the following:

• Select a mapping parameter or action in the Screen Control Inspector.

• Click a parameter on a channel strip or a plug-in window.

The table is updated to show the new mapping.

You can delete assignments and mappings in the Assignments & Mappings table. When
you select a row in the table with both an assignment and a mapping, only the mapping
is deleted. When you select a row containing only an assignment, an alert appears. If the
assignment has a screen control, the assignment is deleted but the screen control remains
in the table. If the assignment has no screen control, the entire row is deleted.

To delete an assignment
1 In the table, select the row with the assignment, then press the Delete key.

2 In the alert that appears, click Delete.

To delete a mapping
µ In the table, select the row with the mapping, then press the Delete key.

Editing Assignments and Mappings
Using the Assign & Map button, you can also edit existing assignments and mappings in
the Assignments & Mappings table.
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To edit an existing assignment or mapping
1 In the Assignments & Mappings table, select the assignment you want to edit.

2 Click the Assign & Map button.

3 To change the assignment, manipulate the hardware control you want to assign.

The table is updated to show the new assignment.

4 To change the mapping, do one of the following:

• Select a new mapping parameter or action in the Screen Control Inspector.

• Click a parameter on a channel strip or a plug-in window.

The table is updated to show the new mapping.

Editing Hardware Input Parameters
You can view and edit the Hardware Input parameters for an assignment in the
Assignments & Mappings table, allowing you to quickly modify the assignment without
leaving Edit mode. For detailed information about particular Hardware Input parameters,
refer to Working with Screen Controls.

To edit Hardware Input parameters for an assignment
1 Click the assignment you want to edit.

A dialog showing the current hardware input settings for the assignment appears.

2 Using the pop-up menus in the dialog, choose new Hardware Input parameters for the
assignment.

3 When you are finished, click Done, or click anywhere outside the dialog.

Working with Sets in Edit Mode
Sets are like folders that let you organize patches you want to keep together. Using sets,
you can organize patches in any manner. For example, you can put all the patches you
want to use in the first part of a performance together or keep all your lead synth patches
together. Sets are flexible, so you can use them in whatever way suits your method of
working.

Here are some different ways you can use sets:

• To group similar or related sounds into “banks”

• To keep multiple patches you’ll use in a single song together

• To share a set-level instrument or channel strip between a group of songs

Creating Sets
You can create a new, empty set or create a set from a group of selected patches.

91Chapter 5 Working in Edit Mode



To create a new, empty set
µ Choose New Set from the Action menu in the upper-right corner of the Patch List.

A new set appears in the Patch List.

To create a set from a group of patches
1 In the Patch List, select the patches you want to include in the new set.

2 Choose New Set From Selection from the Action menu at the upper-right corner of the
Patch List.

The new set appears in the Patch List containing the selected patches. You can add new
patches to the set or drag existing patches into the set.

Renaming Sets
When you create a set, it is given a default name. You can rename a set in the same way
you rename a patch in the Patch List.

To rename a set
1 Double-click the set in the Patch List.

A text field appears around the set name, which is selected.

2 Type a new name in the set name field.

Setting the Time Signature for a Set
You can set the time signature for a set. Time signatures can be used with the Playback
plug-in and also affect the beats of the metronome. When you set the time signature for
a set, it overrides the concert-level time signature (if one is set).

To set the time signature for a set
1 In the Set Inspector, select the Has Time Signature checkbox.

2 Double-click the number in the field to the right, and enter the number of beats for one
measure of the time signature.

3 Choose the beat value from the pop-up menu to the right.

Changing the Tempo When You Select a Set
You can give a set its own tempo setting so that when you select the set, the tempo
changes to the set tempo setting. MainStage uses the new tempo until you select another
patch or set with its own tempo setting, tap a new tempo, or until MainStage receives
tempo information from incoming MIDI messages. For more information about using
and changing tempo in MainStage, see Using Tempo in a MainStage Concert.

To change the tempo using a set
1 In the Patch List, select the set.

2 In the Set Inspector, set the set tempo using the “Change Tempo to” value slider.

3 Select the “Change Tempo to” checkbox to activate the set tempo when the set is selected.
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Changing the Tuning for a Set
By default, new sets (and most existing ones) use the same tuning method as the concert.
You can change the tuning for a set so that it uses a different tuning. When you change
the tuning method for a set, the patches in the set use the set-level tuning unless you
change the tuning at the patch level.

To change the tuning for a set
1 In the Set Inspector, select the Tuning tab.

2 Choose the tuning you want the set to use from the Method pop-up menu.

Overriding Concert-Level Key Ranges for a Set
If a software instrument channel strip exists at the concert level, the concert-level channel
strip takes precedence over any set-level software instrument channel strips within its
key range. This means that when you play any notes in the key range of the concert-level
channel strip on a keyboard controller, you hear only the concert-level channel strip, even
when a patch is selected in a set with a set-level channel strip.

You can override the concert-level channel strip for a channel strip at the set level so that
the set-level channel strip takes precedence over the concert-level one.

To override concert- or set-level key ranges
1 In the Patch List, select the set with the channel strip that you want to override the

concert-level channel strip.

2 In the Channel Strips area, select the channel strip with the key range that you want to
override the concert-level key range.

3 Select the “Override parent ranges” checkbox.

Deleting Sets
You can delete a set if you decide you no longer want it in the concert.

To delete a set
1 Select the set in the Patch List.

2 Choose Edit > Delete (or press the Delete key).

When you delete a set, the patches in the set are also deleted. To delete the set without
deleting the patches, move the patches outside the set before you delete it.
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Working at the Set Level
You can add channel strips at the set level and play the set-level channel strips together
with every patch in the set. This can be useful, for example, if you want to use the same
bass instrument in a single song or group of songs. You can place the patches for all of
the songs in a set, add a channel strip at the set level, and then add a bass instrument to
the set-level channel strip. You can set the key range of the bass instrument to play only
notes in the lower octaves so that you can play it together with your patches.

Important: If you add a channel strip at the set level, it takes precedence over all of the
channel strips in all of the patches in the set. For example, if you add a software instrument
channel strip at the set level, the software instrument for the set takes precedence over
all of the software instruments in all of the patches in the set that fall within the same
key range as the set-wide software instrument.

To add a set-level channel strip
1 In the Patch List, select the set.

2 Click the Add Channel Strip (+) button at the top of the Channel Strips area.

3 In the New Channel Strip dialog, select the type of channel strip you want to create.

4 Choose the audio output for the channel strip from the Output pop-up menu.

5 For audio channel strips, choose mono or stereo format from the Format pop-up menu
and choose the audio input from the Input pop-up menu.

6 Click Create.

Sharing Patches and Sets Between Concerts
You can export patches and sets from a concert and import them into another concert.
When you import a set, all the patches in the set are imported.

To export a patch
Do one of the following:

µ Drag the patch from the Patch List to the Finder.

The patch appears as a .patch file in the Finder.

µ Select the patch, choose “Save as Patch” from the Action menu in the Patch List, then
click Save.

The patch is exported to the ~/Library/Application Support/Logic/MainStage Patches
folder.

To export a set
Do one of the following:

µ Drag the set from the Patch List to the Finder.
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The set appears as a .patch file in the Finder.

µ Select the set, choose “Save as Set” from the Action menu in the Patch List, then click
Save.

The set is exported to the MainStage Patches folder.

Note: You can also export an entire concert as a set by selecting the concert and choosing
Export Set from the Action menu.

You can export multiple patches or sets. When you export multiple patches by dragging
them to the Finder, each patch is exported as a .patch file. When you select multiple
patches and export them using the Export Patch command, the patches are grouped
into a single exported set. You can import patches or sets from the Finder to another
open concert.

To import a patch or set
Do one of the following:

µ In Edit mode, drag the patch or set from the Finder to the Patch List.

µ Choose Load Patch/Set from the Action menu in the Patch List, select the patch or set
you want to import, then click Import.

Recording the Audio Output of a Concert
You can record the audio output of a MainStage concert. When you record audio output,
all audio on the output you choose is recorded (including the metronome, and so on).

Before you record audio output, make sure the correct output, recording location, and
file format are set in the Audio tab of MainStage preferences. For information about
setting recording preferences, see Setting MainStage Preferences.

To record audio in Edit mode
µ Click the Record button in the toolbar.

To turn off recording
µ Click the Record button again.

You can also map a screen control to the Record action to record audio in Perform mode,
and assign a key command to the action to turn recording on or off using a hardware
control.
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Concerts are the documents in which you create and organize the sounds you use in
your performances, customize your onscreen layout, and make connections between
your MIDI hardware and MainStage.

A concert holds all the sounds you’ll use for an entire performance or a series of
performances. In a concert, you add, edit, and organize patches, and select patches while
you are performing. You can reorder patches in the Patch List and also organize them
into sets.

Concerts also contain layouts, where you visually arrange screen controls in the workspace
and make connections between your hardware devices and MainStage. You can add and
arrange screen controls and assign physical controls on your hardware MIDI devices to
screen controls in Layout mode. For information about customizing your layout, see
Working in Layout Mode.

You can also control the volume for an entire concert, add concert-wide effects, and make
other changes at the concert level.

This chapter covers the following:

• Opening and Closing Concerts (p. 98)

• Saving Concerts (p. 99)

• How Saving Affects Parameter Values (p. 99)

• Setting the Time Signature for a Concert (p. 100)

• Using Tempo in a MainStage Concert (p. 100)

• Defining the Source for Program Change Messages for a Concert (p. 102)

• Setting the Pan Law for a Concert (p. 102)

• Changing the Tuning for a Concert (p. 103)

• Silencing MIDI Notes (p. 103)

• Muting Audio Output (p. 104)

• Working at the Concert Level (p. 104)

• Controlling the Metronome (p. 111)
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Opening and Closing Concerts
You can create a new concert from a template, open an existing concert to continue
working, and close and save concerts. You can add patches to a concert and organize
them in the Patch List. The number of patches is limited only by the amount of available
memory. You can add channel strips to an existing patch or to new ones you create and
can organize patches into sets. For information about patches and sets, see Working in
Edit Mode.

The process of creating a new concert from a concert template is described in Choosing
a Concert Template. You can open an existing concert to play the patches in the concert
or continue editing them.

To open an existing concert
Do one of the following:

µ Choose File > Open Concert, select the concert you want to open, then click Open.

µ Choose File > New to open the Choose Template dialog, click “Open an Existing Concert,”
then choose the concert from the Open dialog.

µ In the Finder, double-click the concert.

µ In the Finder, drag the concert over the MainStage icon in the Dock.

You can also reopen a recently open concert by choosing File > Open Recent Concert
and then choosing a concert from the submenu, or by opening the Choose Template
dialog, clicking Recent Concert, then choosing the concert you want to open.

By default, when you open a concert, it opens in Edit mode. You can change the default
behavior in MainStage preferences. For more information, see Setting MainStage
Preferences.

The first time you open a concert, the first patch is selected, and the Patch Library is open
so you can easily choose a patch setting. When you reopen a concert, the patch that was
selected when you last saved the concert is selected.

If any audio files or other assets are not found when you open a concert, a dialog appears
showing which assets are missing, and asking if you want to search for the assets, locate
them manually, or skip them.

Note: When you open a concert created with an earlier version of MainStage, it opens
as an untitled concert, and MainStage prompts you to save the concert as a MainStage 2
concert.

To close a concert
µ Choose File > Close Concert.

If you have edited the concert since the last time you saved it, you are prompted to save
your changes.
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Saving Concerts
When you save a concert, changes to mapped parameter values are saved only for the
selected patch or set, but not for other patches or sets.

To save a concert
1 Choose File > Save.

2 The first time you save a concert, the Save dialog appears. Enter a name for the concert,
and browse to the location where you want to save it, then click Save.

You can save a copy of a concert with a new name by choosing File > Save Concert As.

You can save a concert together with the assets (audio files, instruments, Ultrabeat
samples, and Space Designer impulse response files) the concert uses, similar to saving
a Logic song as a project.

To save a concert including its assets
1 Choose File > Save As.

2 In the Save As dialog, select the Include Assets checkbox.

3 Optionally, with the Include Assets checkbox selected, click the Advanced Options triangle,
then select the types of assets you want to include with the concert.

4 Click Save.

For information about how to set the behavior for saving parameter values for screen
controls in individual patches, see How Saving Affects Parameter Values and Editing the
Saved Value for a Parameter.

How Saving Affects Parameter Values
While a concert is open, any changes you make to mapped (channel strip or plug-in)
parameters are retained for as long as the concert is open. If you close the concert without
saving, the mapped parameter values revert to their previously saved state when you
reopen the concert. If you save the concert before closing it, changes to mapped parameter
values are saved only for the currently selected patch.

If you decide not to keep your latest changes, you can revert a concert to its previously
saved state.

To revert a concert to its last saved state
µ Choose File > Revert to Saved.

All the changes you’ve made since the last time you saved the concert are lost when you
revert the concert to its last saved state.
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If you change parameter values in a patch, select another patch, and later select the first
patch again, the parameter values will be as you left them when you selected the other
patch. You can also choose the default behavior for saving changes to values of parameters
to which screen controls are mapped. You can set the default to either have parameters
keep their current value when changing patches (the default behavior in MainStage
version 1.0), or to reset their values to the last saved value (similar to many hardware
synthesizers).

To set the default behavior for saving parameter values
1 Choose MainStage > Preferences.

2 In the Parameter Values section of the General preferences pane, choose the default
behavior from the “On patch changes” pop-up menu.

a To preserve changes to parameter values when you change patches, choose “Keep
current value.”

b To return parameters to their last-saved value when you change patches, choose “Revert
to saved value.”

You can also set the behavior for saving parameter values for screen controls in individual
patches. For information, see Setting Parameter Change Behavior for Screen Controls.

Setting the Time Signature for a Concert
You can set the time signature for a concert. Time signatures can be used with the Playback
plug-in and also affect the operation of the metronome. When you set the time signature
for a patch or set, it overrides the concert-level time signature while the patch or set is
selected. When you select a patch or set without a time signature, it uses the concert
time signature.

To set the time signature for a concert
1 In the Concert Inspector, select the Has Time Signature checkbox.

2 Double-click the number in the field to the right, and enter the number of beats for one
measure of the time signature.

3 Choose the beat value from the pop-up menu to the right.

Using Tempo in a MainStage Concert
Each concert has a tempo, which you can change in different ways while you are
performing. Some plug-ins available in MainStage, including delay and tremolo effects,
synthesizer LFOs, and the metronome, can require a specific tempo. You can set the initial
tempo for a concert, and change the tempo by selecting a patch or a set with its own
tempo setting. You can also change the tempo in real time by tapping a new tempo or
have MainStage receive tempo changes from incoming MIDI messages.
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When you open a MainStage concert, the tempo setting in the Concert Inspector is used
until you change the tempo by selecting a patch or set with its own tempo setting or by
tapping a tempo. When you change the tempo, MainStage uses the new tempo until
you change it again or until you close the concert.

You can set the tempo for a concert in the Concert Inspector, which appears in the
lower-left corner of the MainStage window when the concert icon is selected in the
Patch List. By default, the tempo for new concerts is set to 120 beats per minute (bpm).

To set the tempo for a concert
1 In the Patch List, select the concert icon.

2 In the Concert Inspector, set the tempo using the Tempo slider or value slider.

Set the tempo by 
dragging the 
Tempo slider or using 
the value slider.

You can use patches and sets to change the tempo when you select the patch or set
while performing. For information about patch tempo settings, see Changing the Tempo
When You Select a Patch. For information about set-level tempo settings, see Changing
the Tempo When You Select a Set.

Tapping the Tempo
MainStage includes a “tap tempo” feature that allows you to set the tempo in real time
while you perform. You can tap the tempo using the Tap Tempo button in the toolbar
(if it is visible) or using a key command.

To tap the tempo using the Tap Tempo button
µ Click the Tap Tempo button in the toolbar several times at the desired tempo.

For information about adding buttons to the toolbar, see Customizing the Toolbar.

You can also tap the tempo using your computer keyboard.

To tap the tempo using a computer keyboard
µ Press Control-T several times at the desired tempo.
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You can also tap the tempo using a screen control mapped to the Tap Tempo action. For
information about mapping screen controls to actions, see Mapping Screen Controls to
Actions.

Getting the Tempo from MIDI Input
You can also have MainStage receive tempo changes from incoming MIDI messages.
When the “Get tempo from MIDI input” checkbox is selected, MainStage listens to incoming
MIDI clock messages for tempo information. If it receives tempo information, the concert
tempo changes to the new tempo value.

To get the tempo from incoming MIDI clock messages
1 In the Concert Inspector, select the “Get tempo from MIDI input” checkbox.

2 Choose the MIDI clock source from the Device pop-up menu.

When the “Get tempo from MIDI input” checkbox is selected, the Tempo slider is dimmed
and cannot be edited. If MIDI messages MainStage receives do not include MIDI clock
information, MainStage uses the concert tempo setting and changes the tempo when
you select a patch or a set with its own tempo setting, or tap a new tempo. If MainStage
stops receiving MIDI clock messages, it continues to use the last received value for the
tempo until you select a patch or set with its own tempo setting or tap a new tempo.

Defining the Source for Program Change Messages for a Concert
By default, MainStage receives and responds to program change messages from all
connected MIDI controllers. Some MIDI controllers, however, send program change
messages while performing other operations. You can define the source for program
change messages for a concert, so the concert responds to messages for only one MIDI
device, port, or channel.

To define the source for program change messages
1 In the Attributes tab of the Concert Inspector, choose the device or port from which the

concert will receive program change messages from the Device pop-up menu.

2 If you want to limit messages to a single MIDI channel on the device, choose the MIDI
channel from the Channel pop-up menu.

Setting the Pan Law for a Concert
Audio signals panned to the center position may sound louder than signals panned hard
left or right. The Pan Law value determines the amount of volume reduction applied to
audio that is panned to the center position. You can choose from the following settings:

• 0 dB: With no change to the volume level, signals will seem louder when panned to
the center position, in comparison with extreme left or right pan positions.
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• −3 dB: A full scale signal (0 dBfs) will have a level of −3 dB when panned to the center
position.

• −3 dB compensated: A full scale signal (0 dBfs) will have a level of 0 dB when panned
to the center position (or +3 dB when panned to extreme left or right positions).

To set the pan law for a concert
µ In the Attributes tab of the Concert Inspector, choose the pan law value for the concert.

Changing the Tuning for a Concert
By default, concerts use equal tempered tuning. You can change the tuning for a concert
so that it uses a different tuning.

To change the tuning for a concert
1 In the Concert Inspector, select the Tuning tab.

2 Choose the tuning you want the concert to use from the Method pop-up menu.

When you change the tuning of a concert, the tuning of the patches and sets in the
concert changes if their Tuning Method is set to “Use parent tuning.” Patches and sets
with a different tuning method are not affected.

Silencing MIDI Notes
MainStage also includes a Panic function, which works like the Panic function in Logic Pro.
The Panic function immediately silences any hanging MIDI notes.

To silence all MIDI notes
Do one of the following:

µ Press Control-P.

µ Double-click the MIDI Monitor in the toolbar.

µ If the Panic button is visible in the toolbar, click it.

µ If you have mapped the Panic function to a screen control, press or move the
corresponding controller.

If the Panic button is not visible in the toolbar, you can customize the toolbar by adding
a Panic button. For information about customizing the toolbar, see Customizing the
Toolbar.
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Muting Audio Output
Sometimes when you are playing or editing sounds, you may want to quickly mute
(silence) all audio output for the concert. MainStage includes a Master Mute button that
silences the output from every patch in the concert.

To quickly mute all sound
Do one of the following:

µ Press Control-M.

µ In the toolbar, click the Master Mute button.

µ If you have mapped the Master Mute function to a screen control, press or move the
corresponding controller.

The Master Mute button changes to show that the output is muted (a red diagonal line
covers the speaker icon). All output remains muted until you click the Master Mute button
again.

To unmute all sound
Do one of the following:

µ Press Control-M again.

µ In the toolbar, click the Master Mute button again.

µ If you have mapped the Master Mute function to a screen control, press or move the
corresponding controller.

Master Mute is also a mappable parameter in the Parameter Mapping browser. You can
map Master Mute to a button or other controller in your concerts so that you can quickly
mute all output when you are playing live in Perform mode.

In addition, you can mute audio output for a single channel strip by clicking its Mute (M)
button.

Working at the Concert Level
You can control the overall volume for a concert and make other changes at the concert
level. You can use busses at the concert level to control concert-wide effects or to control
the output of multiple channel strips assigned to the bus. You can also add channel strips
at the concert level and have the concert-level channel strips available with every patch
in the concert.
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You can map screen controls to busses and to concert-level channel strips only at the
concert level, not at the patch or set level.

To make changes at the concert level
µ In Edit mode, select the concert icon in the Patch List.

Click the concert icon in 
the Patch List to work at 
the concert level.

Controlling the Overall Volume of a Concert
A MainStage concert contains Output and Master channel strips that you can use to
control the overall volume of the concert. The Master channel strip always controls the
output volume of the entire concert. If the concert has multiple Output channel strips,
each Output channel strip controls the volume level for a particular (mono or stereo)
physical output. You can use the Output and Master channel strips to control the overall
volume in the same way you control the overall volume of a Logic Pro project.
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To see all of the channel strips, you may need to resize the Channel Strips area.

At the concert level, the 
Channel Strips area 
shows the Output and 
Master channel strips, 
auxes, and other 
concert-level channel 
strips.

To control the overall volume level of a concert
µ Drag either the Output 1-2 volume fader or the Master volume fader.

You can map a screen control to a channel strip parameter or an action at the concert
level. For example, you can map the Output 1-2 Volume fader to a fader screen control
and use the hardware control assigned to that screen control to adjust the overall volume
of the concert.

To map a screen control at the concert level
1 Make sure the concert icon is selected in the Patch List.

2 Click the screen control you want to map.

The Parameter Mapping browser appears below the workspace.

3 In the Parameter Mapping browser, click the parameter to which you want to map the
screen control.
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In the example above, you would click the fader screen control, click Out 1-2 in the left
column of the Parameter Mapping browser, and then click Volume in the second column
of the browser.

Screen controls can also display visual feedback about parameter values, including volume
level. For example, you can also map the Output 1-2 Volume fader to a level meter screen
control and have the level meter display the overall volume level while you are performing
live. In this case, you would map the level meter to Level in the second column of the
browser, rather than to Volume.

When you map a screen control at the concert level, you cannot map the same screen
control at the patch or set level unless you override the concert-level mapping. For
information about overriding concert-level mappings, see Overriding Concert- and
Set-Level Mappings.

Adding Concert-Wide Effects
You can add concert-wide effects such as reverb and delay using auxiliary (aux) channels.
When you choose a bus from the Send slot on a channel strip, a corresponding aux
appears at the concert level. You can insert effects on the aux and have those effects
apply to every channel strip sending its signal to the aux.

To send a channel strip signal to an aux
1 In the Patch List, select the patch you want to use with a concert-wide effect.

The channel strips for the patch appear in the Channel Strips area.
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2 On the channel strip, click one of the Send slots and choose a bus from the menu.

Choose a bus from one 
of the Send slots.

3 Drag the Send knob next to the slot to set the amount of the signal sent to the aux.

To add a concert-wide effect to an aux
1 In the Patch List, select the concert icon.

The auxes in the concert appear in the Channel Strips area along with the concert-level
channel strips.

2 On an aux, click one of the Insert slots and choose an effect from the menu.

After you add an effect to an aux, you can edit the effect as you would any channel strip
effect, by double-clicking it to open the plug-in window, and then adjusting parameters
in the plug-in window. You can add multiple effects to an aux, and adjust the level and
pan of the aux using the channel strip controls on the aux.
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You can also add concert-wide effects to an aux at the patch level if Show Signal Flow
Channel Strips is active. For information about showing signal flow channel strips in the
Channel Strips area, see Showing Signal Flow Channel Strips.

Using Auxes to Control Channel Strip Output
You can also send the output of multiple channel strips to an aux (auxiliary channel strip)
and then use the aux to control the volume level and pan position of the channel strips.
Sending the output to an aux is also useful for adding EQ or compression to a group of
patches.

To send the output of a channel strip to an aux
1 In the Patch List, select the patch you want to control using an aux.

2 In the channel strip, click the Output slot and choose a bus from the menu.

When you send channel strip output to an aux, the volume fader of the channel strip
controls how much of the signal is sent to the aux.

To control the output of channel strips using an aux
1 In the Patch List, click the concert.

The concert is selected. The busses added to the concert appear in the Channel Strips
area along with the concert-level channel strips.

2 Drag the Volume fader on the aux to adjust the volume level of the overall aux output.

3 Drag the Pan knob on the aux to adjust the pan position of the overall aux output.

When you control the output of multiple channel strips using an aux, their relative volume
levels and pan positions are preserved, but the overall volume level and pan position are
modified by the aux Volume fader and Pan knob.

Adding Channel Strips at the Concert Level
You can add a channel strip at the concert level and use the concert-level channel strip
for a software instrument or audio input you want to use in every patch in the concert.

Important: When you add a channel strip at the concert level, it takes precedence over
the channel strips in the patches and sets in the concert. For example, if you add a
concert-level channel strip containing a software instrument, the software instrument
takes precedence over all of the software instruments in all of the patches and sets in the
concert, for the notes in its key range. This means that you will hear only the sound of
the concert-level software instrument and will not be able to play any software instruments
in a patch or set that fall in the same key range.

To add a concert-level channel strip
1 In the Patch List, select the concert.

2 Click the Add Channel Strip (+) button at the top of the Channel Strips area.

3 In the New Channel Strip dialog, select the type of channel strip you want to create.
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4 Choose the audio output for the channel strip from the Output pop-up menu.

5 For audio channel strips, choose mono or stereo format from the Format pop-up menu.

Important: Audio channel strips can produce feedback, particularly if you are using a
microphone for audio input. When you add an audio channel strip, the volume of the
channel strip is set to silence, and Feedback Protection is turned on to alert you when
feedback occurs on the channel strip. When you add an external instrument channel
strip, the volume of the channel strip is set to silence, but Feedback Protection is turned
off.

6 Click Create.

7 For software instrument channel strips, you can define the key range for the channel strip
in the Channel Strip Inspector so that the concert-level channel strip does not overlap
software instruments you plan to use in your patches and sets.

For information about defining the key range of a channel strip, see Creating Keyboard
Layers and Splits.

When you add a channel strip at the concert level, you can map screen controls to the
channel strip only at the concert level, not for individual patches or sets.

Using the MainStage Clock
Some plug-ins, including the Playback and Ultrabeat plug-ins, require a time source, and
use beat and tempo information in order to play in time.

Additionally, some third-party applications and plug-ins using their own sequencer or
playback engine may behave differently than the included sequencer-based plug-ins.
These plug-ins (which include Reason and other ReWire applications and Reaktor) require
a play message from the host application to begin playback and require a stop message
to end playback. They may also require a continue (also sometimes called “resume”)
message to continue playback from their current time position.

MainStage includes an internal beat clock or “time base” that you can use to control the
playback of these plug-ins. The MainStage clock generates beat, time position, and tempo
information so sequencer-oriented plug-ins can start, stop, and play in time. The MainStage
clock operates similarly to the song position in Logic Pro.

You can send play and stop messages in the following ways:

• Using the Play/Stop button in the toolbar, if it is visible

• Using the Metronome button in the toolbar, if it is visible (turning on the metronome
also starts the MainStage clock, if it is not already running)

• Using a screen control mapped to the Play/Stop, Play, or Stop action

• Using a screen control mapped to the Continue action to resume playback of a
third-party plug-in (but not a Playback plug-in)
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Different plug-ins can make use of the MainStage clock in different ways, depending on
what information they require and what mode they are set to. Some plug-ins may only
make use of the beat information, while others may only make use of tempo information.
For example:

• The Playback plug-in can start immediately (if Snap To is set to Off ), at the beginning
of the next bar (if Snap To is set to Bar), or at the next beat (if Snap To is set to Beat).
It can also start when you start the MainStage clock (if “Start with Play Action” is selected
in the Action menu).

• UltraBeat starts when you start the MainStage clock if its sequencer is turned on, except
in Pattern mode.

• Reason and other ReWire applications start when you start the MainStage clock, and
stop when you stop the MainStage clock.

• For plug-ins with synchronizable LFOs, the LFO can oscillate at the tempo set by the
MainStage clock.

You can view the beat information of the MainStage clock using a Parameter Text screen
control mapped to the Beat Count action. When the MainStage clock is running, the
current bar and beat are displayed in the screen control.

Important: When you start the MainStage clock, the audio engine is reset, causing a brief
interruption in the audio output from MainStage. In some cases, you may want to start
the MainStage clock at the beginning of a song or performance and use screen controls
mapped to individual plug-in parameters to start and stop those plug-ins to avoid an
interruption in the audio output while you are performing.

Controlling the Metronome
MainStage features a metronome that you can use to play in time with the concert tempo.
The metronome always plays at the current tempo of the concert.

You can start the metronome in one of several ways.

To start the metronome
Do one of the following:

µ Click the Metronome button in the toolbar, if it is visible.
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µ Click a button mapped to the Metronome action.

µ If you are using a Playback plug-in, click the Metronome button in the Playback window
(or click a button mapped to the Metronome button).

µ Click any of the listed buttons again to stop the metronome.

Note: Starting the metronome also starts the MainStage clock if it is not already running.

By default, the metronome sound is routed to the main outputs (Output 1-2). You can
route the metronome to another output pair, which can be useful in performance when
you want to hear the metronome sound through a separate audio output (for example,
a headphone mix) and not through the main outputs.

To change the audio output for the metronome sound
1 Choose MainStage > Preferences.

2 In the Metronome section of the General tab, choose a different audio output from the
Output pop-up menu.

You can also change the volume of the metronome relative to the overall audio output.

To change the relative output of the metronome sound
1 Choose MainStage > Preferences.

2 In the Metronome section of the General tab, drag the volume slider left or right to adjust
the relative volume of the metronome sound.
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You visually arrange your onscreen layout and make connections between your music
hardware and MainStage in Layout mode.

You can’t change the position of physical faders, knobs, and other controls on your
instruments and other music hardware, but you can arrange the screen controls in your
MainStage concert in any order you like by editing the layout. You can modify an existing
layout or create one from a template, and you can export a layout and import it into
another concert.

Each concert template included with MainStage includes a built-in layout, optimized for
a type of musical instrument you use with MainStage.

You modify the layout of a concert in Layout mode. You can add and arrange screen
controls in the MainStage workspace to match your music hardware, optimize your display
size, and make assignments between controls on your MIDI hardware and the screen
controls in your concert. Below the workspace, the Screen Controls palette contains
different types of screen controls you can add to your layout. The Screen Control Inspector
appears to the left of the workspace, where you can learn controller assignments and
edit layout parameters.

This chapter covers the following:

• Modifying the Layout of a Concert (p. 114)

• Working with Screen Controls (p. 114)

• Assigning Hardware Controls to Screen Controls (p. 124)

• Editing Screen Control Parameters (p. 126)

• How MainStage Passes Through MIDI Messages (p. 132)

• Exporting a Layout (p. 132)

• Importing a Layout (p. 133)

• Changing the Aspect Ratio of a Layout (p. 133)
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Modifying the Layout of a Concert
You can modify an existing layout by adding and arranging screen controls in the
workspace, changing existing controller assignments or making new ones, and editing
screen control parameters. The following sections describe how to add and arrange
controls onscreen, make hardware assignments, change the appearance of screen controls,
and edit layout parameters. You can also export a layout and import the layout into a
different concert. For information about importing and exporting layouts, see Exporting
a Layout.

To work with the layout of a concert, you switch to Layout mode.

To switch to Layout mode
µ Click the Layout button at the upper-left corner of the MainStage window.

Working with Screen Controls
Screen controls are objects in a MainStage concert that correspond to the physical controls
on your music hardware. Screen controls can also display patch numbers, parameters
values, and other information and update the displayed information in real time.

You can add screen controls to the workspace of your concert, where you can move and
resize them, group them together, and edit their appearance in different ways.

After you have arranged the screen controls for your concert, you make connections
between your MIDI hardware and the concert by assigning physical controls on your
hardware to the screen controls in the workspace. You only need to make hardware
assignments for a concert once, as long as you are using the same music hardware.

After you make controller assignments, you can map screen controls to channel strip
parameters in your patches or to actions. You map parameters in Edit mode. For
information about mapping parameters, see Mapping Screen Controls.

Screen Control Types
There are three types of screen controls you can use in a MainStage layout: panel controls,
shelf controls, and grouped controls. In the Screen Controls palette, located below the
workspace in Layout mode, each type has its own tab; in addition, there is a tab for all
controls. You can add screen controls to the workspace by dragging them from the palette
to the workspace.
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Additionally, if you create and add a grouped control to the Screen Controls palette, a
tab for My Grouped Controls appears in the palette. You can add your custom grouped
controls to the palette, so they will be available in every concert.

Panel Controls
Panel controls appear on a two-dimensional plane (or panel) in the workspace. You can
move a panel control to any position in the workspace, except onto the shelf of a shelf
control. Panel controls include:

• MIDI Activity light (displays MIDI note activity, and can be used as a substitute
“keyboard”)

• Round and directional knobs

• Vertical and horizontal faders

• Button

• Drum pad

• Vertical and horizontal level meters (used to visually display volume level or another
parameter)

• VU meter (used to visually display volume level or another parameter)

• Parameter text (used to dynamically display parameter names and values)

• Organ drawbar

• Progress indicator (used with the Playback plug-in)

• Waveform (used with the Playback plug-in)

• Selector (used to select patches while you are performing, or to select markers for use
with the Playback plug-in)

• Text (used to display song lyrics, performance notes, and other static information)

• Background (used to group a series of controls)
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Shelf Controls
When you add a shelf control, it appears on a three-dimensional shelf. You can move the
shelf, adjust the angle of the shelf, and place multiple shelf controls on the same shelf.
For example, if you have a keyboard screen control in your layout, you can add pitch
bend wheel and modulation wheel screen controls to the same shelf as the keyboard
screen control. Shelf controls include:

• Keyboard

• Modulation or pitch bend wheel

• Sustain pedal

• Foot pedal

• Foot switch

Grouped Controls
Grouped controls consist of individual controls that are grouped together to make them
easier to work with as a single unit. Grouped controls include:

• Selector grouped with increment and decrement buttons

• Keyboard grouped with mod wheel, pitch bend wheel, and sustain pedal

• Sustain and expression pedals

• Organ drawbars

• Guitar amp controls

• Guitar pedal controls

• Arrays of knobs and faders with uniform size and spacing

• Effects and tone control knobs

• Arrays of level meters and VU meters

• Arrays of parameter text displays

• Master output fader grouped with stereo level meter

• Arrays of drum pads

• Transport controls for use with Playback plug-in

• Channel strip controls

My Grouped Controls
The first time you add a custom grouped control to the Screen Controls palette, the
My Grouped Controls tab appears in the palette. You can add custom grouped controls
and name them so they will be accessible from every concert. For information about
adding custom grouped controls to the Screen Controls palette, see Grouping
Screen Controls.
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Adding Screen Controls to a Layout
In Layout mode you can quickly add screen controls to your layout and arrange them in
the workspace.

To add a screen control
µ Drag the screen control from the Screen Controls palette to the workspace.

As you drag the screen control to the workspace, a white outline appears, showing where
it will be added. You can use the alignment guides to align the screen control with other
items in the workspace.

You can drag screen controls into the workspace in any order. If you plan to perform with
a keyboard controller, you might want to first drag a keyboard screen control into the
workspace, position it near the center, and then drag screen controls for the faders, knobs,
wheels, buttons, and other physical controls on the keyboard controller.

When you drag a screen control into the workspace, the control is selected, and the
available hardware assignments and other parameters for the screen control appear in
the Screen Control Inspector to the left of the workspace. Different types of screen controls
have different parameters, which are described in Editing Screen Control Parameters.

Adding Mod/Pitch Wheel Screen Controls
When you add mod/pitch wheels to a layout, by default they are configured to receive
the following MIDI message types:

• The first mod/pitch wheel is configured to receive modulation messages.

• The second mod/pitch wheel is configured to receive pitch bend messages.

• The third mod/pitch wheel is configured to receive aftertouch messages.

By default, modulation and pitch bend screen controls pass through the MIDI messages
for their common use—that is, mod wheels pass through MIDI modulation messages,
and pitch bend wheels pass through MIDI pitch bend messages. In most cases this is
desirable so that you can use them for their standard functions without any additional
setup. If you want to use these screen controls to control other parameters, choose “Do
not pass thru” from the MIDI Thru pop-up menu in the Screen Control Inspector.

Adding Foot Pedal Screen Controls
When you add a foot pedal to a layout, by default the first foot pedal you add is configured
to receive expression messages, and the second foot pedal you add is configured to
receive volume messages.

By default, expression pedal screen controls pass through the MIDI messages for their
common functions (expression or volume). If you want to use an expression pedal screen
control to control another parameter, choose “Don’t pass thru” from the MIDI thru pop-up
menu in the Screen Control Inspector.
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Copying and Pasting Screen Controls
You can copy and paste screen controls using the standard Mac OS X menu items and
key commands.

To paste a copy of a screen control
Do one of the following:

µ Press Command-C to copy the selected screen control, then press Command-V to paste
a copy.

µ Option-drag the screen control to a new location in the workspace.

To add multiple instances of the same screen control in a row or column
1 Option-drag the screen control to create the first copy.

2 Choose Edit > Duplicate to create as many additional copies of the screen control as you
want.

The duplicated screen controls appear offset by the same amount as the first copy.

Option-drag the selected 
screen control.

Duplicate additional 
copies in a row.

Note: You can’t copy a panel control and a shelf control at the same time.

Moving Screen Controls
You can move screen controls to a new position whenever you are in Layout mode. You
can use the alignment guides to help align and position screen controls in an orderly
arrangement. You can move multiple controls together by selecting them (either by
Shift-clicking or “rubber-banding” them) and then dragging them to a new position. If
the panels for the screen controls are merged, rubber-banding selects the entire panel.

To move a screen control
Do one of the following:

µ Drag the screen control to a new position in the workspace.

µ Select the screen control, then press the arrow keys to move it in the workspace.
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To move multiple screen controls
Do one of the following:

µ Shift-click the screen controls, then drag them to a new position.

µ Hold down the Shift key as you drag around the controls, then drag them to a new
position.

You can constrain the movement of screen controls to either horizontal or vertical by
pressing Shift while dragging them.

If a screen control overlaps another screen control in the workspace when you switch
from Layout mode to another mode, an alert appears, asking if you want the overlapped
controls to be highlighted so you can adjust them before leaving Layout mode.

Resizing Screen Controls
You can resize screen controls to make them more easily visible or to fit them into a
smaller area. When you select a screen control, blue resize guides appear over it that you
can drag to resize the control.

To resize a screen control
1 Select the screen control in the workspace.

Blue resize guides appear over the screen control.

2 Drag the resize guides to resize the screen control.

Drag the outer resize 
guides to resize the 
screen control.

For screen controls with a text display area, such as a knob or fader, you can resize the
text display area independently from the control or resize them together.

To resize the text display area of a screen control
1 Select the screen control in the workspace.

2 Drag the inner resize guide to increase the area of the text display.
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3 Drag the outer resize guide to increase the overall size of the control.

Drag the inner resize 
guide to resize the 
text area.

Notice that when you resize the text display area, the rest of the screen control becomes
smaller. You can first resize the overall control, and then resize the text display area using
the inner resize guide.

Aligning and Distributing Screen Controls
MainStage includes controls for centering, aligning, and distributing screen controls in
the workspace.

To align screen controls
1 Select the screen controls in the workspace.

2 Do one of the following:

• To align the top edges of the screen controls, click the Align Top button.

• To vertically align the centers of the screen controls, click the Align Vertical Centers
button.

• To align the bottom edges of the screen controls, click the Align Bottom button.

• To align the left edges of the screen controls, click the Align Left button.

• To horizontally align the centers of the screen controls, click the Align Horizontal Centers
button.

• To align the right edges of the screen controls, click the Align Right button.

To distribute screen controls evenly
1 Select the screen controls in the workspace.

2 Do one of the following:

• To vertically distribute the screen controls, click the Distribute Vertically button.

• To horizontally distribute the screen controls, click the Distribute Horizontally button.
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You can also align and distribute screen controls by Control-clicking the selected screen
controls and choosing commands from the Align and Distribute submenus in the shortcut
menu. The Distribute shortcut menu contains additional controls for distributing the
space between screen controls.

Adjusting the Shelf for a Shelf Control
When you add a shelf control such as a keyboard to the workspace, it appears at a default
angle, creating a three-dimensional appearance. You can adjust the angle of the shelf
control so that it appears more or less three-dimensional. This can be useful, for example,
if you want to see more of the keys on the keyboard or minimize the amount of space it
occupies onscreen.

To adjust the angle of the shelf for a shelf control
1 In the workspace, select the shelf control.

White alignment guides for the control’s shelf appear.

Alignment guides

2 Drag the lower alignment guide (the one aligned with the front of the shelf control).

Drag the lower alignment guide down to make the angle steeper (as though you are
looking down on the shelf control from above), or drag it up to make the angle less steep
(as though you are looking at it from the front).

Drag the front (lower) 
alignment guide to change 

the angle of the shelf.
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Moving the Shelf Vertically
You can also move the shelf vertically to change its position in the workspace. When you
move the shelf vertically, all screen controls on the shelf (for example, a modulation or
pitch bend wheel and a keyboard) move with the shelf.

To move a shelf vertically
1 Select one of the screen controls on the shelf.

The alignment guides for the shelf appear.

Drag the rear (upper) 
guide to move the 

shelf vertically.

2 Place the pointer over the upper alignment guide (the one aligned with the rear of the
shelf control).

The pointer becomes a move pointer (a horizontal bar with up and down arrows).

3 Drag the upper alignment guide to move the shelf to a new position.

Grouping Screen Controls
You can group screen controls together, creating a grouped control. You can move and
resize the grouped control as a single unit. Grouping screen controls has no effect on
how they work in performance, but makes it easier to quickly create a layout. You can
group screen controls using the Group button, using the shortcut menu, or using a
background screen control.

To group screen controls using the Group button
1 Select the screen controls you want to group together.

The Group button is highlighted, indicating that the selected controls can be grouped.

2 Click the Group button, located below the align and distribute buttons on the left edge
of the workspace (or press Command-Shift-G).

The screen controls are grouped into a single, grouped control. If there is no background
around the screen controls, one is added to encompass them. Selecting any member of
the group selects the entire group so you can move and resize them together.

When you group screen controls, the edges of the background appear “dotted” to indicate
that the controls are grouped. When grouped controls are selected, the Ungroup button
is highlighted, indicating that the controls are grouped.
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To group screen controls using the shortcut menu
1 Select the screen controls you want to group together.

2 Control-click the selected controls, then choose Group from the shortcut menu.

To group screen controls using a background screen control
1 Drag a background screen control to the workspace.

2 Size and position the background screen control.

3 Drag the screen controls you want to include in the grouped control so they are within
the borders of the background screen control.

If you want to move one of the grouped controls separately, you can ungroup the controls.

To ungroup screen controls
1 Select the grouped control.

2 Click the Group button again (or press Command-Shift-Option-G).

You can quickly add one or more screen controls to a group.

To add a screen control to a group
µ Drag the screen control into the group.

You can also move and resize individual controls in a group without ungrouping them.

To move or resize a screen control in a group
1 Select the individual screen control you want to move or resize.

The handles of the screen control appear so you can move or resize it independently
from the group.

2 Hold down the Command key as you move or resize the screen control.

You can add a panel or an image to the background of a grouped control to re-create
the look of a hardware panel and visually distinguish the grouped control in the workspace.

To add a panel to a background
1 Select the background.

The Screen Control Inspector appears to the left of the workspace.

2 In the Appearance section of the Screen Control Inspector, click the Panel well, and choose
a panel from the menu.

If an image has been previously selected for the background, select the Panel button
before choosing a texture for the background.

To add an image to a background
1 Select the background.

The Screen Control Inspector appears to the left of the workspace.
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2 In the Appearance section of the Screen Control Inspector, select the Image button.

3 Do one of the following:

• Drag an image to the Image well.

• Click the Select button, then navigate to the location containing the image you want
to use, and select the image.

You can add custom grouped controls to the Screen Controls palette, and use them in
the same concert or another concert. Grouped screen controls you add to the palette
appear in the My Grouped Controls tab.

To add a grouped control to the Screen Controls palette
Do one of the following:

µ Control-click the grouped control, then choose Add to Palette from the shortcut menu.

µ Select the grouped control, then choose Add to Palette from the Action menu at the
upper-right corner of the workspace.

After you add the first grouped control to the Screen Controls palette, the
My Grouped Controls tab appears. Select this tab (or the All tab) to see the custom grouped
controls you have added to the Screen Controls palette.

Deleting Screen Controls
If you decide you no longer want a screen control in your layout, you can delete it from
the workspace.

To delete a screen control
1 Select the screen control you want to delete.

2 Choose Edit > Delete (or press the Delete key).

When you delete a screen control, any assignments or mappings for the screen control
are deleted as well.

Assigning Hardware Controls to Screen Controls
To use MainStage with a MIDI controller, you assign hardware controls on the controller
(such as faders, knobs, buttons, drum pads, and pedals) to screen controls in the
workspace. After you assign a hardware control to a screen control, the screen control
receives the MIDI messages from the hardware control. You only need to make controller
assignments once for a concert as long as you use it with the same hardware.
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You assign hardware controls to screen controls using the Learn process, which is similar
to the process for learning controller assignments for a control surface in Logic Pro. The
Learn process is described in Learning a Controller Assignment. You can also assign
hardware controls in the Assignments & Mappings table. For information, refer to Working
in the Assignments and Mappings tab.

When you assign a hardware control using the Assign button, MainStage determines the
type of MIDI message the control sends when you move it, and the range of values the
control is capable of sending. When you map the screen control to a channel strip
parameter or an action, MainStage converts (or “maps”) the range of values sent by the
hardware control to the optimal range of values usable by the parameter.

For example, many faders, knobs, and other MIDI controls send a range of numeric values
between 0 and 127. You could map a hardware knob with this range of values to control
the frequency parameter of an EQ effect, which has a range of usable values between
20 Hz and 20 kHz. When you map the screen control for the knob to the EQ frequency
parameter, MainStage converts the values sent by the hardware knob to be distributed
between the minimum (20 Hz) and maximum (20 kHz) values for the parameter.

Assigning Knobs
MIDI controllers can have different types of knobs or rotary controllers. Knobs can be
either absolute controllers, which send a fixed value determined by the knob’s position
or can be relative controllers, which increment or decrement the previous value regardless
of their exact position. Knobs can either have a fixed range of movement, or be continuous
(sometimes called endless rotary encoders).

When you assign a knob screen control using the Assign button, MainStage attempts to
determine which type of knob or rotary control on your hardware is sending the MIDI
message and sets the value in the Type pop-up menu in the Screen Control Inspector to
the correct value. For absolute controllers, the correct value is Absolute; for relative
controllers, the correct value can be either Relative (2’s complement) or Relative (Sign
magnitude), depending on the type of relative controller. In most cases, there is no need
to change the default values unless you intend to use the knob for a specific, non-standard
purpose.

When you assign a knob screen control, be sure Absolute is chosen from the Type pop-up
menu if the hardware controller is an absolute rotary controller, or one of the Relative
values is chosen if the hardware controller is a continuous rotary encoder. Moving the
knob through its full range of motion helps ensure that MainStage correctly determines
the type of knob you are assigning.
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Assigning Buttons
MIDI controllers can have different types of buttons. Some buttons send a single value
each time you press them, while others alternate between two values when pressed.
Other buttons can send separate values when they are pressed and released (this type
of button is called a momentary or temporary button).

When you assign a button screen control using the Assign button, MainStage attempts
to determine which type of button on your hardware is sending the MIDI message, and
sets the value in the Type pop-up menu in the Screen Control Inspector to the correct
value for that button type. To enable MainStage to determine the correct value, press
the button exactly three times when you are learning it. Pressing the button three times
helps ensure that MainStage determines if the button is a single value, an alternating
value (binary), or a momentary button. In most cases, there is no need to change the
default values unless you intend to use the button for a specific, non-standard purpose.

You can change the function of a momentary button to match the function of a single
value or alternating value button in MainStage.

To change the function of a momentary button
1 In Layout mode, be sure the button screen control is selected.

2 In the Screen Control Inspector, choose either Single Value or Alternating Value from the
Type pop-up menu.

Choose Single Value if you want the button to function as a single value button, or choose
Alternating Value if you want the button to function as an alternating value button. You
cannot change the function of a single value or alternating value button to match the
function of a momentary button.

Editing Screen Control Parameters
When you select a screen control in Layout mode, the parameters for the screen control
appear in the Screen Control Inspector where you can edit them. Most screen controls
share the same common parameters, but some types have different parameters according
to their function. The parameters for each type are described in the following section.

For most Hardware Input parameters, there is no need to change the default values
MainStage sets when you learn a controller assignment unless you intend to use the
screen control for a specific, non-standard purpose.

To edit screen control parameters
1 In Layout mode, select the screen control. (When you drag a screen control to the

workspace, it is selected.)
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2 In the Screen Control Inspector, edit the parameters for the selected screen control by
choosing the menu item, typing text, clicking the button, or selecting the checkbox for
the parameters you want to edit.

Lifting and Stamping Screen Control Parameters
You can “lift,” or copy, certain parameters from a screen control and “stamp” them onto
other screen controls. This makes it easy to give multiple screen controls the same size,
appearance, and text attributes to create a uniform look in your layout. Parameters affected
by lift and stamp include the parameters in the Appearance and Text Labels headings in
the Screen Control Inspector (except the control type), as well as the size of the screen
control.

To lift parameters from a screen control
µ Control-click the screen control in the workspace, then choose Lift Attributes from the

shortcut menu.

To stamp parameters onto another screen control
µ Control-click the screen control in the workspace, then choose Stamp Attributes from

the shortcut menu.

You can Shift-click to select multiple screen controls, then Control-click the selection.

Common Screen Control Parameters
You can edit the following common parameters for button, knob, fader, knob, pedal,
footswitch, mod/pitch wheel, meter, VU meter, organ drawbar, progress indicator, and
parameter text screen controls.

Hardware Input
• Device pop-up menu: Shows the name of the device containing the assigned control.

The device name may correspond to the name of a keyboard controller, or to a port
on the controller, if it has multiple ports. You can choose another device, All, or
Unassigned.

• Channel pop-up menu: Choose the MIDI channel on which MainStage receives input
from the controller.

If you plan to use more than one keyboard when you perform, be sure that screen
controls such as faders and knobs are assigned to receive input from the correct
controller using the Device and Channel pop-up menus.
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• Type pop-up menu: Choose the type of control messages to which the control responds.
Control types include the following three categories:

• Continuous Control:  Includes knobs, rotary encoders, faders, and most pedals that
send values in the range of 0-127. In most cases, these controls are set to Absolute.
Some rotary encoders can be set to Relative after you program the hardware device
to send relative controller messages. The different types of Relative control messages
represent different encoding types used by different vendors (who may refer to them
by proprietary names).

• Button Control—Toggle Only:  Includes buttons that send either one (Single) or two
(Alternating) values.

• Button Control—Toggle or Momentary:  Includes drum pads and other buttons that
send a value when the button is released as well as when it is pressed.

• Number pop-up menu: Choose the MIDI control number that the control sends. For
common MIDI controls, such as volume, the control name appears in the menu along
with the number.

• MIDI Thru pop-up menu: Choose whether the control automatically passes MIDI through
or does not pass MIDI through.

• Send Value to pop-up menu: Sends the current value of the screen control to supported
devices to display using an LED ring around a rotary encoder or to move a motorized
fader.

Appearance
• Color selector: Choose the color for the active part of the screen control, which visually

displays its current value in performance. (This parameter is not available for text or
meter screen controls.)

• Control pop-up menu: Choose the type for the screen control. If you change the control
to a different type, you may need to resize it in the workspace.

Text Labels
• Color selector: Choose the color for the text labels.

• Display pop-up menu: Choose what information is displayed in the text display area for
the control and how many lines are used to display it.

• Add hardware label checkbox and field: Select the checkbox, then type a hardware label
in the field to display it on the top line of the control’s text display.

Keyboard Screen Control Parameters
If you are using a keyboard controller or another MIDI device that sends MIDI note
messages, your layout should include a keyboard (or MIDI activity) screen control. You
can edit the following parameters for keyboard screen controls.
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Hardware Assignment
• Device pop-up menu: Shows the name of the learned keyboard. The device name may

correspond to the name of the keyboard controller, or to a port on the controller, if it
has multiple ports. You can choose another device or choose All.

• Channel pop-up menu: Shows the MIDI channel on which MainStage receives input
from the keyboard. You can choose another channel or choose All.

• Velocity Sensitivity slider: Sets the velocity sensitivity for the keyboard. Less means that
higher velocities are required to trigger the maximum value, while More means that
lower velocities trigger the maximum value.

Settings
• Name field: Enter a name for the keyboard. The name appears in the Input pop-up

menu in the Channel Strip Inspector, where you can select the device the channel strip
responds to.

• Number of Keys value slider: Enter the number of keys to display on the keyboard screen
control.

• Lowest Key value slider: Enter the note name for the lowest key.

• Lowest Key Learn button: Click the Learn button, then press the lowest key to have
MainStage learn it.

The Number of Keys and Low Key affect only the visual appearance of the screen control.
They do not affect what notes are received from your keyboard controller.

Layer Display
• Display keyboard layers checkbox: When active, a layer is displayed above the keyboard

in the workspace for each software instrument channel strip in a patch. The layers show
the name and color of the channel strip and respond when you play the keyboard.

• Height value slider: Sets the height of the layer display that appears above the keyboard.

MIDI Activity Screen Control Parameters
MIDI activity screen controls can indicate when MIDI note messages are received and can
also be used as smaller, “noteless” keyboard screen controls. You can edit the following
parameters for MIDI activity screen controls.

Hardware Input
• Device pop-up menu: Shows the name of the device to show MIDI activity for. You can

choose another device, All, or Unassigned.

• Channel pop-up menu: Choose the MIDI channel on which MainStage receives input
from the controller.

• Velocity Sensitivity slider: Set the amount of sensitivity for incoming MIDI data.
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Settings
• Name field: Type a name for the screen control.

Appearance
• Color selector: Choose the color for the MIDI activity light.

Drum Pad Screen Control Parameters
You can use drum pad screen controls with hardware drum pads. You can edit the
following parameters for drum pad screen controls.

Hardware Input
• Device pop-up menu: Shows the name of the hardware device with the drum pad

control. You can choose another device, All, or Unassigned.

Note: If the Device parameter for a drum pad screen control is set to All, the MIDI note
that triggers the drum pad (set in the Note value slider) is not sent to any keyboard
screen controls in the patch, and so does not produce sound from any software
instrument plug-ins “played” using those keyboard screen controls.

• Channel pop-up menu: Choose the MIDI channel on which MainStage receives input
from the controller.

• Note value slider: Change the MIDI note for the drum pad to a different value than the
learned value.

Appearance
• Color selector: Choose the color for the active part of the screen control, so that you

can easily see when the drum pad is pressed.

Text Labels
• Color selector: Choose the color for the active part of the text label.

• Justification buttons: Click to set the text justification (left, center, or right).

• Display pop-up menu: Choose what information is displayed in the text display area
and how many lines are used to display text.

• Add hardware label checkbox and field: Select the checkbox, then enter hardware label
text in the field to display it on the top line of the control’s text display.

Waveform Screen Control Parameters
You can use waveform screen controls to display the audio waveform of the audio file
for a Playback plug-in. You can edit the Color and Hide Ruler parameters for waveform
screen controls.

• Color selector: Choose the color for the waveform display.

• Hide Ruler checkbox: When selected, the ruler at the top of the waveform display is not
visible.
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Selector Parameters
You can use selector screen controls to display and select patches and sets, or to display
and select markers in audio files used by a Playback plug-in. You can edit the following
parameters for selector (patch or marker selector) screen controls.

• View Patches and Sets button: When active, both patches and sets are shown in the
selector.

• Dual Column Display checkbox: When selected, sets are displayed in the left column
and patches are displayed in the right column.

• Patches or markers button: When active, only patches are shown in the selector.

• Items to Display value slider: Set the number of items (lines) visible in the selector.

• Color selector: Choose the color for selected items in the selector.

• Set Justification buttons: Click to set whether sets are left, center, or right justified in
the selector.

• Patch Justification buttons: Click to set whether patches are left, center, or right justified
in the selector.

Text Screen Control Parameters
You can edit the following parameters for text screen controls after adding text to the
text field.

• Font button: Select text, then click to show the Font menu from which you can select
the font, style, color, and size.

• Alignment buttons: Select whether the selected text is left, right, or center aligned, or
justified.

• Text field: Enter the text you want to display onscreen.

• Show frame around text checkbox: When selected, a darker frame appears around the
text, showing the borders of the screen control.

Background Screen Control Parameters
You can use backgrounds for grouped controls. You can edit the following parameters
for background screen controls.

• Name field: Enter a name for the grouped control in the Name field.

• Description field: Enter a description for the grouped control in the Description field.

• Panel button and well: Click the Panel button, then choose a panel or texture for the
background from the menu that appears.

• Image button and well: Click the Image button, then drag an image into the well to use
it for the background.

• Select button: Click to open an Open File dialog to browse and select an image.
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• Stretch to Fit checkbox: When selected, the image stretches to fill the area of the
background as completely as possible.

How MainStage Passes Through MIDI Messages
Some MIDI messages sent by your keyboard controller (or other MIDI device) are “passed
through” to any channel strips in the MainStage concert that are mapped to the same
controller (or device). Whether or not MIDI messages are passed through depends on
the following conditions:

• If there is no screen control in your layout assigned to receive the message type sent
by the controller, the messages are passed through.

• If a screen control for that MIDI message type exists, and the MIDI Thru parameter for
the screen control is set to Automatic or to the input device, the messages are passed
through. This is the default for screen controls set to receive volume, pan, expression,
sustain, modulation, pitch bend, and aftertouch messages.

• If a screen control for that MIDI message type exists, and the MIDI Thru parameter for
the screen control is set to “Do not pass through,” the data is not passed through. This
is the default for most other screen controls.

The reason for these exceptions is so that when you add a screen control for a modulation
wheel or a sustain pedal, for example, it “automatically” responds to the appropriate MIDI
message type, without your having to configure it further. If you want to have the screen
control respond to a different type of MIDI message, you can choose another MIDI message
type from the Number pop-up menu in the Screen Control Inspector.

Incoming MIDI messages that are passed through are passed to any channel strips mapped
to the same device sending those messages (that is, to the keyboard controller you are
using to “play” those channel strips). If there is no matching device, the MIDI messages
are sent to all channel strips.

You can also filter incoming MIDI messages for individual channel strips. For information
on filtering MIDI messages, see Filtering MIDI Messages.

Exporting a Layout
You can export a layout so that you can save it independently from the concert and
import it into other concerts.

To export a layout
1 Choose File > Export Layout (or press Command-Shift-Control-S).

2 In the Save As dialog, type a name for the layout, and browse to a location where you
want to save the layout (or use the default location).

3 Click Save.
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Importing a Layout
You can import an exported layout into another concert, and then adjust it to work with
the mappings in the concert.

To import a layout into a concert
1 Choose File > Import Layout (or press Command-Control-O).

2 In the Open dialog, select the layout you want to import.

3 Click Open.

The layout for the concert changes to the imported layout.

When you import a layout into a concert, MainStage analyzes the layout and attempts
to convert the assignments and mappings in the layout to work with the concert. It uses
the following rules to convert imported assignments and mappings:

• Screen controls are assigned and mapped to screen controls of the same type if they
exist in the imported layout.

• Keyboard screen controls are assigned only to keyboard screen controls.

• If the arrangement of screen controls in the concert is similar to their arrangement in
the imported layout, screen controls are assigned and mapped to screen controls in
the same positions in the workspace.

• If the arrangement of screen controls in the concert is different, MainStage tries to
assign and map screen controls starting from the top-left corner of the workspace to
the bottom-right corner.

Because of the wide variety of possible layouts, not all assignments and mappings may
be converted as you intended, depending on the differences between the layouts. After
you import a layout into a concert, be sure to try the screen controls in the concert to
see if they work as expected. After importing the layout, you may need to manually
reassign some controls and then manually remap screen controls in your patches for the
concert to work with the new layout. If the imported layout has fewer screen controls
than the old layout, or has different types of screen controls, you will likely have to add
new screen controls after importing and then assign physical controls to the screen
controls to maintain the same level of functionality.

Changing the Aspect Ratio of a Layout
You can change the aspect ratio of a concert layout. Changing the aspect ratio lets you
use the concert with different monitor types:  16:10 (widescreen), 4:3 (standard), and 10:16
(portrait).

To change the aspect ratio of a layout
µ In the Action menu located in the upper-right corner of the workspace, choose Aspect

Ratio, then choose the aspect ratio from the submenu.
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You can play back audio files in time with your live performance. Playing back audio files
can have a variety of uses, including playing backing tracks to accompany your
performance, playing song stems that you can mix live, and using a “backing band” while
you practice your performance.

You play back audio files using the Playback plug-in, which is available in the Instrument
menu. Using the Playback plug-in, you can start and stop playback of an audio file, cycle
(loop) playback, and fade out the audio. Using markers, you can shift playback to different
parts of the audio file. You can have files play at their original speed or synchronize
playback to the current tempo of the concert. You can also play back several audio files
together using multiple instances of the Playback plug-in and control them using groups.

The Playback plug-in is available only in MainStage. This chapter provides information
on how you can use the Playback plug-in in a MainStage concert. For detailed information
about the interface, parameters, and functions of the Playback plug-in and supported
audio file formats, see The Playback Plug-in.

This chapter covers the following:

• Adding a Playback Plug-in (p. 135)

• Using the Playback Plug-in (p. 140)

Adding a Playback Plug-in
The Playback plug-in is an Instrument plug-in and is available only for software instrument
channel strips. To use the Playback plug-in, you add it to a software instrument channel
strip, then select an audio file to play. You can add a Playback plug-in to a channel strip
in a patch or at the set or concert level.
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Where you add an instance of the Playback plug-in depends on how you want to use it.
If you want to play back an audio file while you play a single patch, you can add it to the
patch. If you add a Playback plug-in at the set level, you can select different patches in
the set and have the audio file continue playing. This can be useful, for example, if the
set includes all the patches you’ll use in a song, and the Playback plug-in plays an audio
file with a backing track for the song. If you add a Playback plug-in at the concert level,
you can select different patches in the concert and have the audio file continue playing.
The ability to use the plug-in at any level gives you a great deal of creative freedom in
how you use it.

Each instance of the plug-in can play one audio file. You can use audio files in a variety
of file formats including AIFF, WAVE, and CAF. You can play audio files containing marker
information, including files exported (bounced) from Logic Pro and Apple Loops, and
shift playback to markers located at different time positions in the audio file.

There are two ways to add a Playback plug-in:  by dragging an audio file to the Channel
Strips area or from the Instrument slot on a channel strip.

To add a Playback plug-in by dragging an audio file
1 In the Patch List, select the patch to which you want to add a Playback plug-in. You can

also select a set or the concert icon.

2 Drag an audio file from the Finder to the space between channel strips in the Channel
Strips area.

A black line appears between the channel strips, and the pointer becomes an Add File
pointer as a new channel strip is created. The new channel strip contains a Playback
plug-in with the audio file you dragged to the Channel Strips area.

To add a Playback plug-in from the Instrument slot
1 Click the Add Channel Strip button to add a new channel strip to the patch, set, or concert.

2 In the new Channel Strip dialog, select Software Instrument as the type. Leave other
settings at their default values, or change them to suit your setup.

A new software instrument channel strip appears in the Channel Strips area.

3 In the I/O section of the channel strip, click the Instrument slot, choose Playback from
the menu, then choose either Mono or Stereo from the submenu.
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The Playback plug-in is added to the channel strip, and the plug-in window appears over
the MainStage window.

You can add an audio file to a Playback plug-in in one of several ways:  by dragging an
audio file, by clicking in the File field, or by using the Action menu in the plug-in window.

Adding an Audio File to the Playback Plug-in
After you add an instance of the Playback plug-in, you select and add the audio file you
want to play using the plug-in.

To add an audio file to the Playback plug-in
Do one of the following:

µ Drag the audio file to the Instrument slot with the Playback plug-in.

µ Drag the audio file to the “tape” area of the plug-in window.

µ Click the File field in the plug-in window, select an audio file in the Open dialog, then
click Open.

µ Choose Open File from the Action menu at the upper right of the Playback plug-in window,
select an audio file in the Open dialog, then click Open.
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The name of the audio file appears in the File field, and the waveform of the audio file
appears in the Waveform display.

You can preview an audio file in the Open dialog by selecting the file and clicking Play.
To hear the file after adding it to the Playback plug-in, click the Play button in the plug-in
window.

Setting the Sync Mode for the Playback Plug-in
When you add an audio file to the Playback plug-in, MainStage looks for tempo information
in the file. For audio files containing tempo information (including Apple Loops and files
exported from Logic Pro), the file is scanned for transients (short bursts of audio energy
that usually occur on rhythmic beats). Transient information is stored in the audio file
and used to play the file with the best audio quality, even when the file is played at a
different tempo or pitch. For these audio files, you can use the Sync feature to set whether
the audio file plays at its recorded tempo or uses the current tempo of the concert. When
Sync is set to Off, the audio file plays at its recorded tempo, regardless of the current
tempo of the concert. This can be desirable, for example, when the audio file contains
non-pitched sounds or a sound effect. When Sync is set to On, the audio file plays at the
current tempo (set by the patch, set, or concert, by tapping the tempo, or by listening to
MIDI beat clock). This makes it easy to keep backing tracks, for example, in time with each
other and with your performance. Setting Sync to On can affect audio quality.

You set the Sync mode for an instance of the Playback plug-in from the Sync pop-up
menu, located in the lower-left corner of the plug-in window.

To set the Sync mode for a Playback plug-in
µ To have the audio file play back at its original tempo, choose Off from the Sync pop-up

menu.

µ To have the audio file play back at the current tempo of the concert, choose On from the
Sync pop-up menu.
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Note: For audio files that do not contain tempo information, Sync is set to Off and the
Sync pop-up menu is unavailable.

Choosing the Flex Mode for the Playback Plug-in
For audio files containing tempo information, you can choose between different flex
modes for playing back audio. Each flex mode is optimized for playback of a certain type
of audio file, and you can choose which flex mode an instance of the Playback plug-in
uses to play back the audio file you added. The flex modes available are:

• Slicing: Slices the audio material at transient markers and plays each slice at its original
speed. Slicing is a good choice for general use, particularly for rhythmic material.

• Rhythmic: Based on the time-stretching algorithm used for Apple Loops, Rhythmic is
best suited for playing non-monophonic material, such as rhythmic guitars, rhythmic
keyboard parts, and Apple Loops.

• Speed: Time-stretches material by playing the source material faster or slower, including
changing the pitch. Speed is recommended for percussive material.

• Polyphonic: Based on a phase vocoder, Polyphonic time-stretches material, delivering
high sonic quality with suitable polyphonic material. It is recommended for complex
polyphonic material and is good for all kinds of chords—such as guitar, piano, and
choir—and for complex mixes.

Because each flex mode can produce different results depending on the audio material,
it is recommended that you try out different flex modes for each instance of the Playback
plug-in to determine which provides the best playback for your audio files.

To choose the flex mode for a Playback plug-in
µ Choose Flex Mode from the Action menu at the upper right of the plug-in window, then

choose the flex mode from the submenu.

Note: For audio files that do not contain tempo information, the Flex Mode menu item
is unavailable.

Adding Screen Controls for the Playback Plug-in
You can use screen controls to control the parameters of the Playback plug-in, display
parameter values and the name of the audio file, and display the audio waveform of the
audio file. The Screen Controls palette includes a waveform screen control that you can
use with the Playback plug-in to view the waveform of the audio file. If the audio file
contains markers, you can also view the markers in the waveform screen control.

To add a waveform screen control to the workspace
1 Click the Layout button (in the upper-left corner of the MainStage window) to switch to

layout mode.

2 Drag a waveform screen control to the workspace, and position it as needed.
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Note: If there is no Playback plug-in in the patch, an alert appears when you try to add
a waveform screen control.

When you map the waveform screen control to the Playback plug-in, the waveform for
the audio file loaded in the Playback plug-in appears in the waveform screen control.
When you press the button you mapped to the Play/Stop parameter, the audio file starts
playing, and you see the waveform move across the waveform screen control.

You can add screen controls for other parameters, including Fade Out, Cycle, Tempo, and
so on, and map them to the corresponding parameters in the Mapping browser or in the
Playback plug-in window. You can also map a parameter text screen control to the File
field and have it display the name of the audio file being played.

Using the Playback Plug-in
The design of the Playback plug-in allows you to use it in many different ways. You should
plan how you intend to use the Playback plug-in when you are designing your concert
to use it most effectively. You can try out different placements and settings to decide
how you want to use the Playback plug-in in your concerts.

You start playback by sending a Play command to the Playback plug-in using a screen
control, such as a button, mapped to the Play/Stop parameter of the plug-in. To stop
playback, you send a Stop command using the same parameter. Alternatively, you can
set the plug-in to start when you select the patch or set, or when the Play action is
triggered. You can control other parameters of the Playback plug-in while you perform,
including the Fade Out and Cycle parameters. If the audio file contains marker information,
you can use the Go To Previous Marker and Go To Next Marker parameters to shift playback
to different parts of the audio file, or use the Go to Marker action to shift playback to a
specific marker.

Note: When mapping a screen control to the Go to Marker action (in the Markers
submenu), set both the Button On and Button Off parameters in the Screen Control
Inspector to the value of the marker, to ensure that the mapping works correctly.
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A Playback plug-in in a patch plays only while the patch is selected. If you are using a
Playback plug-in at the set level, you can select different patches in the set (for example,
different lead synth or guitar solo patches) and have the audio file continue playing. If
you are using a Playback plug-in at the concert level, you can select different patches in
the concert and have the audio file continue playing.

The Playback plug-in provides an additional form of control using groups. If you use
multiple instances of the plug-in in your concert, you can use groups to control which
instances play together and which are mutually exclusive. When Playback instances are
in the same group, a change to the Play/Stop, Cycle, Fade Out, Return to Start, Go to
Previous Marker, or Go To Next Marker parameters in one instance changes that parameter
for every member of the group. You can use up to 26 groups, each identified by a different
letter. Starting one group stops all other groups, while ungrouped instances of the plug-in
continue playing.

If you are using multiple instances of the Playback plug-in in a group, you can start and
stop their playback together by starting or stopping any member of the group using a
screen control mapped to the Play/Stop parameter. When playback instances are grouped,
playback is “locked” so changes in position affect all members of the group. You can
control other aspects of playback, such as having the group fade out or loop playback,
using screen controls mapped to the corresponding controls in the plug-in window of
any member of the group. Playback instances that are not members of a group are not
affected.

You assign an instance of the Playback plug-in to a group from the Group pop-up menu,
located in the lower-right corner of the plug-in window.

To assign a Playback plug-in to a group
1 If the Playback plug-in window is not open, double-click its name in the Input slot to

open it.

2 Choose the letter of the group you want to assign the instance to from the Group pop-up
menu.
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Now that you’ve created and organized your sounds and set up your layout, it’s time to
play! MainStage features Perform mode which optimizes your display for live performance.

This chapter covers the following:

• Before the Performance Starts (p. 143)

• Using Perform Mode (p. 144)

• Selecting Patches in Performance (p. 144)

• Using Screen Controls in Performance (p. 146)

• Handling Tempo Changes in Performance (p. 146)

• Tips for Performing with Keyboard Controllers (p. 147)

• Tips for Performing with Guitars and Other Instruments (p. 147)

• Using the Tuner (p. 148)

• Using the Playback Plug-in in Performance (p. 149)

• Recording Your Performances (p. 150)

• After the Performance (p. 150)

• Tips for Complex Hardware Setups (p. 150)

Before the Performance Starts
Here are a few things to check before you begin performing:

• Make sure your MIDI controllers, instruments, microphones, and other music equipment
is connected to your computer and is working.

• Test the audio output from MainStage using the audio interface and speakers or
monitors you plan to use in performance.

• Select a patch with a software instrument channel strip and play your keyboard
controller. Watch the Activity Monitor to make sure MainStage is receiving MIDI input
from the controller, and make sure you can hear the audio output.
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• Make sure any instruments or microphones you plan to play through audio channel
strips are connected to the correct audio inputs on your audio interface. Select a patch
with an audio channel strip and play or sing to make sure you can hear audio output.

• For the best results, close any applications that you do not need while performing,
particularly applications with high processor or RAM requirements.

• Disconnect the computer running MainStage from any network connections.

Using Perform Mode
When you perform live, you can use either Perform in Full Screen or Perform in Window,
depending on which you prefer. Each offers some advantages for different performance
situations. If you want to view the workspace at maximum size on your display and do
not need to access the Finder or the toolbar, use Perform in Full Screen. If you need to
access other applications or access buttons in the toolbar, use Perform in Window.

To switch to Perform mode
Do one of the following:

µ Choose View > Perform in Full Screen (or press Command-4).

µ Click the Perform button in the toolbar.

Note: By default, the Perform button opens the workspace in full screen. For information
about changing this preference, see Display Preferences.

To close Perform in Full Screen
Do one of the following:

µ Press the Escape (Esc) key.

µ Click the circled “X” in the upper-left corner of the screen.

µ Use the key command for one of the other modes (Command-1 through Command-3).

To switch to Perform in Window
µ Choose View > Perform in Window (or press Command-3).

By default, when you open MainStage, it opens in Edit mode. You can change the default
behavior in MainStage General preferences so that it opens in Perform mode or Perform
in Full Screen. For more information, see General Preferences.

Selecting Patches in Performance
In Perform mode, you can view and select patches using the patch selector screen control
in your layout. Patches and sets appear in the patch selector in the same order as in the
Patch List in Edit mode. Skipped items do not appear in the patch selector and cannot
be selected, but patches in collapsed sets do appear and can be selected. For information
about skipping items, see Skipping Items in the Patch List.
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When you select a patch, you can start playing it instantly. If you are sustaining notes
from the previous patch, they will continue to be sustained until you release the notes
or the sustain pedal. If the previous patch contains effects (such as a reverb or delay effect)
with a release “tail,” the effect tail continues sounding for the amount of time set in the
Silence Previous Patch pop-up menu in MainStage preferences. For more information,
see Setting MainStage Preferences.

When performing, keep in mind the difference between patch parameters and parameters
controlled at the concert level. When you select a patch, its parameters are set to the
values at which you last saved the patch. If you have previously played the patch since
you opened the concert, they are set to the values at which you left them when you
played the patch. Parameters at the concert level, however, remain at their current value
when you select new patches. For example, if you select a patch with a channel strip set
to a volume 0 dB, but the Master volume fader at the concert level is set to −96 dB, you
will hear silence, not full volume. Similarly, parameters controlled at the set level remain
at their current value when you select a different patch in the set.

Also keep in mind that when you select a patch, the screen controls for knobs, faders,
and other controls in the workspace show the parameter values for the patch, which may
be different than the positions of the physical controls on your controller. When you
move the physical controls, the screen controls instantly update to show the current
value.

Selecting Patches Using Key Commands
You can select patches in the patch selector using the following key commands:

SelectionKey command

The previous patchUp Arrow

The next patchDown Arrow

The first patch in the previous setLeft Arrow

The first patch in the next setRight Arrow

Selecting Patches by Typing
You can select a patch in the Patch List by typing the first few letters of its name.

To select a patch by typing its name
µ Type the letter “f”, then begin typing the name of the patch.

Once you type enough letters to uniquely identify the patch name, the patch is selected.

µ To cancel typing, press Enter.
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Selecting Patches Using Actions
If you have mapped screen controls to actions for selecting patches, such as selecting
the previous or next patch, you can select the patches using the physical controls assigned
to those screen controls as you perform. You can also select sets or the concert using
actions. Buttons are particularly useful for selecting patches, sets, or the concert using
actions.

When selecting patches using actions, skipped patches are also skipped. For example, if
you use a screen control mapped to select +10 patches, any skipped patches would not
be counted in the +10.

For more information, see Using MainStage Actions.

Selecting Patches Using Program Change Messages
If your MIDI device has buttons or other controls that send program change messages,
you can select patches in your concert by program change number. You can use program
change messages to select patches but not sets.

For information about how your MIDI device sends program change messages, consult
the documentation that came with the device or the manufacturer’s website. For
information about changing the program change number for a patch, see Setting Patch
Program Change Numbers.

Using Screen Controls in Performance
In performance, you use the controls on your MIDI hardware devices that are assigned
to screen controls to manipulate the parameters mapped to those screen controls. When
you select a new patch, the parameters you mapped for that patch are instantly available
for editing.

When you move a physical control, the screen control updates based on the Respond to
Hardware Move parameter in the Screen Control Inspector. If the parameter is set to
Jump, the screen control instantly moves to the position of the hardware control. If the
parameter is set to Pickup, the screen control starts moving when the hardware control
reaches its current position. If the parameter is set to Relative, the screen control moves
in sync with the hardware control, starting from its current position.

Handling Tempo Changes in Performance
When you open the concert you plan to use in your performance, MainStage uses the
tempo for the concert you set in the Concert Inspector. If the “Get tempo from MIDI input”
checkbox is selected, MainStage uses incoming MIDI beat clock to set the tempo. For
information about setting and changing the tempo in a concert, see Using Tempo in a
MainStage Concert.
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If you select a patch or set with its own tempo setting, the tempo changes to the new
setting. You can also change the tempo in real time while you perform using the Tap
Tempo feature, either by pressing Control-T repeatedly at the tempo you want to use,
by clicking the Tap Tempo button in the toolbar repeatedly, or using a screen control
mapping to the Tap Tempo action.

Tips for Performing with Keyboard Controllers
If you are using one of the Keyboards templates designed for use with a MIDI-compatible
keyboard controller, you can play your keyboard and use MainStage as a sophisticated
sound module and multi-effects processor. The patches in the template make extensive
use of the software instrument plug-ins included with MainStage as well as a wide range
of effects plug-ins.

Tips for Performing with Guitars and Other Instruments
If you are using one of the Guitar Rigs templates designed for use with electric guitar,
you can play your electric guitar and use MainStage as a multi-effects processor. The
patches in the template make extensive use of the Amp Designer amp simulation plug-in
and the Pedalboard effects plug-ins as well as other effects commonly used with guitars.

Guitar patches with Pedalboard-style screen controls can be assigned to a foot switch,
allowing you to bypass different effects in the channel strip. Some patches also allow you
to switch between channel strips with different effects using an expression pedal.

When playing guitars and other low-impedance instruments, be sure they are connected
to an audio input that matches the impedance of the instrument. Connecting a guitar to
a standard line-level audio input may produce a lower volume level for the guitar’s output
than intended.

You can also use MainStage with vocals, or any sound captured with a microphone, using
an audio interface connected to your computer and choosing the audio input channel
in audio channel strips in your patches.

For guitar patches that use multiple channel strips, you can control the overall volume
of the patch using a foot pedal. Using the following procedure, you can set the overall
volume for the patch (that is, for all channel strips) so it starts playing at the set volume
level but still control subsequent volume changes using the foot pedal.
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Using the Tuner
MainStage includes a Tuner that you can use to tune guitars and other instruments you
play through an audio channel strip. The Tuner shows pitch on a circular scale with the
note name and octave displayed in the center of the scale. When you play a single note
on your instrument, the pitch is shown in relation to the correct pitch for the note
displayed.

You can use the Tuner on an instrument connected to the first audio channel strip in a
patch. Channel strips that can use the Tuner are indicated by a tuning fork icon near the
top of the channel strip.

To tune an instrument using the Tuner
1 Select the audio channel strip you want to use the Tuner with.

2 Click the Tuner icon in the toolbar (or press Command-T).

The Tuner appears in the workspace.

3 Play a single note on your instrument, and watch the Tuner display.

As you play, the Tuner shows the note name of the closest note. If the note is not in tune,
red vertical bars appear, showing whether the note is sharp or flat. The bars appear to
the right of the note name if the note is sharp, and to the left if the note is flat.

4 Adjust the tuning peg for the string you are tuning.

When the note is in tune, a blue vertical bar appears in the center, above the note name.

Be sure to play only a single note at a time while tuning. The Tuner can’t tune to a chord
or interval or if you play different notes rapidly.
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When using the Tuner with a patch containing multiple channel strips, only audio from
the first audio channel strip is sent to the Tuner, even if other channel strips in the patch
have the same input source. Before using the Tuner, make sure that the first audio channel
strip is active and not muted.

In the Channel Strips area, the channel strip that will send audio to the Tuner is indicated
by a tuning fork icon at the top of the channel strip.

If other channel strips in the patch have the same audio input source as the first channel
strip, the sound from those channel strips is still audible (unlike the output from the
Tuner). For example, if you are using a twin-amp patch from the Rock guitar concert
template, the output for the second amp is audible while you tune the guitar, unless you
mute its output (by setting the Expression pedal screen control to zero).

Using the Playback Plug-in in Performance
You can use the Playback plug-in to play backing tracks or other audio files while you are
performing, and trigger playback either when you select a patch or set, or using a button
or other screen control. You can control other Playback parameters to which you have
mapped screen controls, including fading out the sound and looping playback. For files
containing marker information, you can also use markers to switch playback to different
sections of the audio file. You can start and stop playback of multiple Playback plug-in
instances using the Group menu.

Where you add an instance of the Playback plug-in depends on how you want to use it.
If you want to play back an audio file while you play a single patch, you can add it to the
patch. If you add a Playback plug-in at the set level, you can select different patches in
the set and have the audio file continue playing. This can be useful, for example, if the
set includes all the patches you’ll use in a song, and the Playback plug-in plays an audio
file with a backing track for the song. If you add a Playback plug-in at the concert level,
you can select different patches in the concert and have the audio file continue playing.
The ability to use the plug-in at any level gives you a great deal of creative freedom in
how you use it.

The Playback plug-in is designed so that it can be used in a variety of ways. Following
are a few ideas for how to use the Playback plug-in in different situations. You can try
them out or use them as a starting point for your own creative uses.

Some Playback Plug-in Usage Ideas
You can use the Playback plug-in in software instrument channel strips in a patch or at
the set or concert level.

• Add a Playback plug-in to a patch and use it to play a backing track while you play an
instrument on another channel strip in the patch.
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• Add a Playback plug-in at the set level and use it to play a backing track that continues
while you select and play different patches in the set.

• Add a Playback plug-in at the concert level and use it to play a backing track or sound
effect while you select and play different patches in the concert.

• Add multiple instances of the Playback plug-in at the set or concert level, and use them
to play and remix different backing tracks.

Recording Your Performances
You can record a performance to an audio file. Before you record a performance, you can
choose the file format of the recorded audio file.

If you choose AIFF as the file format for recording, the maximum file size for the recorded
file is 2 gigabytes. If you choose WAVE as the file format, the maximum file size is
4 gigabytes. If you choose CAF as the file format, there is no practical limit to the file size.
You can choose the file format in the Audio pane of MainStage preferences and also set
the location of the recorded file and choose which audio outputs are recorded (if you are
using multiple sets of outputs in your concert). For information about recording
preferences, see Recording.

You can record in Perform mode by mapping a screen control to the Record action. You
can also assign a key command to the Record action and use it to record in Perform mode
(but not in Perform in Full Screen).

To start recording to an audio file
µ Move the screen control mapped to the Record action (or press Option-R).

To stop recording
µ Move the screen control mapped to the Record action (or press Option-R again).

After the Performance
Before closing your concert after your performance, remember that, for any screen controls
for which the On Patch Change parameter is set to “Reset to saved value,” any changes
to channel strip parameters or plug-in parameters you made while performing revert to
their previously saved state if you close the concert without saving. If you save the concert
before closing, the new values will only be saved for the currently selected patch, and
not for the other patches (or sets) in the concert.

Tips for Complex Hardware Setups
It is highly recommended that you test your concert thoroughly using the same setup
you plan to use in live performance prior to performing, at the performance location or
venue if possible. This is especially important for more complex hardware setups.
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Using Multiple Keyboard Controllers in Performance
If you plan to use multiple keyboard controllers when you perform, you can choose
whether screen controls respond to MIDI messages from all controllers or only a specific
controller and whether channel strips receive input from all controllers or only a single
controller.

In Layout mode, screen controls can be set to respond to MIDI input on all MIDI ports
and channels or to only a specific device or channel. To have a screen control respond
to MIDI input from all controllers, choose All from both the Device and Channel pop-up
menus in the Layout Inspector. To have a screen control respond to a specific controller
or to the same channel as the keyboard screen control, choose that controller from the
Device pop-up menu.

In Edit mode, you set the device from which a channel strip receives MIDI input in the
Key Range section of the Channel Strip Inspector. By default, channel strips receive input
from the first controller in the layout. You can set a channel strip to receive input from
another device in the Input pop-up menu.

Using a Different Hardware Setup in Performance
If you use MainStage with a complex hardware setup, for example, with multiple MIDI
controllers or MIDI interfaces or with multiple audio inputs, you will achieve the best
results when you use exactly the same hardware setup you used when you created your
concert.

If you plan to use MainStage with different controllers, interfaces, or other devices than
the ones you used to create your concert, you need to relearn your hardware assignments
using your performance hardware setup. To facilitate working in this situation, you can
create two separate layouts, one for your studio setup and another for your performance
setup, with corresponding screen controls in each layout. Before you perform, import the
performance layout into your concert. The hardware assignments for your performance
setup are imported with the layout, and your mappings are maintained.
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This chapter provides tables listing the default key commands for MainStage and describes
how to open the Command Editor to customize key commands.

This chapter covers the following:

• Using the Command Editor (p. 153)

• MainStage Default Key Commands (p. 153)

Using the Command Editor
MainStage includes a Command Editor that lets you view and customize key commands.
You can assign key commands to functions that do not have a default key command and
change the key command for other functions. You can also create multiple command
sets and switch between them.

You can assign key commands to customize the current command set. You can also
choose a different command set, and import, export, duplicate, and delete command
sets in the Command Editor.

To open the Command Editor
µ Choose MainStage > Commands > Customize.

The Command Editor opens, showing the key commands for the selected command set.

For detailed information about working with the Command Editor, including information
on customizing, exporting, and importing command sets, see “Working with Key
Commands” in the “Basic Operations” chapter of the Logic Pro User Manual.

MainStage Default Key Commands
The following sections show all of the default key commands for MainStage, grouped by
function. These can significantly accelerate your workflow, particularly when creating
large or complex projects.
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Concerts and Layouts
Includes key commands for creating, opening, and saving concerts and for exporting and
importing layouts.

FunctionDefault key command

New concertCommand-N

Open concertCommand-O

Close concert, or close the active plug-in windowCommand-W

Save concertCommand-S

Save concert asCommand-Shift-S

Import layoutCommand-Control-O

Export layoutCommand-Shift-Control-S

Patches and Sets (Edit Mode)
Includes key commands for adding, selecting, exporting, and importing patches and sets.

FunctionDefault key command

Add a new patchCommand-Option-N

Add a new setCommand-Option-S

Import patches or setsCommand-I

Export patch, export set, or export as set
(depending on what is selected)

Command-E

Select the previous patchCommand-Up Arrow

Select the next patchCommand-Down Arrow

Select the first patch in the previous setCommand-Left Arrow

Select the first patch in the next setCommand-Right Arrow

Create a new set from selected patchesCommand-Shift-Option-S

Reset program change numbersCommand-Shift-Option-R

Editing
Includes key commands for cutting, copying, pasting, and other common editing functions.

FunctionDefault key command

Undo the last commandCommand-Z

Redo the last undone commandCommand-Shift-Z

CutCommand-X

CopyCommand-C

PasteCommand-V

DuplicateCommand-D
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FunctionDefault key command

Select allCommand-A

Actions
Includes key commands for some MainStage actions.

FunctionDefault key command

PanicControl-P

Tap TempoControl-T

Master MuteControl-M

Toggle RecordingControl-R

Toggle Play/StopSpace bar

Parameter Mapping (Edit Mode)
Includes commands for learning mappings and locating mappings in the Parameter
Mappings browser.

FunctionDefault key command

Map the selected parameter (turn on mapping)Command-L

Find in Parameter Mapping browserCommand-F

Find againCommand-G

Channel Strips (Edit Mode)
Includes commands for adding channel strips.

FunctionDefault key command

Add audio channel stripCommand-Option-A

Add software instrument channel stripCommand-Option-I

Show/Hide signal flow channel stripsCommand-Option-F

Screen Controls (Layout Mode)
Includes key commands for learning controller assignments and for grouping and
ungrouping screen controls.

FunctionDefault key command

Learn controller assignment (turn on the Learn process)Command-L

Group screen controlsCommand-Option-G

Ungroup screen controlsCommand-Shift-Option-G

Select the next screen control, select the Add hardware label
checkbox, and select the Add hardware label text field for entering
text

Command-Option-H
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Perform in Full Screen
Includes key commands for selecting patches and sets, sending MIDI panic,
muting/unmuting audio, and exiting Perform in Full Screen.

FunctionDefault key command

Select the previous patchUp Arrow

Select the next patchDown Arrow

Select the first patch of the previous setLeft Arrow

Select the first patch of the next setRight Arrow

Send MIDI panicP

Mute/unmute all audioM

Exit Perform in Full ScreenEsc

Window and View
Includes key commands for switching modes and for showing Inspectors and other areas
of the interface.

FunctionDefault key command

Layout modeCommand-1

Edit modeCommand-2

Perform in WindowCommand-3

Perform in Full ScreenCommand-4

Show/Hide InspectorsCommand-5

Show/Hide the Channel Strips areaCommand-6

Show/Hide the TunerCommand-T

Minimize the MainStage windowCommand-M

Open MainStage preferencesCommand-Comma (,)

Show/Hide the active plug-in windowV

Help and Support
Includes the key command to open the MainStage User Manual.

FunctionDefault key command

MainStage User ManualCommand-Question Mark (?)
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The Playback plug-in is an audio file player that you can use to play backing tracks, song
stems, and other audio files. The Playback plug-in supports uncompressed mono or stereo
audio files in the AIFF, WAV, and CAF formats with a bit depth of 16 or 24 bits. You can
bounce a single stem from a Logic Pro project or a set of stems from individual tracks.

You can use Playback to jump to song sections and repeat them. If you assign multiple
instances to groups, each song section can include multiple stems, which expands the
possibilities for live remixing of your material. These and other features make the Playback
plug-in a flexible, powerful, creative tool, both in the studio and in live performance.

This appendix covers the following:

• Getting to Know the Playback Interface (p. 158)

• Using the Playback Waveform Display (p. 159)

• Using the Playback Transport and Function Buttons (p. 160)

• Using the Playback Information Display (p. 161)

• Using the Playback Sync, Snap To, and Play From Parameters (p. 162)

• Using the Playback Group Functions (p. 163)

• Using the Playback Action Menu and File Field (p. 164)

• Using the Playback Shortcut Menu (p. 165)
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Getting to Know the Playback Interface
The Playback interface resembles a hardware tape player. This section will familiarize you
with various areas of the Playback plug-in window.

Waveform display Action menu

Information displaySync, Snap To, Play From, 
and Group pop-up 
menus

Transport buttons

Function buttons

• Waveform display: The waveform display shows the waveform of the currently loaded
audio file, the current playback position, and the ruler. See Using the Playback Waveform
Display.

• Transport and function buttons: The transport and function buttons appear on either
side of the information display in the silver bar below the waveform display. See Using
the Playback Transport and Function Buttons.

• Information display: The information display shows the current playback position and
audio file length, meter, tempo, fade time, and pitch. See Using the Playback Information
Display.

• Sync, Snap To, Play From, and Group pop-up menus: The bar across the bottom of the
Playback window contains controls you use to set playback behavior: the Sync, Snap
To, Play From, and Group pop-up menus. See Using the Playback Sync, Snap To, and
Play From Parameters. The Group pop-up menu sets group membership for each
Playback instance. See Using the Playback Group Functions.

• Action menu and File field: The Action menu (with the gear icon) contains options for
adding an audio file, choosing the flex mode, and other functions. See Using the
Playback Action Menu and File Field. The File field displays the name of the currently
loaded audio file.

• Shortcut menu: You can add, edit, and remove markers using the shortcut menu (not
shown), which you can access by Control-clicking (or right-clicking) the waveform
display. See Using the Playback Shortcut Menu.
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Using the Playback Waveform Display
The waveform display shows the waveform of the currently loaded audio file. The vertical
line in the center of the display indicates the current playback position as the waveform
scrolls from right to left. Above the waveform, the time ruler displays time in either hours,
minutes, and seconds (when Sync mode is off ) or bars and beats (when Sync is on). If the
audio file contains marker information, the marker names and positions appear below
the time ruler.

File field Action menu
Playhead/playback 

position Marker barTime ruler

You can drag the waveform horizontally to move to a different position while Playback
is stopped. Playback starts from the new position if the Play From parameter is set to
Current Position.

Note: The Snap To and Play From parameters can affect playback behavior. See Using
the Playback Sync, Snap To, and Play From Parameters.

Markers, if present, are indicated on the marker bar, below the ruler. You can load audio
files that contain markers, or add markers to the loaded audio file using the Add Marker
command in the shortcut menu. For information about adding, renaming, and deleting
markers, see Using the Playback Shortcut Menu.

To move to different markers with the marker bar
Do one of the following:

µ Click a marker in the marker bar to move it to the current playhead position (in the center
of the waveform display). Playback begins from this position if you are in play mode.

µ Click to the left of a marker to move the preceding marker to the centered current position
indicator. Repeated clicks move earlier markers to the current position indicator. Playback
begins from this position if you are in play mode.
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Using the Playback Transport and Function Buttons
This section covers the buttons used for playback, fade, count-in, click, and marker
navigation operations.

Return to Start button

Metronome buttonPlay/Stop button

Cycle button Count-in buttonFade Out button

Previous/Next Marker 
button

• Return to Start button: Moves to the very beginning of the audio material, but does not
start playback. If Playback is in play mode, however, playback will continue from the
start of the audio file.

• Play/Stop button: Starts or stops playback. The position playback starts from is affected
by the Sync, Snap To, and Play From parameters. See Using the Playback Sync, Snap
To, and Play From Parameters.

• Cycle button: Cycles playback between the current marker and the next marker. Audio
is automatically crossfaded at the marker points to minimize clicks. If the file contains
no markers, playback of the entire file is cycled.

• Fade Out button: Gradually lowers the volume level to silence over the number of
seconds specified in the Fade Time parameter. The Fade Out button turns blue until
the fade out has completed and playback stops.

You can stop an active fade out by clicking the Fade Out button a second time. This
gradually restores audio playback to the full volume level over the same amount of
elapsed time as the fade out.

• Count-in button: Enables a one-bar count-in, using the MainStage metronome click.
The count-in always uses the concert tempo and meter, regardless of the Sync mode.

• Metronome button: Turns the MainStage metronome on or off. The metronome always
uses the concert tempo and meter, regardless of the Sync mode.

• Go to Previous Marker button: In play mode, immediately moves to the previous marker
(to the left of the current playhead position) if the audio material contains markers.
Playback continues from this position. If the audio file contains no markers, moves
backward 8 bars (if Sync is on) or 20 seconds (if Sync is off ). Playback continues from
the new position.
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If Playback is stopped, moves to the previous marker or to the beginning of the audio
file if the current playhead position precedes the first marker. If the file contains no
markers, moves 8 bars (if Sync is on) or 20 seconds (if Sync is off ). Press Play to start
playback from this position.

• Go to Next Marker button: In play mode, immediately moves to the next marker (to the
right of the current playhead position) if the audio file contains markers. Playback
continues from this position. If the audio file contains no markers, moves forward 8 bars
(if Sync is on) or 20 seconds (if Sync is off ). Playback continues from the new position.

If Playback is stopped, moves to the next marker or to the end of the audio file if the
current playhead position is after the last marker. If the file contains no markers, playback
rewinds by 8 bars (if Sync is on) or 20 seconds (if Sync is off ). Press Play to start playback
from the new position.

Using the Playback Information Display
The information display shows information about several key aspects of your audio
material, and lets you edit some of the displayed values.

• Position field: Shows the current position in hours, minutes, and seconds (when Sync
is off ), or in bars and beats (when Sync is on).

• Length field: Displays the overall length of the loaded audio file in hours, minutes, and
seconds (when Sync is off ), or in bars and beats (when Sync is on).

• Meter field: When Sync is on, lets you define the meter (time signature) of the audio
file. The bar and beat values can be altered independently. Editing the Meter field
changes the ruler display, and may alter the Length field display, but has no impact on
audio playback.

• Tempo field: Displays the MainStage concert tempo in beats per minute when Sync is
on. Playback follows only a single, constant tempo. The Tempo field is disabled when
Sync is off.

Note: Because Playback instances use the concert tempo when Sync is on, you can use
audio files recorded at different tempos, and have them all play back at the same tempo
(the concert tempo).

• Fade Time field: Sets the fade-out time in seconds. Drag vertically to adjust this value.
Click the Fade button to start or stop a fade-out.
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• Pitch fields: Transpose audio playback when Sync is on. Drag vertically in either the
semi or cent field to transpose the audio file in semitones or cents (1/100 of a semitone).
The Pitch fields are disabled when Sync is off.

Using the Playback Sync, Snap To, and Play From Parameters
The Sync, Snap To, and Play From pop-up menus control various aspects of playback and
synchronization of the audio file.

• Sync pop-up menu: Controls whether playback is synchronized with the concert tempo.
When Sync is off, the audio file plays at its recorded tempo. When Sync is on, the file
plays at the current tempo of the concert.

Note: Only audio files that contain tempo information will play back at the MainStage
concert tempo when Sync is active. If the file contains no tempo information, the Sync
parameter is disabled.

• Snap To pop-up menu: Sets the value to which transport functions—including Play,
Return to Start, Previous Marker, and Next Marker—snap. The active transport function
is delayed until the next bar, beat, or marker is reached, depending on the current Snap
To setting. The Snap To setting always reflects the concert tempo and time signature,
regardless of the Sync setting.

• Off: Transport functions occur immediately, without waiting.

• Beat: Transport functions occur at the start of the next beat.

• Bar: Transport functions occur at the start of the next bar.

• Wait for Marker: Transport functions occur when the next marker is reached.

• Play From pop-up menu: Determines the position from which playback starts.

• Current Position: Playback starts from the current playhead position in the audio file.
This can be especially useful when you are setting up Playback instances in Edit
mode.

• Start: Playback starts from the beginning of the audio file.

• Current Marker: Playback starts from the start of the current marker (the marker to
the left of the current position) in the audio file.

• Relative Position: Playback is synced to the MainStage clock, so stopping and starting
playback follows the MainStage clock position. Using Relative Position is similar to
using a mute button.
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Using the Playback Group Functions
If you have multiple instances of the Playback plug-in in a concert, you can use groups
to control which instances play together and which instances operate independently.
Any Playback instance can either be assigned to one of 26 Groups, named A-Z, or not be
a member of any group. The linked operation of multiple instances can be used for
creative playback purposes, such as alternative versions of a song verse or chorus.

Only one group can be active at a time. For example, if two Playback instances are in
Group A, and four Playback instances are in Group B, activation of a transport function in
any Group A member will stop playback of all Group B members, and vice versa. Instances
that are not in any group are not affected.

All Playback instances that belong to a group will switch between states for the following
transport functions when changed in any group member:

• Return to Start

• Play or Stop

• Dragging in the waveform display

• Cycle

• Fade Out (time and action)

• Go to Previous (or Next) Marker

Important: Editing a parameter in one member of a group does not automatically update
the parameter value in other group members. To change the parameter value in all group
members, hold down Shift while you edit the parameter in any group member. This
applies to the Meter, Fade Time, Pitch, Sync, Snap To, and Play From parameters. You
need to set Sync to the same mode for all group members or you will hear playback drift
between grouped instances.

To assign a Playback instance to a group
µ Open the Group pop-up menu at the lower right of the interface and choose a letter.

Note: When a Playback instance is added to an existing group, some button states may
be different from other group members. If you want all group members to behave
identically when a transport button is used in any group member, make sure that the
states of all buttons match those of other group members before you add a Playback
instance to a group.

To remove a Playback instance from all groups
µ Choose the “–” item from the Group pop-up menu.
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Using the Playback Action Menu and File Field
The Action menu is found to the top right of the waveform display and contains the
following items:

• Open File: Opens a dialog from which you can preview and choose a file to load into
the Playback plug-in.

• Remove File: Removes the file currently loaded in the Playback plug-in.

• Flex Mode: For audio files containing tempo information, you can choose one of the
following time-stretching modes:

• Slicing is a good choice for general use, particularly for rhythmic material such as
drum parts. It works by dividing the audio material at transient markers. Each slice
is played back at its original speed.

• Rhythmic is best suited for playing polyphonic rhythmic audio material such as rhythm
guitar or keyboard parts.

• Speed is recommended when the concert tempo is the same as (or close to) the
recorded tempo of the audio file. It produces an effect like slowing down or speeding
up a tape recorder, without the artifacts of time stretching.

• Polyphonic is designed for complex polyphonic audio material and is a good choice
for guitar, piano, and choir parts, or for complete mixes.

• Start on Patch Change: Starts playback when you select the patch (or set) containing
the Playback instance.

• Start with Play Action: Starts playback of the Playback plug-in when the MainStage clock
starts. “Start with Play Action” follows the current Play From setting—that is, it waits
until the next event specified in the Play From setting.

The File field, which is located to the left of the Action menu, shows the name of the
currently loaded audio file. You can load an audio file in several ways.

To load an audio file
Do one of the following:

µ Click the File field to show an Open dialog, from which you can choose the file you want
to load.

µ Choose Open File from the Action menu to show an Open dialog, from which you can
choose the file you want to load.

µ Drag an audio file to the File field.

µ Drag an audio file into the waveform display.

µ Drag an audio file to the Instrument slot containing the Playback plug-in.
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µ Drag an audio file between two channel strips. This creates a new channel strip with the
Playback plug-in inserted. The (dragged) audio file is automatically loaded into this new
Playback instance. You can drag multiple files between channel strips to create a new
channel strip for each file.

Note: Using either of the first two methods, you can preview files in the dialog before
adding one to the Playback instance. To preview the selected audio file in the dialog,
click the Play button. Click the Stop button in the dialog to stop playback.

Using the Playback Shortcut Menu
The Playback window includes a shortcut menu that lets you add, name, and remove
markers in the waveform display. You access the shortcut menu by Control-clicking the
waveform display. The shortcut menu contains the following commands.

• Add Marker: Adds a marker at the current position of the pointer, and opens a name
field. Enter the name, then press Return or click outside the name field.

• Remove Marker: Removes the marker to the left of the current position.

• Rename Marker: Opens a name field for the marker nearest to the clicked position.
Enter a new name, then press Return or click outside the name field.

• Remove All Markers: Removes all markers.
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The Loopback plug-in lets you record virtual “tape loops,” play them back repeatedly,
and overdub new recordings while previous ones continue playing. You can use the
Loopback plug-in to create simple loops, recurring motifs, or complex, evolving textures.

Using Loopback as an insert plug-in in an instrument channel strip, you can create looped
performances with a single instrument, your voice, or other audio material. By inserting
Loopback in an aux channel strip and using it as a send effect, you can create loops with
multiple instruments, vocal performances, and other audio material routed from other
channel strips. Relative levels can be controlled with the Send knobs of the source channel
strips.

Loopback lets you create “sound-on-sound” backing tracks or grooves in your MainStage
performance. You can use multiple instances as a rhythm section, and switch between a
reduced and a full version of your rhythm parts, for example. The Loopback plug-in is a
flexible, powerful, creative tool both for the studio and for live performance. You can also
export loop performances as standard audio files to use in other plug-ins, including the
Playback plug-in.

This appendix covers the following:

• Getting to Know the Loopback Interface (p. 168)

• Using the Loopback Waveform Display (p. 169)

• Using the Loopback Transport and Function Controls (p. 169)

• Using the Loopback Information Display (p. 170)

• Using the Loopback Sync, Snap To, and Play From Parameters (p. 171)

• Using the Loopback Group Functions (p. 172)

• Using the Loopback Action Menu (p. 173)

• Adding Loopback to a Channel Strip (p. 174)
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Getting to Know the Loopback Interface
The Loopback interface resembles a hardware tape-loop device. This section will familiarize
you with various areas of the Loopback interface.

Waveform display Action menu

Information displaySync, Snap To, and 
Play From pop-up menus

Transport buttons

Function buttons

• Waveform display: The waveform display shows the waveform of the recorded audio
material, the playhead position, and the ruler. See Using the Loopback Waveform
Display.

• Transport and Function controls: The transport and function buttons are located to the
left and right of the information display in the silver bar that spans the plug-in window.
See Using the Loopback Transport and Function Controls.

• Information display: The information display provides details on the current playback
position and recording length, meter, tempo, and fade time. See Using the Loopback
Information Display.

• Sync, Snap To, Play From, and Group pop-up menus: The black bar across the bottom
contains the Sync, Snap To, and Play From pop-up menus. These are used to set playback
and recording behavior. See Using the Loopback Sync, Snap To, and Play From
Parameters. The Group pop-up menu sets group membership for each Playback instance.
See Using the Loopback Group Functions.

• Action menu: The Action menu is accessed by clicking the button with the gear icon
at the top right of the interface. It provides import and export, monitoring, and other
commands. See Using the Loopback Action Menu.
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Using the Loopback Waveform Display
The waveform display shows the waveform of the recorded audio material. The waveform
display updates in real time as you record new material. The vertical line in the center of
the display is the playhead, which shows the current playback or recording position as
the waveform scrolls from right to left. The ruler appears above the waveform, showing
bars and beats (musical time).

Using the Loopback Transport and Function Controls
This section covers the controls for recording, playback, fade, count-in, metronome, and
undo operations.

Record button

Play/Stop button

Reverse button

Fade Out button

Count-in button

Metronome button

Undo button

• Record button: Starts or stops recording. Click the Record button once to start recording
to the tape loop—a virtual tape loop, not an actual one. Click a second time to set the
length and start overdubbing. During overdubbing, the first recorded take plays back
while you record subsequent takes. Subsequent clicks toggle recording off or on, while
the tape loop keeps playing.

• Play/Stop button: Starts playback at the position set by the Play From and Snap To
parameters. If Loopback is playing or recording, stops immediately (without waiting
to reach the Snap To value). If loopback is recording and has not established length it
sets the length and just continues to play back with no overdubbing. See Using the
Loopback Sync, Snap To, and Play From Parameters.
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• Reverse button: Reverses the contents of the tape loop, so the sound plays back in
reverse. You can activate Reverse when Loopback is either playing or stopped.

• Fade Out button: Gradually lowers the volume level of the tape loop over the time
specified in the Fade Time field. The Fade Out button remains highlighted until the
fade-out has finished and playback stops.

The fade-out affects only previously recorded material. You can start recording during
a fade-out, and the new material is recorded and plays at full level. When you record
new material during a fade-out, Loopback does not stop when the fade-out has finished,
but continues playing the newly recorded material.

If the tape loop length has been set, pressing the Fade Out button (or activating a
screen control mapped to it) while Loopback is playing clears the buffer, but does not
reset the loop length. Pressing the Fade Out button while Loopback is stopped clears
the buffer. If the loop length was undefined when Loopback started playing, it also
resets the loop length.

• Count-in button: Enables a one-bar count-in, using the concert time signature.

• Metronome button: Turns the MainStage metronome on or off.

• Undo button: When pressed during playback or when stopped, removes the most
recently recorded take from the tape loop. Pressing Undo during the first beat of a new
take removes the previously recorded take.

Using the Loopback Information Display
The information display shows information about several key aspects of the audio material
in the tape loop, and lets you edit some of the displayed values.

• Position field: Indicates the current playhead position.

• Length field: Displays the length of the loop.

If Sync is set to Off, Loopback analyzes the first take and determines the tempo and
length, using the concert tempo as a starting point. After the length is set, it cannot
be changed (until you clear the tape loop).

If Sync is set to On, you can set the length (in the information display, or using a screen
control) before you record the first take. If you do not set the length, Loopback analyzes
the first take and sets the length using the concert tempo, rounding up to the next
whole bar.
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• Position dial: Displays the current playback position in the context of the overall loop
length.

• Meter field: Displays the meter (time signature) of the audio material. The bar and beat
values can be altered independently, which changes the ruler display and may alter
the Length field display, but does not affect audio playback. Cannot be changed once
the length is set without first clearing the tape loop.

• Tempo field: Displays the tempo in beats per minute. The tempo is “locked” after the
first recording and cannot be changed.

• Fade Time field: Indicates the fade-out time in seconds. Drag vertically to adjust this
value. See Using the Loopback Transport and Function Controls.

Using the Loopback Sync, Snap To, and Play From Parameters
The Sync, Snap To, and Play From pop-up menus in the bar at the bottom of the interface
control various aspects of playback and synchronization of the audio material.

• Sync pop-up menu: Enables or disables synchronization with the MainStage tempo and
clock.

• Snap To pop-up menu: Determines how Loopback starts, in play or record mode, when
stopped. It also quantizes the tape loop length “on the fly” by stopping the first take.

• Off: Loopback starts immediately, without waiting.

• Beat: Loopback starts or stops at the start of the next beat.

• Bar: Loopback starts or stops at the start of the next bar.

• Loop: Loopback waits for the amount of time defined by the Length parameter.

• Play From pop-up menu: Determines the playback start position within the audio
material.

• Loop Start: Playback starts from the beginning of the audio material.

• Relative Position: When you stop and restart the Loopback instance, playback
continues as if the plug-in had been playing continuously, without interruption. This
is useful when several Loopback instances are playing together, or when you are
using Loopback instances with Playback or Ultrabeat instances, allowing you to
effectively “mute” and “unmute” instances while keeping them in sync with each
other.
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Using the Loopback Group Functions
If you have multiple instances of the Loopback plug-in in a concert, you can use groups
to control which instances record and play together and which instances operate
independently. Any Loopback instance can either be assigned to one of 26 Groups, named
A-Z, or not be a member of any group. The linked operation of multiple instances can be
used for creative purposes, such as alternative versions of a song verse or chorus.

Loopback and Playback instances share the same group functions. If you have instances
of Playback that you have assigned to a group, they will respond to any group functions
(except Record) as any Loopback instances assigned to the same group.

Only one group can be active at a time. For example, if two Loopback instances are in
Group A, and four Loopback instances are in Group B, activation of a transport function
in any Group A member will stop all Group B members, and vice versa. Instances that are
not in any group are not affected. Similarly, any Playback instance in Group A will also
respond, while Playback instances in Group B (or any other group) will stop.

All Loopback instances that belong to a group will switch between states for the following
transport functions when changed in any group member:

• Record

• Play or Stop

• Return to Start

• Dragging in the waveform display

• Fade Out (time and action)

• Count In

• Metronome

• Undo

• Reverse

Important: Editing a parameter in one member of a group does not automatically update
the parameter value in other group members. To change the parameter value in all group
members, hold down Shift while you edit the parameter in any group member. You need
to set Sync to the same mode for all group members or you will hear playback drift
between grouped instances.

To assign a Loopback instance to a group
µ Open the Group pop-up menu at the lower right of the interface and choose a letter.
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Note: When a Loopback instance is added to an existing group, some button states may
be different from other group members. If you want all group members to behave
identically when a transport button is used in any group member, make sure that the
states of all buttons match those of other group members before you add a Loopback
instance to a group.

To remove a Loopback instance from all groups
µ Choose the “–” item from the Group pop-up menu.

Using the Loopback Action Menu
The Action menu is found to the top right of the waveform display and contains the
following items:

• Export Tape Loop: Shows an export dialog, where you can name and choose a location
to save the tape loop to an AIFF audio file.

• Import Tape Loop: Shows an import dialog, where you can select and import a previously
exported tape loop or any short audio file.

• Clear Tape Loop: Deletes the entire tape loop in the Loopback plug-in.

• Monitor: You can choose one of the following monitoring modes for the Loopback
plug-in: On (monitoring is always on); During Record (monitoring is on only during
recording); or Off (monitoring is disabled).

Note: Some mixer routing configurations may result in no audio being heard through
Loopback. Use this menu command if you encounter this situation.

• When Patch or Set is Selected: You can choose one of the following functions to be
performed when the patch (or set) containing the Loopback plug-in is selected: Do
Nothing (the default); Clear (empties the entire tape loop); Start Playing (starts the
plug-in playing at its current settings); Start Recording (starts recording the first take
at the current plug-in settings); or Clear and Start Recording (clears the existing tape
loop and starts recording the first take at the current plug-in settings).

• On MainStage Clock Start: You can choose one of the following functions to be
performed when the MainStage clock starts: Do Nothing (the default); Clear (empties
the entire tape loop); Start Playing (starts the plug-in playing at its current settings);
Start Recording (starts recording the tape loop at the current plug-in settings); or Clear
and Start Recording (clears the existing tape loop and starts recording a new tape loop
at the current plug-in settings).

• Set Concert Tempo After First Take: With this item selected, and Sync set to Off, clicking
Record tarts recording the tape loop but does not start the MainStage clock (if it is
stopped). When you click Record a second time (or click Play), recording stops and the
tape loop continues playing. MainStage sets the Length and Tempo based on the
duration of the recorded take, and starts the MainStage clock.
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Adding Loopback to a Channel Strip
The Loopback plug-in is an insert plug-in. You can use it in any type of channel strip.

To add a Loopback instance to a channel strip
1 Click one of the Insert slots in the channel strip you want to use Loopback on.

2 Choose Delay from the shortcut menu that appears, choose Loopback from the submenu,
then choose Stereo from the second submenu.
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You can set a variety of preferences in the MainStage preferences window. The preferences
window includes tabs for general, audio, MIDI, and display preferences, which are described
below.

This appendix covers the following:

• General Preferences (p. 175)

• Audio Preferences (p. 176)

• MIDI Preferences (p. 178)

• Display Preferences (p. 178)

General Preferences
These preferences let you set the tuning of software instruments, set the volume and
output for the metronome, choose what happens when you open MainStage, reset alerts,
and set whether screen controls highlight when their parameter values change.

Tuning
• Tuning slider and field: Sets the tuning for all software instruments in MainStage. Tuning

is centered around A440 Hz, in the range of 100 cents.

Metronome
• Output pop-up menu: Choose the audio output (or output pair) that the metronome

sound is routed to.

• Volume slider: Drag the slider to set the relative volume for the metronome sound.

Startup
• Startup Action pop-up menu: Choose the startup action when you open MainStage. The

choices are:

• Do Nothing: Does nothing. You can access the Choose Template dialog by choosing
File > New.

• Create New Concert from Template: Opens the Choose Template dialog.
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• Open Most Recent Concert: Opens the last open concert in the same mode it was in
when you closed it.

• Open Most Recent Concert in Perform Mode: Opens the last open concert in Perform
mode.

Alerts
• Reset Warnings button: Click to reset the behavior of alerts for which you have selected

the “Do not show again” checkbox, so that they appear in the future when appropriate
conditions occur.

Parameter Values
• On Patch Change pop-up menu: Choose whether parameter values change or remain

the same when you change patches. By default, the On Patch Change parameter for
individual screen controls is set to Preference, in which case they follow the preference
behavior. If this parameter is set to another value for a screen control, the control follows
the value of its individual setting. The choices are:

• To preserve changes to parameter values when you change patches, choose “Keep
current value.”

• To return values to the last saved value, choose “Reset to saved value.”

• Respond to Hardware Move pop-up menu: Choose how screen controls respond when
you move the hardware controls assigned to them. By default, the Respond to Hardware
Move parameter for individual screen controls is set to Preference, in which case they
follow the preference behavior. If this parameter is set to another value for a screen
control, the control follows the value of its individual setting. The choices are:

• To have screen controls instantly change to match the hardware value, choose “Jump.”

• To have screen controls change when the hardware control matches its current value,
choose “Pickup.”

• To have screen controls move relative to the hardware control, choose “Relative.”

Autosaving
• Autosave modified concerts pop-up menu: Choose the time interval for autosaving

modified concerts, or choose Never to turn off autosaving.

Note: FFor performance reasons, autosaving doesn’t occur in Perform mode. However,
the concert is autosaved when you switch to Perform mode.

Audio Preferences
These preferences let you set the audio output and input drivers, set the size of the
I/O buffer, set the audio sample rate, and choose which note is displayed as middle C.
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Audio
• Audio Output pop-up menu: Choose the device you want to use to hear the audio output

from MainStage.

• Audio Input pop-up menu: Choose the device you want to use as the source for audio
input. Choose Automatic to use the system setting for audio input (except when the
only available input device is the built-in microphone, in which case no input device
is selected).

• Setup buttons: Click the Audio Output Setup button to open the Audio/MIDI Setup
window and configure audio output. Click the Audio Input Setup button to open the
Audio/MIDI Setup window and configure audio input.

• Sample Rate pop-up menu: Choose the sample rate for audio input. If you are using an
audio interface or other audio device with MainStage, the Sample Rate value should
be set to the sample rate of your audio device.

• I/O Buffer Size pop-up menu: Choose the size of the buffer for audio input and output
in samples. Smaller buffer sizes reduce the amount of latency, but also require more
work from the CPU and may result in playback artifacts. You may want to try different
settings to find the lowest setting that does not produce any artifacts.

• I/O Safety Buffer checkbox: When selected, MainStage uses an additional buffer to process
audio output streams, providing a safeguard against crackling noises that may occur
when using very low I/O Buffer Size settings. If turning on this preference doesn’t
improve things on your system, disable the checkbox and select a larger I/O buffer size
setting.

Note: Use of the I/O Safety Buffer preference increases the output latency and therefore
the round trip (input plus output) latency.

The latency for the current buffer size is displayed below the I/O Safety Buffer checkbox.

• Apply Changes button: Click to apply changes to the input, output, sample rate, and
buffer size settings. If you do not click the Apply Changes button, changes are applied
when you close the Preferences window.

• Hot-Plug Behavior pop-up menu: Choose what action MainStage takes when you hot-plug
an audio device while MainStage is open. The choices are:

• Alert me: Displays an alert when a device is hot-plugged. The alert includes buttons
allowing you to use or ignore the device.

• Automatically Use Device: Switches the audio drivers to allow immediate use of the
hot-plugged device for audio input and output.

• Do Nothing: Does not switch the audio drivers.

• Display audio engine overload message checkbox: When selected, an alert appears when
the audio engine overloads.
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Recording
• Output pop-up menu: Choose the audio output to record.

• Recordings Folder field and Set button: Click the Set button, then browse to choose the
location where recordings are saved. The file path of the chosen location appears in
the field.

• File Format pop-up menu: Choose the file format for audio recordings. The choices are:

• AIFF

• CAF

• WAVE

Audio Channel Strips
• Silence Previous Patch pop-up menu: Choose the amount of time sustaining notes and

effects tails continue to sound before falling to silence when you select a new patch.

The Silence Previous Patch preference applies only to audio and external instrument
channel strips, not software instrument channel strips.

• Globally Disable Feedback Protection checkbox: When selected, feedback protection is
disabled for all audio and external instrument channel strips in all concerts. The Feedback
Protection checkbox is also removed from the Attributes tab in the Channel Strip
Inspector.

MIDI Preferences
These preferences let you view the current status of MIDI inputs and choose which note
appears as middle C.

MIDI
• MIDI Status field and Setup button: Displays the number of detected MIDI inputs.

Display
• Display Middle C pop-up menu: Choose whether middle C is displayed as C3 or C4.

Display Preferences
These preferences let you choose the default size at which plug-in windows are displayed,
and the view in which the workspace opens in Perform mode.

Plug-in Window
• Default size pop-up menu: Choose whether plug-in windows are displayed at their

standard size (100%) or at a larger size.
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Performance
• Perform in Full Screen checkbox: When selected, Perform mode opens in a full screen

view, rather than a window.

179Appendix C Setting MainStage Preferences





In addition to mapping screen controls to channel strip and plug-in parameters, you can
map them to MainStage actions. Actions let you select patches and sets, silence MIDI
notes, control the Tuner and the metronome, tap a new tempo, display information about
patches, MIDI messages and other information, and perform other functions using screen
controls.

The Actions folder, which appears in the Parameter Mapping browser along with available
parameters, contains actions for a variety of MainStage functions. The Actions folder also
contains an AppleScript subfolder with useful scripts. The following table describes each
action and the type of screen control to map it to.

For information about mapping screen controls to actions, see Mapping Screen Controls
to Actions.

This appendix covers the following:

• Table of Actions (p. 181)

Table of Actions
For each action in the Actions folder, the Description column describes the function of
the action, and the Usage column tells which screen controls it is intended to be used
with.

UsageDescriptionAction

Button screen controlSelects the patch 10 patches
above the current patch in the
Patch List.

−10 Patches

Button screen controlSelects the patch above the
current patch in the Patch List.

Prev Patch

Parameter Text screen control
(to display); Knob screen control
(to select)

Displays the name of the current
patch and can also be used to
change patches.

Current Patch

Parameter Text screen control
(to display); Knob screen control
(to select)

Displays the patch number of
the selected patch and can also
be used to change patches.

Current Patch Number
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UsageDescriptionAction

Parameter Text screen control
(to display); Button screen
control (to change)

Displays the program change
number of the selected patch
and can be used to change to a
specific program.

Current Program Number

Button screen controlSelects the patch below the
current patch in the Patch List.

Next Patch

Button screen controlSelects the patch 10 patches
below the current patch in the
Patch List.

+10 Patches

Button screen controlSelects the set above the current
patch in the Patch List.

Prev Set

Parameter Text screen controlDisplays the name of the current
set.

Current Set

Button screen controlSelects the set below the current
patch in the Patch List.

Next Set

Parameter Text screen controlDisplays the name of the
concert.

Concert

Button screen controlShows or hides the Tuner.Tuner

Knob or fader screen controlAdjusts the overall tuning for the
concert, from −100 cents to
+100 cents.

Master Tuning

Button screen controlMutes or unmutes all audio
(toggle).

Master Mute

Button screen controlUse to tap a new tempo.Tap Tempo

Button screen controlTurns the metronome on or off
and starts the “transport”
(toggle).

Metronome

Parameter Text screen controlDisplays incoming MIDI beat
clock messages.

MIDI Beat Clock

Button screen controlDisplays the current bar and
beat count from the “transport”
if it is running.

Beat Count

Button screen controlDisplays incoming MIDI
messages, the same as the MIDI
Activity display in the toolbar.

MIDI Display

Button screen controlSilences all MIDI notes and resets
the audio engine.

Panic

Parameter Text screen controlDisplays the current CPU usage,
the same as the CPU Activity
display in the toolbar.

CPU Load

Button screen controlTurns audio recording on or off
(toggle).

Record
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UsageDescriptionAction

Button screen controlStarts or stops playback at the
current transport position.

Play/Stop

Button screen controlStarts playback at the beginning
of the song or file (bar 1, beat 1).

Play

Button screen controlPauses playback at the current
transport position.

Stop

Button screen controlResumes playback at the current
transport position.

Continue

Button screen controlToggles the selected patch
between its edited and last
saved state (toggle).

Reset/Compare Patch

Parameter Text screen controlDisplays the current time in
hours, minutes, and seconds.

Current Time

In addition to the actions in the Actions folder, there are two actions in the Send to All >
Destinations > Actions folder.

UsageDescriptionAction

Button screen controlTransposes the software
instrument played by the
keyboard up one octave.

Transpose Octave Up

Button screen controlTransposes the software
instrument played by the
keyboard down one octave.

Transpose Octave Down
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